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      PAD2 Pattern Professional / Pattern Enterprises 6.0 

Pattern Professional 
This edition offers full features of previous Pattern Professional and also the 
Clone relationship that allows you to create more patterns pieces in 
different fabrics. Clone enables you to create the link between Plan piece 
and Production piece that any changes made on Plan View will 
automatically update on the Piece view, resulting in saving your valuable 
time in working with the pattern. In addition to all the advantages of PAD2 
Pattern Professional, you can use the Clone relationship with this software 
package. This revolutionary function allows you to create one or many 
pattern pieces in as many different fabrics as you wish. The respective 
Clone Pieces automatically modify themselves whenever the Master 
Pieces undergo a modification. The Clone gives you the possibility when 
you set your piece from the plan to keep a link between the Plan piece 
and the Production piece. So that if you make a modification on the Plan 
View it will automatically be made also on the Pieces View. This allows you 
to save a lot of valuable time when adjusting, modifying and/or correcting 
your pattern. 

 
Pattern Enterprise 
This edition offers the most complete features of PAD2 Patter Design. Apart 
from the features found in Professional edition, this also includes the Frames 
that can create the base of measurement entries by allowing you to apply 
and retrieve all of your patterns.  Other distinctive features include, Plan 
View, Piece View, Comprehensive Pattern Design Tools, Made-to-measure 
frame options, Clone (Plan-Piece View), Piece Production Treatment and 
also File Conversion, giving you the wonderful experience in working with 
patterns. The most complete and advanced PAD2 PAD Enterprise includes 
all the functions previously described in Pattern Professional. PAD Enterprise 
includes the Frames to create a base of measurement entries that you can 
save, load and apply on all your patterns. PAD Enterprise gives you the 
Plan View, Pieces View and all the pattern design tools, the 
made-to-measure frame options and the clone Plan to Piece link feature. 
Also it includes the important features on Piece Production Treatment and 
File Conversion. It is the most complete version of PAD's pattern design 
application. 
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Chapter 1 
The Pattern Basics 
• • • • • • 

 
Working Area Interface 
 

 
 

User can use the toolbox / toolbar to perform different functions on the 
working area.  The Piece List window shows the pieces you work on and the 
info box gives you useful hints of tools as well. Each element will be 
elaborated further in coming sections. The toolbox or toolbar represents a list 
of actions that you can perform on the working area. The Piece List window 
shows the pieces on the working area, visible or not. The Info box gives much 
useful information about the work that is being done. Those elements are 
detailed on the following pages. 
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Info bar is at the window’s bottom part. 
The Info bar shows: 
● Default Unit 
● Grid Status (On or Off) 
● Medium Size (as default) 
● Quantity of sizes in grading nest  
● Cursor position on the working area 
 
And it may display: 
● Information of angle  
● Length of segment 
● Length and depth of a curve 
● Info of the radius of a circle  
● X and Y coordinates and distance of a rectangle, Ellipse 
● Job Status
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Floating Windows in Working Area                                                     

Floating windows perform different functions, such as Piece List, Grading 
Arrows, Grading Info, Grading Library, Frame and Technical Sketches. User 
can group those into a single window or ungroup to multi windows in the 
working area; and also drag those to the desired place inside the working 
area. 
Single Window 
You can group two or more into the window by simply dragging the title 
bar to one of the floating window.  

 
 Grading Arrows dialogs put to the middle of the floating window. 
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Or dragging another new window to the existing item in the floating     
window.  

 
 
The Technical Sketches access to the same window. And user can navigate  
the item by clicking the appropriate tab at the bottom of the window. 
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Separate into Multi Windows 
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Zoom Menu       

You can find the Zoom Menu (with 5 functions) at 
the lower left-hand corner of main application  

                        window.   
 
 

The Zoom Menu is for controlling the zoom level. You can select pre-set zoom 
scale from the drop-down menu or directly input desired value in the box.  

                                                                                                                                                   
                       

 
 
The Zoom scale range from 0.1% 2000%(maximum).The Global View displays 
all the visible pattern pieces in the working area. 
 

 
 
 
 
 
 
 

  The Zoom - shows the selected piece(s) at the center of window. 
 
 
     The Global View - displays all the visible pattern piece in the working  
        area. 
 
 

 The Zoom Out / In - click to elarge / reduce piece view of pre-set level,  
        Ex: 200%, 100%, 50%, 33%, 25%, 20%, 10%, 8%, 6%, 5%, 4% , 3% , 2%, 1% or  
           0.5%. 
 
 
 



 

 10  

Contextual Menu 
 
You can choose to display a contextual window by right-clicking the piece 
(Windows / Linux) or by holding the Control key or clicking the piece 
(Macintosh). This window enables you to Set Piece, verify or modify the grading, 
work on the pattern inside the seam allowance, open the Piece Info dialog box 
and Zoom on piece.  
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Types of Points 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Points use to define both the contour and inner indication of the pattern. PAD 
System™ has three types of points: 

 

 
    Regular Point: It uses to mark the beginning and the end of a segment. The  
       system reads a segment from one Regular point to the next one, including  
      the points between both ends. Regular points are added when working  
      on the pattern piece. 
 

   
  Mark Point: Mark points are added to the contour of a pattern piece, by  

        using either the Add Point to Segment or Point tool. 
 
 

  Control Point: It uses to create a curve by pulling particular point of a  
  segment where curve draws based on Beizer curve principle. 

 
 

Note: Please refer to Points section of User Manual for further details. 
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Points can also be used for making Notches, Punch Holes, User’s Notches, User’s 
Punch Holes, Matching Point, Start Point, Lift and Plunge, Symmetrical Start/End 
Point, Internal Start Point. You can perform above functions by selecting Point 
characteristics dialog box or the Points and Notches option from the Treatment 
menu. 
 
PAD's pattern applications allow you to place a matching reference on a 
regular or mark point to create plaid and striped fabrics in PAD System™ 
Marker Enterprises (previously known as Opticut AutoMarker). You can put the 
matching reference on pieces from the Pieces View or in the marker. These 
matching points snap on matching guidelines. 
 
You can use points for CNC cutter. PAD System’s pattern applications allow you 
to remark the reference points on a regular or mark point that can be used in 
the marker. 
 
Each point is the coordinates of the grading X and Y.  You can use the Grade 
View tool box to modify the grading coordinates by entering specific 
coordinate’s value in the Grading Info dialog box, or by retrieving record from 
Grading, or by using Grading Arrows directly. 
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Segments 
A segment can be shown as one of following style: 
• A polygon contour, 
• A style line, or 
• A construction line between two points located inside or outside of a  
  shape. 

 

 
 
 

A segment, without define any elements of pattern, is considered as a 
construction line only; but can serve as a guide for further development. 
 
You can perform many functions on a segment by using Toolbox / Toolbar 
of Plan View / Piece view to access information of Segment Length and 
Segment Angle.   
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Selection and Activation 

You can either by double click or using the Painter tool (found in the Toolbox 
in upper-left corner) to select a specific point, segment or piece. This function 
will elaborate further in later section.  
 
No points show: The piece is not selected to work on.  

 
 
 
 
 
 
 
 

White points are visible: Click any point along the segment to select the piece you 
work on.                                             

 
 
 
 
 
 
 
 
 

Black points are visible: The piece is selected and you can choose particular 
black point / segment by clicking on it or hold down mouse left click and drag.  
To select entire piece, you can click any point along the segment and press 
the Alt (Windows) / Alt +Windows (Linux) / Option (Macintosh) at the same 
time.            
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     Keyboard Selection 
You can press left mouse button (for Windows) / mouse button (for 
Macintosh), together with the keys of keyboard, to perform different 
functions. 
 
Use the Shift key (Windows, Macintosh and Linux) to: 
 
• Select more than one element. 
• Restrict any movement along X, Y coordinates or on every 15°. (Define the angle  
  by the setting “Round Angle” in the Preference menu.) 
• To select a continuous selection from the listed items (from …to). 

    
 
 
 
 
 
 
 
 
 

Use the Alt (Windows) / Option (Macintosh) / Alt +Windows (Linux) to: 
• Select an entire piece instead of just one segment or point. 
• Move one piece or group of pieces in the Piece list. 
• Provide precise measurements in a dialog box. 
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Use the Ctrl (Windows / Linux) / Command (Macintosh) to: 
• Temporarily show the Pointer tool while other tool of toolbox is selected  
• Uncheck a selected element 
• Remove a continuous selection from the list 

   
 
 
 
 
 
 
 
 

You can perform different functions by using multiple keys together. 
 
Use either Shift + Ctrl (Window/ Linux) / Shift + Command (Macintosh) to select more 
than one element (if the function is already activated). 

 
 
 
 
 
 
 
 
 

Use either Shift + Alt (Windows) / Shift + Alt + Windows (Linux) / Shift + Option 
(Macintosh) to select more than one piece using the Pointer tool. 
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Use Shift + Alt + Ctrl (Windows / Linux) / Shift + Option + Command 
(Macintosh) to select more than one piece or a group of pieces while 
other function is in use. 

 

 
 
 
 
 
 
 
 
 
 
 

Instead, you can use the directional keys (Up, Down, Left, Right) to 
adjust the insertion point in a text box or move the selected pieces in the 
working area (using grids). 

 
 

 
 
 
 
 
 

Use the Esc (Windows, Macintosh and Linux) to quit the dialog box or cancel any 
action in progress. 
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Use the Tab key to make a quick move from one field to the next or button to 
another in a dialog box. 

 
 
 
 
 
 
 
 
 
 
 
 

Press Shift and Tab at the same time to move backward to previous field. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can click to choose the field and double-click to select all the text within the 
field. 
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To cancel a selection: 
To perform delete, please select the unwanted materials and press Backspace  
(Windows / Linux) / Delete (Macintosh). 

 
  
 
 
 
 
 
 
 
 

To scroll the view of the working area: 
Press and hold the Space bar (Windows, Macintosh and Linux) until a hand icon 
appears. 

 
 
 
 
 
 
 
 
 
 

 
A hand icon: 

 
 
 
 
 

Hold the left mouse button (Windows/Linux) / mouse button (Macintosh) 
to move and view your desired part. 
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Info Bar 

 
 

The Info bar displays: 
 
• Default measurement units, as configured in the Options menu 
• Grid status (on or off) 
• Default medium size 
• The quantity of sizes in the grading nest 
• The cursor coordinates on the working area 

 
 

It may display: 
 
• Angle’s Info 
• Segment’s Info 
• Curve’s length and depth  
• Radius’s Info 
• The X and Y coordinate and distance of a rectangle. 
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Piece List 

 

 

 

 

 

 

 

 

 

 

 

 
 

The Piece List window shows the pieces on the working area. 
 
Click minus  to hide or plus    to show the full piece list. 
 
Click the +/- symbol to open the subjacent menu. Press Alt (Windows) / Option 
(Macintosh) / Alt +Windows (Linux) and click + / - sign to open or close the entire 
section (all the subjacent menus and elements)  
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The button before each piece allows you to Show or Hide the corresponding piece. 
The button before each group allows you to Show or Hide the corresponding 
group. Press Alt (Windows) / Option (Macintosh) / Alt + Windows (Linux) keys and 
click the button to Show or Hide the whole section (all the subjacent menus and 
elements) with a single click. 
 

The Icon shows you the display status of the corresponding element or group of 
elements. 

  

   Means corresponding piece or group of pieces is hidden on the working area. 

 

 

   Means one or more pieces of the corresponding group are hidden on  

      the working area. 
 

                                

   Means corresponding piece or all the pieces in the corresponding  

       group show(s) on the working area. 
 
 
  

Task menu bar (with six buttons) of Piece List window allows you to work on the 
multiple pieces selected previously.   
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Piece List Buttons 

 
                       
 
 

  Click to cut and paste the selected piece(s) onto the clipbard temporarily for  
     future use. 
 
 

  Click to copy the selected piece(s) while it still keeps in the Piece List window and   
     the clipboard for future use. 
 
 

  Click to paste the piece(s) kept in the clipboard by using Cut or  
     Paste command. 
 

  Click to display the Clone Hierarchy of the selected piece(s), available in  
      both Pattern Professional and Pattern Enterprise editions. 
 
 

  Click to display the Piece Info dialog box or double-click a piece instead. 
 
 

  Click to delete the selected piece(s) and will remind to reconfirm before             
      execution. Delete to confirm or Cancel to keep. 
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Customizing your Piece List by Contextual Menu 
 
Go to the Piece List Menu of Piece List window and right click mouse button to 
open the Contextual Menu to customize the way of information shown. 

 

  

 

 

 

 

 

 

 

Check the criteria to choose the way of information displayed, you can 
make multiple choice as well. 
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Piece information: Info By Columns 
 
Info by Columns - Piece information will list in column 

 
 

 
 
 
 

 
 
 
 
 
 
 
 

 
 

Uncheck to list each piece information in row, details separate with comma 
(,)  
 

 
 

 
 
 
 

 
 

 

Right click the title bar to 
choose the option by mouse 
left click 

Right click the menu bar and 
uncheck by clicking left mouse 
button 
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Contextual menu allows you to select the criteria of viewing pieces in the 
Pieces List window. You can list your pieces grouped with fabric or list all 
together without grouping under All Fabrics 

 
Piece List Style: Group by Fabric (Plan) 
 
Group by Fabric (Plan) - pieces listed one by one in the Piece List without grouping 
under All Fabrics. 

    
 
 
 
 
 
 
 
 
 
 
 
 
 

Uncheck to list the pieces group under All Fabrics.
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Piece List Style: Group by Fabric (Pieces) 
 
Group by Fabric (Pieces) - pieces listed one by one in the Piece list, without 
grouping under All Fabrics. 

                                
  
 

Uncheck to list the pieces group under All Fabrics. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Allow to select both Group by Fabric (Plan) and Group by Fabric (Pieces). 
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Technical Sketches 

Technical Sketches window builds the link between pattern file with 
sketch. 
File formats support: 

 

• BMP files (*.bmp) 
• GIF files (*.gif)               
• JPEG files (*.jpg, *.jpeg)       
• MNG files (*.mng)              
• PBM files (*.pbm)         
• PGM files (*.pgm)    
• PNG files (*.png)              
• PPM files (*.ppm)    
• TIFF files  (*tif, *.tiif)     
• XBM files (*xbm) 
• XPM files (*xpm) 
 
To build the link between the sketch and pattern file: 

1 Select Show Technical Sketches from Option menu or click right mouse  
  button on Menu bar and choose Technical Sketches on Contextual    
  menu to open the Technical Sketch window.  
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2 Click the button on top right corner of the window to open the   
  menu and select Link to Image….. 
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3 Follow the directory, select the file and click open. Sketch will resize  
  to fit in the window. 

        
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Three ways to adjust the sketch viewing size: 

 
  Zoom (drop-down menu) - select as per pre-set percentage. 

 
 
 
 
 
                     Global view icon - view whole sketch fit into the window   
 
 
                  Zoom In / Out icons - reduce / enlarge the size by 100%    
                as default. 
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Remove link from the pattern file 

     Click the button at the top-right corner and select the Remove Link to  
       remove the current sketch file or use the Remove All Links to remove  
       all links saved in the pattern file. 

 
 

Navigate through linked sketch files 
Click the button at the top-right corner and a list of linked files will shown at 
bottom of drop-down menu.  You can view each linked file one by one. 

 
 

Missing Files 
If you change pattern file name or move without saving those linked files to the 
pattern file, it may result in file missing and dialogue box will pop-up and 
request for locating the path of those missing file as below: 

       

 
Yes – To replace the file by selecting the file from directory and click Open. If 
missing more than one file, system will scan and locate all missing files under the 
same folder / path of previous selected one. You may be required to provide 
exact location of each missing files if this search fails.    
 

No – To remove the link with respective missing file 
 
Ignore - to retain the file with missing link  
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Default Hot Key Shortcuts 
You can use Hot Keys to increase working speed and efficiency. 
 
It preconfigured Hot Key to enable you carry out tasks in more 
convenient way. 
 
Hot Key list as follows: 

Menu Windows / Linux Macintosh 

File: New Ctrl+N Command+N 

File: Open 

 

 

 

  

Ctrl+O Command+O 

File: Close Ctrl+W Command+W 

File: Save Ctrl+S Command+S 

File: Save as Ctrl+Shift+S Command+Shift+S 

File: Print Ctrl+P Command+P 

File: Plot Ctrl+T Command+T 

File: Export Ctrl+H Command+H 

File: Quit Ctrl+Q Command+Q 

Edit: Undo 

Edit: Redo  

Ctrl+Z 

Ctrl+Y 

Command+Z 

     Command+Y 

 

 

Edit: Cut Ctrl+X Command+X 

Edit: Copy Ctrl+C Command+C 

Edit: Paste Ctrl+V Command+V 

Edit: Replace Ctrl+= Command+= 

Edit: Select All Ctrl+A Command+A 

Options: Snap to Grid Ctrl+R Command+R 

View: Plan View Ctrl+1 Command+1 

View: Pieces View Ctrl+2 Command+2 

View: Grade View Ctrl+3 Command+3 

View: Show Checked 
 

Ctrl+4 Command+4 

View: Clone View Ctrl+5 Command+5 
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 Menu Windows / Linux Macintosh 

View: Frame View Ctrl+6 Command+6 

View: Work on Sewing Line Ctrl+7 Command+7 

View: Zoom – Global View Ctrl+0 Command+0 

View: Zoom – On Selection Ctrl+9 Command+9 

View: Zoom – Zoom In Ctrl + + Command + + 

View: Zoom – Zoom Out Ctrl + - Command + - 

Treatment: Set Piece Ctrl+E Command+E 

Treatment: Piece Info Ctrl+D Command+D 

Treatment: Item Info Ctrl+I Command+I 

Treatment: Group Ctrl+G Command+G 

Treatment: Ungroup Ctrl+U Command+U 

Treatment: Align Shapes Ctrl+K Command+K 

Treatment: Pattern Assistant Ctrl+Shift+P Command+Shift+P 

Grade: Library – Open 

Grade: Grading Info                

Ctrl+L 

Ctrl+J                   

Command+L 

Command+J 

  
 Tool Windows / Linux Macintosh 

Selection:  Ruler 
 

  R   R 

Drawing: Rectangle                T   T 

Drawing: Segment    S   S 

Drawing: Curve   C   C 

Drawing: Parallel Line   Y   Y 

Point: Point   Q   Q 

Point: Add Point to Segment   D   D 

Segment: Walking Piece   W   W 

Segment: Segment Length    E   E 

Characteristics: Seam Allowance   A   A 

           Note: You can customize your shortcuts in Preferences menu and Hot Key. 
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      Floating Windows 
Floating window (Piece List, Grading Arrows, Grading Info… 
You can group two or more windows into one by simply dragging the 
head of floating window into others; thus, allows you to work on different 
elements under one window.  You can click the tab to navigate each 
element one by one.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Each window shows one element only. You can select the tab / header 
and drag outside the window to separate from the rest.   
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Intelligent Dialog Box 
 
Dialog box allows to perform calculation function by using + (add), - 
(minus), x (times), / (divide) to calculate the measurement 
Any dialog box with intelligent calculation. You can put +, -, * and / to 
calculate your new measurement. 
           
 
 
You can change to present decimal point number in fraction. 

  
 
You can include the Inline unit in the measurement by choosing the 
option in file menu PreferenceGeneral Inline unit.   
Inch = 30 in 
Centimeter = 30 cm 
 
You can also change the measurement unit to inch or centimeter by 
simply putting “in” (for inch) or “cm” (for centimeter) at the end of the 
dialog box. It will convert the new measurement as per unit indicated 
automatically. 
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Pattern Template 
It allows saving the most used Pattern Pieces into a list.  
To do so: 
1 Open the file with some pieces need to save to Pattern Template 
 
2 Go to Option menu and select Show Pattern Template List. 

  
 
3 The Pattern Template displays on the floating window. And press “New”    

from the sub-menu. 

  



 

 37  

4 A dialog box appears and please input the name for Pattern Template 
List. 

   

 
5 The item of the Pattern Template List displays on the floating window. 

   

 
6 To activate the item (Pattern Template List) as the above screen shot. 
  And activate the piece, click right button on mouse and choose the  

item Create Template. 
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7 Then it saves this piece to the Pattern Template List as the following   
 screen shot. 

   
 
8 If you would like to save another list for keeping body shape. You can 

press “New” to create a new Pattern Template List and name to “Body. 
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9 The Pattern Template will save its automatically to the location as follows.   
 C:\Users\May\AppData\Local\PAD System 6\Pattern Design\template 

 
 When you start Pattern Design, it will load the Pattern Template List   
 automatically. 
 
To Save and Open Pattern Template List to another PC 
How to do: 
1 Press “Save” item from the sub-menu. 

    
 
2 A dialog box appears and enter the name for the Pattern Template List 

and choose the directory to save the file(.temp). 
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3 To open the Pattern Template List to another pc. Please pass this temp  
file .temp to the station need to open. Start Pattern Design and open or 
create a new file. Click on the item Open from the sub-menu and 
choose the file to be opened. 

   

4 A window appears to show all of Pattern Template List of the selected 
file. 

   
5 You may choose one of them or Select All. 
 
6 To get a piece from the list. Activate the item and drag it to the working 

area. The selected piece will copy on the current file. 

 
Note: For the pieces setting with Frames, it will keep them to the pieces 
and save to Pattern Template List.  
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Seam Allowance Library 
The Seam Allowance Library allows you to create a list including the 
frequent used seam values.  It also allows you to manage a Master Seam 
List and share it with other Pattern Makers. 
 
Show Seam Allowance Library from Options menu that you can use the 
Seam Allowance Library window to add seam allowance on a segment(s) 
or even several pieces at the time more easily in doing so. 
A tick () will show if you choose to Show Seam Allowance Library.  

 

A Seam Allowance Library allows you to keep the seam value in a 
database. You can create as many Seam Allowance Libraries as you 
need. Each library may contain up to 999 seam evolutions available on 
screen through the Seam Allowance Library window. The Seam Allowance 
Library window lists the number and name (if any) of each seam evolution. 
 
Next to each element of the Seam Allowance Library, there is an arrow 
that opens a drop- down menu showing the Seams Characteristics of the 
element. It contains the numbers and names of the Seam Evolutions. Only 
one Seam Allowance Library can be open at a time. 
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Seam Allowance Library Drop-Down Menu 

 

Library commands are available in the drop-down menu, to the upper 
right of the Seam Allowance Library window.   
 
The Library drop-down menu offers the following options: 
New...: It creates a new Seam Allowance Library. 
Open...: It opens a Seam Allowance Library that already exists. 
Open & Reaffect...: It replaces the current Seam evolutions to the pattern 
pieces with those from a chosen Library. 
Close: It closes the open Seam Allowance Library. 
 
 
To create a New Seam Allowance Library: 
1 Select the New… item in the sub-menu from the window of the Seam 

Allowance Library. The Save new library as dialog box opens. 
 
2 Enter the library name in the File name text field. 
 
3 Press the Save button once you have located the proper folder. The 

library window appears; enter the name for the Seam Allowance Library 
file (.seam).To return to the previous window, press on the Cancel button. 

   
Note: All seam evolutions adding to Seam Allowance Library. It saves 
automatic to the Seam Allowance Library. 
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Seam Allowance Library Buttons 
 

 
 New : It adds a new seam evolution to the Seam Allowance Library. 

 
  Edit: It allows modifying information about the seam evolution that is  

    selected. Or get the dialog box on the selected item by mouse  
    double clicks. 
 

 Delete: It removes the selected seam evolution.   
 

 Cancel: It removes the link between the selected seam evolution and  
    the segment(s). Once the linking is removed, the selected item turn to  
    black color. 
 

 Apply: It applies the updated Seam Evolution to the segment(s). 
    If there are more than one item in RED color in Seam Library and it  
    need to update the value to the pieces. It can press Apply to update  
    one by one. 
 
    Just select the item in REB color and press Apply to validate.  
    A dialog box appears: 

     
    Click Continue button to confirm or click Cancel to close the dialog. 
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To open an existing Seam Allowance Library (.seam) file and apply Seam 
evolutions to the piece (s): 
 
1 Select the Open… item in the library sub-menu from the window of the  
  Seam Allowance Library. A dialog box opens. 
 
2 Select the library you wish to open and click the Open button.  
  The Seam Allowance Library appears: 

   
 
3 Select the segment (s) that you want to add seam allowance on. 
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4 Click on the seam evolution in the Seam Allowance Library window. 

  
 
  The selected segments add the seam value by the selected item. 
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To replace all seam evolutions from a chosen Library: 
 
1 Select Open and Reaffect... in the library sub-menu from the window of 

the Seam Allowance Library. 
 
2 An Open dialog box appears. Select the updated library that will 

replace the current seam evolutions to the piece(s).  
 A dialog box appears: 
 

   
 
Click Continue button to confirm or click Cancel to close the dialog. 
 
The seam item of the library is applied according to the numbering 
process and the seam value on the open pattern. 
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Attach Image on a Pattern Piece 
Attach Image allows you to add it on the pattern pieces. A rectangle is 
surrounded the image, two regular points show on top right corner and left 
bottom corner that let you to manage the image. Image file treats as an 
internal shape; it supports all of operation as working on the internal 
section. 

 
File formats support as following: 
• BMP files (*.bmp) 
• GIF files (*.gif) 
• JPEG files (*.jpg, *.jpeg) 
• MNG files (*.mng) 
• PBM files (*.pbm) 
• PGM files (*.pgm) 
• PNG files (*.png) 
• PPM files (*.ppm) 
• TIFF files (*tif, *.tiif) 
• XBM files (*xbm) 
• XPM files (*xpm)  
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To attach an Image on the piece by using the Contextual menu: 
1 Right-click the piece (Windows / Linux) or click the piece while holding 

down the Control key (Macintosh). 
 
2 Select the Attach Image… from the Contextual menu. 

    
 
3 Follow the directory, select the file and click open. Image will resize to fit 

in the Pattern simulation area.   
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Reposition the Image File 
To activate the Image and freehand to move it by using Pointer tool to the 
new position. 
 

 
 

Or, to move the selected Image using the keyboard arrows: 
1 Select the Pointer tool. 
 
2 Select the Image(s) you wish to move. 
 
3 Use the directional arrows (Up, Down, Left, Right) to move the image(s) 
to the desired location. 
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Rotate the Image File 
To rotate the Image freehand or to a precise angle X, Y or every 15° 
(Define the angle by the setting “Round Angle” in the Preference menu.) 
 
To rotate selected images by freehand: 
1 Select the image(s) you wish to rotate. 
 
2 Select the Rotation tool. 
 
3 Click the fixed point (pivot point). 
 
4 Click the second reference point and hold down the left mouse button  

(Windows/Linux) or the mouse button (Macintosh). A reference dash 
guideline going from the first point to the second point appears. Those 
two lines represent an angle. 

 
 
5 Pivot the guideline to the desired rotation angle. 
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Hold down the Shift key (Windows and Macintosh) to constrain the 
rotation angle (X, Y or every 15°). 

 
When you hold and move the reference guideline, you can view the 
rotation angle at the fixed point (pivot point) or in the info bar.  

 
 
To rotate the image to a precise angle using numerical values: 
1 Activate the image(s) you wish to rotate. 
 
2 Select the Rotation tool. 
 
3 Hold down the Alt key (Windows), the Option key (Macintosh), the Alt + 

Windows keys (Linux). 
 
4 Click the pivot point. The Rotate dialog box appears: 

   
 
5 Enter the desired value of rotation.   
 
6 Click the OK button to execute the function. 
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Resize the Image by Freehand 
1 Select the Pointer tool. 
 

2 Select the Image(s) you wish to resize.  
 
3 Click one of the points at the corner and drag the mouse to resize the 

image. 

    

Able to Scale the Image 
To scale an image, activate the desired image and click the Scale... item 
in the Treatment menu. The Scale dialog box appears. To scale an image, 
select the appropriate radio button and enter the desired scale values.  
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Add Grading Value to the Image 
It allows adding grading value to the regular point located at 2 corners. 
1 Select the point(s) required on the image. 
 
2 Select the Grading Info... item in the Grade menu or press Ctrl+J.  
  The Grading Info dialog box appears. 

   
3 Enter the X and Y coordinate values of the point(s) in the dialog box. 
 
4 Press on the OK button to validate the operation. 
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Show the Image on the Pattern 
The Show menu and Image item in the View menu allows you to view or 
hide the Image(S) in the working area: 
Image: By checking Image, you can display all the Images to the pieces.  

 

 
 
Saving Image Files 
It saves the Image file automatic when you save the Style file. The 
extension of the Image file is .pmg. Please be sure to put the Style file(.sty) 
and the Image file (.pmg) into the same directory.  
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Missing Image Files 
If you change the name of the Style file (.sty) or the Image file (.pmg), it 
may result in file missing and dialogue box will pop-up as below: 

 
Continue – Choose the directory of the Image file 
Cancel – Close the dialogue box. If the image file is not found, it will show 
a rectangle instead. 
 
Plot Image on the Piece from Wide Printer 
The item in Plot and Piece Info allows you to plot the image on the piece. 

 
Note: It will plot out a rectangle in DASH LINE if the plotter does not support 
Image plotting. 
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Convert Style File with Image to Another File Format 
When exporting Style file to the file format as follows: 
DXF-AAMA  
DXF-ASTM 
Illustrator(.txt)  
Plot File(.plt) 
 
Images on the piece will become a rectangle (Regular Line) if converting 
to DXF, Illustrator(.txt) and Plot file(.plt). 
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Display Measurement on Segment 
It can show the measurement on Whole Pattern Piece or the selected 
Segment. It allows showing value for the piece with Seam Allowance.  
But this feature does not support on Graded Pieces. 
 
Showing Measurement on Whole Pattern Piece 
By checking Segment Value from View menu and Show 

  
The whole piece shows the value calculated by each segment. It 
calculates along the segment between 2 Regular Points. Curve point and 
Mark point are included.   
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Showing Measurement on the Selected Segment 
To do so: 
1 Select the desired segment(s) 
2 Select the Ruler tool 
  Or, Press “R” key for the Hot Key of Ruler tool 
3 Press “R” key again 
4 The value displays on the selected segment as follows. 
  Sample 1: The value calculates for one segment. 

         
  Sample 2: The value is two segments combined. 

    
5 The value keeps showing with the piece until remove it. 
6 Support to show the value on Seam Allowance 
 
Remove Measurement on the Selected Segment 
1 To remove the value, select the desired segment(s).  
2 Select the Ruler tool.  Or, Press “R” key for the Hot Key of Ruler tool 
3 Press “R” key again 
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Show Grid on Background  

Show Grid to the Background. You can select the Unit of the Grid size 
under Options menu, Preferences… and Display tag page. The dimension 
of the Grid’s Resolution is default to 1/1. 
 
By checking Grid from View menu and Show to show Grid in background 

   

 
Uncheck View menu Show Grid 
 
To check if the Snap to Grids is activated, it allows moving the pieces or 
elements on the working area using pre-defined grid steps. You can 
deactivate it at any time. 
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Chapter 2 
The Menu Bar 
• • • • • • 
 

File Menu 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Before getting start, you had to know how to use the File Menu.  
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File Menu: New… 
To create a new pattern document, a Base Algorithm window allows you to 
choose pre-set Algorithm (Skirt, Bodice, Pants or Sleeve) or New Style to open a 
blank for you to work on.   
 
An Algorithm has already created the base block of Skirt, Bodice, Pants or Sleeve 
for you to work on directly. 

 
       

 
 
 
 

 
 
Skirt: A skirt base block allows you to create your own skirt style at 
ease 
 
Bodice: A bodice base block enables you to create your own 
bodice style at ease 
 
Pants: A pants base block enables you to create your own pants 
style at ease 
 
Sleeve: A sleeve base block enables you to create your own 
sleeve style at ease 
 
You can either open one of the algorithm or New Style for a blank one; click 
cancel button to go back previous step. 
 
The file of Algorithms is in base format (*.bas). It can be modified by 
using the Base menu but you need to save yours in style format (*.sty). 
Please go to Save and the Save As… to learn details.  
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     File Menu: Open… 

To open file either in Style format (.sty) or Base format (.bas) that already 
created. 
 
How to do: 
1 Select Open... from the File menu and list the entire file (in .sty / .bas  
  format) available in the folder.  

   
2 Browse to select file or change the path if necessary. 

3 You can also sort the file available by selecting the file type drop-down  
  menu next to File name field so as to narrow down your selections.  

4 Select the file and click Open afterwards  

 

Start from Pad2 V.5.0 support both Gerber native file (.zip) and Lectra native 
file (.iba/.vet) and can be opened directly. 
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File Menu: Open Digitizer… 
 
Open a digitize file into a New Style (blank) or current working window. 
 
How to do: 
1 Select the Open Digital Pieces... from File menu and the Open Digital  
  Pieces windows pop up. 

 
    

2 Choose the digitizer(s) you wish to take the files. All of files are showing  
  from the Job List. 
  Digitizer: The account of the digitizer. 
  State: It shows the state of the digitizer. The state under Log Success, you  
  can open the files from right side of the Job List window. If the state is in  
  Security Enabled, please double click on the selected account. A dialog   
  box appears and allow input the password.  

               
  File Number: The number of digitize files you allow to take. 
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3 Select and Click OK to open    

    

 
4 The pieces of the selected file will open in a New Style (blank) or current     
  working window. If the pieces were digitized to Pieces View by Digitizer  
  Manager, file will be opened in Piece View automatically. 
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File Menu: Open Other… 

To open the pattern plan and pieces file into a style format (.sty) in 
the working area 

 
How to do: 

1 Select the Open Other... from the File menu and dialog  
  box pop up. 

2 Browse to select or click browse button to change directory. 

3 Select file in style format (.sty) and click Open. 
 
 
The selected piece file will open in current working window.  The size 
of piece will be fit in the existing window. All pieces are added in Plan 
View to Piece List (if applicable).  It can still support different Piece 
characteristics, i.e. Frames, Clone, Grading etc. 
 
 
 
 
Note: For the Open Other... item to be unlocked, the active file must be  
a Style file and the file you are opening must be a Style file. 
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File Menu: Close 

To close the active file or the file you are now working on. A dialogue box will 
be pop-up to remind you when you have made any modification without 
saving.  

 
 

 
 

 
 
 
Discard: Close immediately without updating any latest changes 
 
Cancel: Close the dialogue box and continue to work on file 
 
Save: Save the latest update. A dialogue box will remind you if you want to 
replace existing one (saved under same file name) or create a new file.  
You are required to make a name and directory path if save as new.  File 
will be saved and closed accordingly. 
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File Menu: Save 

Remember to save the file once you make any change of existing file 
or create a new one.  

 
How to do: 

      1 Select Save from File menu. If you work on existing file, file will be  
        saved under the same name.  

 
   2 If you are working on a new file, you are request to enter the file  

  name and choose the directory, together with the file format  
  (in *.sty / in *.bas) to be saved.   
 
3 Click Save to execute 
 
 
Note: Four basic blocks can only be saved as Style (.sty) that can be opened 
in others environment for modification. 
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File Menu: Save Changeset 
This feature is for the management of changes to documents. Users are 
able to view the changes on each piece; it does not allow doing any 
modification on the pieces. It keeps the maximum number of Changeset 
to 3 copies. And it will overwrite the last copy if it reaches the maximum 
number of files. This feature is available in Pattern Design only.  

 
To do so: 
1 Open a pattern file and change the measurement on one of the piece. 
  Ex: Add 2 inch at the Sleeve Length 
 
2 Select Save Changeset from File menu; it keeps the previous file in the  
  first copy. Please choose Close from File menu to close this file. 
 
3 Select Open… from File menu; to open the file save with changeset and  
  is able to compare the all of files in Changeset View. 
 
4 Go to Changeset View from View menu to choose the Changeset file to  
  be compared. 

 
 
5 Once the Changeset file is selected; it goes to Changeset View to  
  display the current file and the first Changeset file. And you can choose  
  the pieces to be compared from the Changeset window. All of pieces  
  in the first Changeset file display in Pink color. The pieces will align at the  
  center point.  
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6 The Toolbar allows you to make some actions on pieces in Changeset  
  View. All of the tools are the same function as in Plan / Pieces View. 

   
 

7 Or you allow using Align Shapes… from Treatment to align pieces. 
 
8 To left the Changeset View, just go to Plan View / Pieces View. The latest  
  file displays on screen. And the Changeset file is hidden until you choose  
  it to view again.  
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Restore Changeset File to a New File 
You allow copying the whole style to a new .sty file. Put the cursor on the 
title bar and right click on mouse, the contextual Menu appears; please 
select Copy to a New File. A new file appears and all of pieces pastes in 
it. 

        

 
 
 

Set Number of Copy for Changeset Files 
Predetermine the maximum number (Between1 to 3) to save for 
changeset files. The item Version Control in Preference and General allows 
you to set the value. The maximum number is between1 to 3. The default 
number is 3.  
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File Menu: Save as... 

To save an existing file under different name or other directory. If you just 
change the location without renaming, all changes would be updated on the 
file of latest saved location only.  

Save as… item also allows saving the file in the format of previous version of 
PAD System. It serves as a platform to communicate with users using 
previous PAD’s versions, like 4.0, 4.1, 4.5, 4.6, 4.8 and 5.0. 

 
How to do: 

1 Select Save as… from File menu. If you work on existing file and you  
  want to change directory without renaming it, all changes will be  
  updated on file of new locations. If you want to rename it, you are  
  required to save with new file name and new location (if necessary). 

 

2 You can choose the version to save as in Save as Type drop-down menu. 

 

 The Save Current Style As (for a style file) or the Save Current Base As 

 (for a base file) window appears. Enter the name of the file, select its  

 type if it applies and select the folder you would like to save the file in. 
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3 It is default using the same file name with _Copy at the end and you  
  can rename it as well. 

 

4 Click the Save to execute. 

 
5 Text Conversion dialog box pop up and ask to choose language used. 

 
PAD Language: Select Auto to save the file as per operating system 
language used or select language from this list. 

 
6 Click the Save to execute. 

 

 
Note: Four basic blocks can only be saved as Style (.sty) that can be 
opened in others environment for modification. 
Save a Copy is only available in Pattern Enterprise edition. 
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File’s format and saved version will be indicated in both Summary Info and 
Comments box.  

 

 
 

 
 

Note: This works for the Style files but does not work for the Base files. 
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File Menu: Revert to Saved 

To undo all the steps after the last saved. You can undo all the steps of 
pattern modifications by one click; however, you cannot recover the undo 
steps once you execute this function. 

 

                  
 

              
Click OK to revert since last saved. 
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File Menu: Recent Files 

To open a list of pattern file you worked on recently 

 
 

 

Recent Files record the last 10 pattern files you have opened. 

 

Recent Files only record the recent opened file path. If file location / path has 
been changed or removed, a dialogue box will remind that file cannot be found 
and require you to find out the file manually.   
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File Menu: Search... 
 

To open a dialog box to search any files (can be identified by system) 
with different search criteria for sorting purpose.  

 
 

You can use following criteria to help the search results : 
 
• File name or part of the file name (use * as a wildcard); 
• File type; 
• File location – from Specific drive, or All volumes (all drives); 
• Keywords included in Summary Info. 
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Advance Search 
You can apply the advance search criteria to narrow down your search results. 
list. Advance search features listed below.  

 

 

 

 

 

 

 
     Dates… 

Search by date of file create, last updated and/or stamp date 
 

 
 
 
 
 
 
  

 

• Date Stamp from and Date Stamp to: Search as per file stamp date being  
   indicated 

  • Created from and Created to: Search as per file create date being  
  indicated. 
• Last Saved from and Last Saved to: Search as per file last saved date being  
  indicated. 

 
Click Clear All to clear all fields’ information. 
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Piece Label… 
Search as per specific piece information. 
 
 

 
 
 
 
 
 
 

 
Search criteria as follows: 
 
• Pattern #: Enter a piece pattern number directly (if any) 
• Piece Name: Enter a piece name directly (if any). 
• Description: Enter description of a piece directly (if any) 
• Piece Code: Enter a Piece Code on a piece directly (if any)  
• Reference Code: Enter a Reference code (if any) 

 
       Click Clear All to clear all fields’ information 

 

Marker Info… 
Search as per the marker file name 
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Search, Files Found 
Results come with a list of files that match your search criteria. Browse and 
select the file and click OPEN. 

        
 

 
 
 
 
 
 
 
 
 

Select a file to display its directory and path under the search list.  
 
The Files Found dialog box offers the following options: 
 
Summary Info...: It enables you to read the summary of a file. 
 
Export...: Export the file search results in PAD System Manager (xml) or Text File 
format. 
 
Open: Open the selected file (in case it can be opened in current working 
environment, i.e.: *.mar in Marker or *.sty in Pattern. 
 
Find: Find to start searching. 
 
Cancel: Cancels to stop search 
 
No File Found means no file match your search criteria.  Please reset your 
criteria and click Find to search again. 
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File Menu: Summary Info… 

  
 

To enter or save useful information to describe the file and facilitates file search 
easily.  
 
Summary Info: Summary 
 
Title: The name of file. 
 
Author: The person who create the file. 
 
Company: The Company name. 
 
Keywords: Keywords that describe the file. 
 
Comments: Text box to enter and save personal comments. 
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Stamped: To assign a date to the file. Click Now if you want to  
enter current date. 
 
Created: Date of file first created. 
 
Last Saved: Date of file last saved. 
 
Version: PAD’s version of file being saved. 
 
Summary Info: Security 

 

Input Password: Allow to input the password to secure the file. Please be  
aware that password is case sensitive. 

 

Confirm password: To input the password for confirmation. 
 

Clear: To remove the current password. 
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      File Menu: Page Setup… 
To set up the page for file printing by setting the Printer, Paper Size, Printer Tray, 
Paper Orientation, etc. 

 
 

 Note: Please refer to your printer manual and/or user manual of different   
 platform for page setup details. 
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File Menu: Print... 
To set your print instructions before printing. Print results would be based on 
your selection and you can click preview the view the results before sending 
to print.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Type of Report 
 
Items: One item per page with the information being selected from the 
Options list at the right. 
 
Item List: List all the items within a page with information being selected 
from the Options list at the right. 
 
Item List (Text): Print the Text information, such as Name, Description, 
Quantity to Be Cut and Fabric of the pieces only. 
 
Workspace: To select the work area printing options - the whole plan, the 
pieces or the visible elements, in the Items to print section. 
 
 
 



 

 84  

      Items to Print 
 
Plan: Print all pieces in Plan View. 
 
Pieces: Print all pieces in Pieces View. 
 
All visible: Print items can be seen on screen. 
 
 
Options 
 

Item Description: Print information about the pieces. 
 
Item Options: Print the options of the pieces. 
 
Grade Nest: Print the grade nest of each piece. 
 
Grade Points Numbering Nest Info: Each grading evolution points with a 
numbering. 
 
Sewing Lines: Print the non-graded sewing lines for each piece. 
 
Sewing Values: Print the values of the sewing. 
 
Frames: Print the frames on the pieces. 
 
Print Colors: Select and check the print color box for the color you choose to 
print. 

 
Note: Options available depends on your selection of the Type of Report and 
Items to Print sections. 
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      Print Order 
None: Organize the print sequence, allow to sort pieces by Fabric Id., 
Piece Name and Plan/Pieces. You can make multiple selections or non of 
these options.  You can make your preliminary selection in the Sort Pieces 
by menu; and then go to Then by menu for 2nd and 3rd level sorting 
criteria that the printed items would be based on preliminary selection.  

        
 
Preview: Show the printing preview 
 
OK: Execute printing 
 
Cancel: Cancel printing 
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File Menu: Plot… 
To plot the Pattern pieces either in Plan View or Pieces View and also allow you 
to select information being plotted in the pattern pieces   

                  

 
Plot window allows you to click the tab and choose different criteria in 
plotting, including Piece Info, Cut Options, Symbols and Page Setup, to 
specify your plotting instruction.  
 
Plotter Drivers / Printer Drivers 
The top part is the hardware setup that allows you to select Preference and 
Plotter / Printer where you may select more than one driver from the plotter list. 
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Plotter 
 
 
 
 
 
 
Printer  
 
 
 
 
 
 
Network 

      The Plot Manager activates the network options and allows you to           
      connect the plotter / printer being found in the network. 

       

 
      If Plot Manager’ plotting service is not ready, it shows the message as   
      below. 
 
 
 
 
 

 
 
      
     Note: Please refer to the Plotter section under Preference menu for details. 
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Plot Items 

 

Plan: Plot all pieces in Plan View. 
 
Pieces: Plot all established pieces or selected pieces from the Piece List, 
the pieces from all fabrics; or, the selected fabrics from the fabric list. 
 
Grading 
Check and select to plot either all grading sizes or specific sizes; it 
can be nested or plotted separately.  

Nested: Plot as Nest Pattern 
Size by Size: Plot separately 
One Size per Section: Plot separately and a size put in a section 

 
Plot Pieces Info: Activate if Piece has bee selected and plot the piece info 
as you have already checked the box in the Piece Info page.   
 

Use Knife Tool: Activate if Pieces option has already been selected. Check if 
you use plotter-cutter. 

Auto Cut Frame: Cut Sheet in each Frame 
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Scale in X or Y: Scale the plotting items on both X or Y axis. Number value 
indicates the percentage of real size. 
 
Press Plot to execute plotting. 
 
Press Preview to view the plot job before plotting. 

 
 
       Piece Info 

Select specific information to be plotted inside the pattern pieces. 

                   
File Name: Plot the file name. 
 
Pattern #: Plot the pattern number of a piece (from the Set piece dialog 
box). 
 
Piece Name: Plot the name of a piece (from the Set piece dialog box). 
 
Grain Line: Plot the Grain line of each piece. 
 
Description: Plot the description assigned to a piece (from the Set piece 
dialog box). 
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Piece Code: Plot the code of a piece (from the Set piece dialog box) on 
the piece. 
 
Reference Code: Plot the reference code of a piece (from the Set piece 
dialog box)   

 
Qty. to Be Cut: Indicate number of times the pieces to be cut (from the Set 
Piece dialog box). 
 
Fabric ID: Plot the name of fabric. 
 
Sizes: Indicate the size of a piece. 
 
Special: Plot alphanumeric information or other special name (if any) 
given in the Grade Working Sizes dialog box. 
 
Message: Plot as per the text in Message field from the Plot dialog box. 
Select to plot the message in either all pieces or the first (or more page 
from the first) of pieces. 
 
Plot Sewing Lines: Plot the sewing lines of seam allowances. 
 
Plot Sewing Values: Plot the sewing values of seam allowances. 
 
Plot Image: Plot the image attach on a piece. 
 
Space between Pieces: Add some space between pieces within a 
rectangle when plotting. 
 
Save as Default - Save current settings as default. 
 
Preview – Preview plot job before sending to plotter. 
 
Plot - Execute plotting 
 
Cancel - Close the dialog box 
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Cut Options 
Allow you to specify setting for plotters equipped with cutters. 

                

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
Cut Notches: Cut the notches. 
 
Cut Simple and Double Notches into Simple U Notch: Cut the simple and 
double notches on your pattern as simple U notches and give you a new 
width and depth, regardless of the original notch value.  The notches still 
keep the original shape on the pattern.  
 
Notch Depth: Set the depth of U notches to be cut. 
 
Notch Width: Set the width of U notches to be cut. 
 
The preset range listed as follows - 

                                           Values 
 

 
       Min 

 
     Default 

 
       Max 

 
Notch Width 

 
0,1 cm/0,039 inch 

 
0,15 cm/0,0585 inch 

 
2,54 cm/1 inch 

 
Notch Depth 

 
0,1 cm/0,039 inch 

 
0,5 cm/0,195 inch 

 
2,54 cm/1 inch 

      

      Cut Internal Lines: Cuts internal lines without stitch attributes. 
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Cut Punch Holes: Cut punch holes on the pieces. 
 
Save as Default - Save current settings as default. 
 
Preview – Preview plot job before sending to plotter. 
 
Plot - Execute plotting. 
 
Cancel - Close the dialog box  
 

 
Symbols 
Define and modify the length and type of both Notches and Punch holes; and 
also set the letter size of the piece description.  

                   

Notch Length: maximum 2.54 cm (1 inch). 
 
Notch Type: Standard setting as T or I notches are available 

 
Punch Hole Size: Four sizes options - from largest to smallest (28, 18, 12 & 10) 
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Punch Hole Type: Three standard punch hole types (Cross, Butterfly, Circle). 
 
Use Setting from Document: Check to read the Symbol setting from the file. 
 
Save as Default - Save current settings as default. 
 
Preview – Preview plot job before sending to plotter. 
 
Plot - Execute plotting 
 
Cancel - Close the dialog box 
 
 
 
Page Setup 
Define the paper size or use the paper setting from the Plotter driver. 
 

                  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Canvas: Indicate the width and length of the paper or choose Custom… from 
the scroll menu to customize your paper size of selected plotter.  
 
Shrink to Fit into Paper: Check to resize all pieces fit into paper printed. 
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      Size: Choose the Printer / Plotter listed in scroll menu. Plotter shows the Roll  
      Paper or Custom; and printer shows the pre-set Paper size and Custom.  
       
      Width: Indicate / set paper width 
 
      Length: Indicate / set paper length 
 
      Unlimited: Check to set paper length to be unlimited. 
 
      Default: Change back to default value. 
 

Press Save as Default button to save the current settings as default. 
 
Plot - Execute plotting 
 

      Cancel - Close the dialog box 
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File Menu: Import… 

Select Import… item from File menu to import pattern pieces from 
directory. Choose the imported file format and specify other options 
of the pattern pieces.   

       
 
 
 
 
 
 
 
 
 
 
 

Merge in Current Document: Merge the imported file into current working 
document. 
 
File Format: Select the imported file format, supported format 
listed as follows: 
• Frame: import Frame measurements from a tab-separated text file. 
• DXF-AAMA: Import pattern piece file in AAMA standards. 
• DXF-ASTM: Import Pattern Pieces file in ASTM standards. 
• DXF-TIIP: Import Pattern Pieces file in TIIP standards. 
• DXF-Basic: Import Pattern Pieces file in DXF standards. 

  • Plot file HPGL: Import Pattern Pieces files created in Hewlett- Packard  
  Graphic Language (HPGL) format. 
• Cut file ANSI: Import pattern pieces file from an automatic cutter’s cut file. 
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Importing Frames 
Please refer to Frame Chapter to learn more about import Frames. 
 

Importing DXF-AAMA , DXF-ASTM and DXF-TIIP Files 
If you import the DXF-AAMA, DXF-ASTM and DXF-TIIP format files, the dialog box 
shows as follows. 

 

       
 

Merge in Current Document: Imported file merge as current working 
document. 

 
Units: Select the unit of measurement, i.e. inches, centimeters, millimeters, 
1/32 inch. 
 
Scale: Select the percentage of size of imported piece file (max is 100%) 
 
Import Sewing Lines: Check to include sewing lines of imported piece file. 
 
View Imported Points: Check to show the Imported Points in a template so as 
to check accuracy of results. 
 
Note: The file is imported in Pieces View with grading, if any. 
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Importing DXF-Basic 
If you import DXF-Basic format files, the dialog box shows as follows. 

 
 
 
 
 
 
 
 
 
 

Units: Select the unit of measurement, i.e. inches, centimeters, millimeters, 
1/32 inch). 
 
Scale: Select the percentage of size of imported piece file (max is 100%) 
 
 

Importing HPGL and ANSI Files 
When you choose to Import HPGL or ANSI files, the following dialog box 
appears. 
 
 
 
 
 
 
 
 
Scale: Select the percentage of size of imported piece file (max is 100%) 
 
 
The file is imported in Plan View, with grading information, where you cannot 
re-create the grade nest through the Create Graded Shape function in the 
Treatment menu. 
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File Menu: Export 
Send selected files to foreign systems or compatible software. PAD System 
can create several file types or by different means to communicate with 
the others. 

       

 

 

 

          

 

 

 

      File Format: Select the exported file format and supported export file  
      format listed as follows. 
 

• PAD System Manager (xml): Export pattern information from the PAD System™   
  Manager database (in XML format). 
• PAD System Manager (txt): Exports pattern information from the PAD  
  System™ Manager old version database (in text format). 
• Text File: Export the text information based on selected options  
• Frame: Export the Frame measurements to a tab-separated text file. 
• Specs: Export the frame specs to a tab-separated text file. Specs  
  are the specification measurements obtain from the results of    
  Formulas, Frames (Measurements and/or Levels), the Links and the  
  Segments. 
• Illustrator™ 88 (10%): Export the Pattern to Postscript file format. 
• DXF-AAMA: Export the Pattern Pieces to a file in AAMA standard. 

 
• DXF-ASTM: Export the Pattern Pieces to a file in ASTM standard. 
 
After you select the file format and click OK, a save dialog box requests 
you to enter file name, select the directory and click save to confirm. 
 
Note: Export feature of PAD Manager, DXF and Frame are available 
 in PAD Enterprise only. 
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Export to PAD System™ Manager in txt or xml format 
      You can choose to export the file via PAD System™ Manager into xml or txt  

database format. Click OK to confirm. 
 

 
    
 
       
 
 
 
 
 
 
 
 
Afterwards, you need to select directory and name the file. 
 
The PAD System™ Manager uses these files to compile a full and comprehensive 
database, including PAD System™ marker file information such as cost 
calculations, sewing specifications and the supplier, buyer and sub-contractor 
databases. 
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Export as a Text File 
If choosing export as Text File, the Text File option dialog box shows as follows. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can select following option to customize the file format. 
 
Tab Character: Default as field separator. 
 
Other: You can specify another field separator by putting something inside 
the field. 
 
Repeating Field Character: Several field separator options are available 
and option Other allow you to customize your own 
 
One Line Per Size: Arrange to show information of each size in single line 
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Please OK to save your selections or Cancel to close the window without save. 
An Export format dialogue box follows with clicking OK.  

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can select 4 categories of export information from the drop-down menu 
in the left; i.e. Style information, Style and Grading, Piece Information and 
Piece and Grading.  
You can select list of criteria of the export file format on the left and click Right 
Arrow in the middle to move the chosen criteria to the confirmed list on the 
right. You can also select any chosen criteria from the confirmed list and click 
Left Arrow to remove. 
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There are list of options to export under 4 categories of information, details 
listed as follows  

 

 
 
Click OK to confirm export or Cancel to quit file export window. Once 
confirm export, Export Document as… window will request you to name 
the file and click Save to export the file as per your instruction made 
previously. You had to choose various options of export file format after 
naming the file. 
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Export Frames 
Export the specification information and measurements obtained from the 
Frame function. 

           
You can open by using spreadsheet software, like MS Excel. You can read, 
modify or even use the file to compile different charts by adding value to 
the raw information. 
 
 
Export Specs 

      Export the Specs calculation generated from Frame window. 

           
 
Specs generated from Frame calculations can be exported through Export 
Specs option; and thus, the file can be opened by using spreadsheet program, 
like MS Excel™. You can read, modify and even using it to make different 
charts afterwards. 

 
Note: You must select a style file with Frames before exporting Frames or 
Specs; and, it is only available in PAD Enterprise only. Please refer to Frame 
section of this User Manual for further details. 
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Export to Illustrator (TM) Format 
It would be useful for the one who use this format file to import the pattern 
pieces in vectors to this application. 

 
 
If choosing this format, you had to choose different options to customize your 
results and multiple selections are allowed. You can export - 
 
Plan: Export the Construction plan or the graded Construction plan, 
with or without Template. 
 
• Grading Nest 
• Template 
 
Pieces: Exports the pieces, the graded pieces with piece information 
(from the piece identification dialog box) and Grain Line, and/or 
Sewing Lines, with or without Template. 
 
• Piece Information 
• Grain Line 
• Sewing Lines 
• Grading Nest 
• Template 
 
Scale: Enter the value to specify the export size of selected unit. 
The maximum is 100%; it is between 10% to100%. 
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Export as a DXF-AAMA File 
The DXF-AAMA format pattern file format can only be read by systems with 
translator or file converter.   
 
How to do: 

Select the DXF-AAMA format from the drop-down menu and dialog box 
shows as follows - 
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Units: Select the measurement unit 
 
Scale: Enter the value to specify the export size of selected unit, 
max. 100% 
 
Export Grading: Export the current Grading Nest. 
 

Using Grade Rule Table: Create two distinctive file format: Base Size (*.dxf) and 
Grade Rule Table (*.rul). 
 
Using Grade Nest: Create a single DXF file incorporating both pattern and 
grading. 
 
Export Size Numbers: Export the numbers of each size. 
 
Export Specials: Export the special names assigned in the Grade Working 
Sizes dialog box. 
 
Export Pattern # with Piece Name: Export pattern number. 
 
Reduce Number of Curve Points: Reduce to least number of points of a 
curve.  
 
Export Sewing Lines: Export the sewing lines. 
 
Use DOS Format File Names: Export a file with a DOS-compatible name, i.e. 8 
characters, no space, all capitals with file extension). 
 
One Piece Per File: Create a specific file for each pattern piece and allow you 
to set your format preference and export location.  Exported file can be 
named by pattern number, piece name or in ascending number. You can 
combine or separate above options as per your preferences.  
 
Name the File Using Pattern #: Named by Pattern number 
 
Name the File Using Piece Name: Named by Piece name. 
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Name the File Sequentially: Name by ascending no. of each new piece file. 
 
Automatically Save to: Pre-define the specific path/location to save the export 
file automatically.  This is once and for all action, saving your time in repeating 
path selection afterwards. 
 
Browse…: Browse the directory and save the exported file accordingly. 
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File Menu: Quit 
Close this application and all the open files. 
 
If there is any modification unsaved, system will remind you to save or discard 
the changes; or, cancel to go back. 
 

     
 

Save: Save the unsaved and exit afterwards 
 
Discard: Quit without saving the unsaved 
 
Cancel: Return to previous windows in use 
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Edit Menu 
 

                  
 

Perform editing on current working area or on specific pieces. 
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Edit Menu: Undo/Redo 
Undo - Go back to the latest 3 – 20 moves done on the current 
working area at one time. 
 
You can configure the number of moves recorded in systems. go to Options 
menu; then select Preferences -> General and change the Undo Levels 
(3-20) in the field.  

 
    
Redo - Revert any moves cancelled by Undo command. 
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Edit Menu: Cut 
Cut – Remove the working piece(s) or group of pieces from the working area. 
The cut piece(s) is/are temporarily kept at the clipboard and can be pasted to 
somewhere else of the same working area or in other files. Please be careful 
that the cut pieces will be removed from the clipboard permanently if any cut 
or copy action taken place afterwards.  
 
 

Edit Menu: Copy 

Copy - Copy selected working piece(s) or group of pieces from the working area. 
The origin is/are still kept in the working area while copied piece(s) is/are 
temporarily kept at the clipboard for you to paste on somewhere else in the 
same working area or in other files. Please be careful that the copied pieces will 
be removed from clipboard permanently if any cut or copy action taken place 
afterwards. 
 
 
 

Edit Menu: Paste 

Paste - Paste the previous copied/cut piece(s) or a group of pieces onto the 
current working area. Copied/Cut piece(s) can be pasted in other file. You can 
paste the same piece(s) repeatedly, provided that the copied piece(s) is / are 
still kept in the clipboard. 

 

 

 

 

 

 

 

 

 

 

 

 



 

 112  

Edit Menu: Replace 

Replace - Copy selected piece identification from one piece and to 
replace identification of one or more pieces. 
 
 
How to use: 

1 Select the reference piece. 

2 Select Copy from Edit menu. 

3 Select the targeted piece(s)  

4 Select Replace from Edit menu. 
 
 
Replace Identification dialog box shows as follows: 
   

           
 

5 Check the options to be replaced on the selected piece(s). 

6 Click the OK button to confirm 
 
Copied information will replace the previous copied information. 
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Edit Menu: Clear 
 

Clear – Delete the elements selected or in use 
 
A dialog box reminds you to confirm deletion or cancel it before taking actual 
Clear action.  
   

               
 
 

 

 

Edit Menu: Select All 
Select All - Select all visible elements on the working area. 
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Options Menu 

               

 
Options - List different options to customize your working area and facilitate 
you to work with PAD System. 
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Options Menu: Preferences 

 
         

 
Preferences - Set different parameters to customize your working area. 
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Preferences: General 
Select preferences to customize your working area and offer following options - 

 
Localization 

Language: Define the language used. To choose Auto from the list, the 
language used will be the same as your operating system in use. 

 
 
      Export to Clipboard  

Scale: Set the scale percentage (between10 to 25) of the pasted image by 
simply entering the number (or adjust by arrow). 
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Undo/Redo 
Undo Levels: Pre-determine the number of undo levels by entering a 
value (between three to twenty) and only apply to the newly opened 
documents. 

 
 

Manage 
Allow to save or recall all modifications being made to the Preferences 
under Manage, where your customized preferences are saved with .padp 
extension. 

 
Load from: Browse and retrieve the preference file from directory 
Save Current to…: Save the current preferences in selected location. 
 
 

Security Copy 
Security Copy… – check to save a Security copy of your work at 
pre-determined time intervals automatically. 

 
To configure your application to save a security copy: 
 

 
1 Check Automatically Save a Security Copy to backup any   
  updates and will ask you to give the location of the security   
  copy being saved afterwards. Click OK to confirm. Uncheck to  
  deactivate the function.   
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2 Specify the auto save time interval by determining number of actions  
  taken place after the last auto save. 
 

3 Click Change… to change the Security copy saved location  
Click OK / Apply to execute; or click Cancel to return previous action. 
 
 

Version Control 

Maximum Number of Changesets:  
Predetermine the maximum number (Between1to 3) to save for 
changeset files. The maximum number is between1 to 3. The default 
number is 3. 

 

 

Pattern Assistant 
Auto Check Error before Close: Check this option to start checking before close. 
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Preferences: Display 
Customize your working area as per options selected. Display offers variety of 
options:       

   
 
Unit & Precision 
Length Unit: Select the measurement unit, i.e. centimeter, millimeter and 
inch 
Decimal Places: Define the figure from one (0.X) to six (0.XXXXXX) decimal 
places.  You can input number in the field directly or adjust the number by 
arrow cursor.   
Remove Trailing Zeros: Check to remove zero in measurement. 
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Inline Unit: Check to convert measurement displayed as follows - 
Segment length Measurement Box 
18 inch 18 in 
45.72 cm 45.72 cm 
457.2mm 457.2mm 

 
Display Number as Fraction: Check to show all measurement in fraction 
but require to set the maximum denominator for fraction presentation  
 
Maximum Denominator: Select from 0 to 99 
 
 
 

 
Snapping 

Grid’s Resolution: The Grids value is established for freehand 
selection and arrow manipulations. It allows you to move step-by-step 
according to the chosen value. 

 

 
 
 
 
 
 
 
 

Round Angle: Input the value in the field directly or adjust by arrow. Then, 
you can create the round angle by holding shift key and moving on each 
step as per the angle set at the same time.  
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Contour Line Type  
Select the contour line present in either fine or thick line. 

 
Antialias Line Drawing: Check to smooth out the segment line, no matter 
curve or straight, to achieve more precise drawing. 
Uncheck Antialias Line Drawing        Check Antialias Line Drawing 

           
 
 

 
 
 
 
Contour Attribute: Check this option to show point characteristic 
 

         
       Click to show the characteristic of the selected point 

 
 
Selection Color  
Select the color of line to highlight the selected segments for easier 
identification. You can choose either from current piece color or from the color 
options available.   

 
 

Background Color 
Choose the Background Color so as to make a contrast with your piece 
for easier identification. You can choose System Color (as per default) or 
different colors available (White, Black or Grey).   
 
Choose and click OK to confirm or click Cancel to return. 
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       Preference: Breaks & Colors 
Differentiate different Grading Breaks by their color and name to facilitate 
grading work.    
        
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To assign colors and/or names to Grading Breaks: 
1 Select and change the color of respective grading group by choosing  
  color from the color chart. 
 
2 Rename of each break to replace existing one set by default 
 

3 Choose to display the above color to be applied in break size (Use the  
  Break Size Color) or grading nest (Use the Grading Nest Color).  Please  
  refer to Colors in the Working Sizes section to learn more about  
  configuring Grading Nest Colors.  
  

 Click OK / Apply to confirm or click Cancel to return. 
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Preference: Compatibility 
       Customize your working area by setting language used and its look and feel. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Text Conversion  
Convert text in .sty files saved in previous version (prior to v5.0) to Unicode  
 
PAD Language: Choose the language used from the language list 
available. Choose “Auto” means it will follow as per the default language 
of operating system. “Ask Every Time” means the system will remind you to 
choose language when you open any file saved in previous version 
anytime.   

 
Look & Feel 
Use Floating Toolbox Instead of Toolbars: Check to switch from Toolbars to 
Floating Toolbox. 
 
Click OK / Apply to confirm or click Cancel to return 
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Preference: Hot Keys 
Create shortcuts to facilitate you to carry out different functions so as to 
increase work efficiency.  You can use the default one or re-configure 
your hot key by your own. 
 

      Hot Keys and Menu tab page shows as follows -    
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Hot Keys and Tool tab page shows as follows -    

 
 
Hot Key for the tools most frequent used: 
Ruler -- R 
Rectangle -- T 
Segment -- S 
Curve -- C 
Parallel -- Y 
Point -- Q 
Add Point to Segment --D 
Walking Piece -- W 
Segment Length -- E 
Add Seam -- A 
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How to do: 
1 Select Options -> Preferences- General -> Hot Keys and select Menu or  
  Tool tab page.   
 
2 Highlight specific function to set the Hot Key 

       

       3 Enter the keys on keyboard to create new Hot Key 

         

4 Click OK / Apply to confirm or click Cancel to return 
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Permitted Hot Keys 
Not all Hot Key configurations are allowed to be set in Windows / Macintosh.  
System may prompt a warning message to remind the Hot Key you set is not 
valid. Please review and try again. 

        

 

Invalid Hot Keys, per operating system 
Below shows the Hot Keys configuration that is not permitted in 
Windows and Macintosh operating system. 

 
 
 

Hot Key combinations not permitted by Windows / Linux 
 
F4 + Ctrl Num lock + Ctrl 
 
F4 + Ctrl + Shift Num lock + Ctrl + Shift 
 
F6 + Ctrl Insert + Ctrl 
 
F10 Caps Lock + Ctrl 
 
F10 + Ctrl + Shift Caps Lock + Ctrl + Shift 
 
F10 + Ctrl Space bar + Ctrl 
 
F10 + Shift Space bar + Ctrl + Shift 
 
Esc + Ctrl Tab + Ctrl 
 
Esc + Ctrl + Shift Tab + Ctrl + Shift 
 
Print Screen + Ctrl 0 (w/NumLock) + Ctrl 
 
Print Screen + Ctrl + Shift 0 (w/NumLock) + Ctrl + Shift 
 
Scroll lock + Ctrl + Shift 
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 Hot Key combinations not permitted by Macintosh 
 
 F9 + Shift                         Q + Command + Shift 
 
 F10 + Shift                        3 (Print Screen) + Command + Shift 
 
 F11 + Shift                        4 (Print Screen Selection) + Command + 
                                      Shift 
                                                                                                              
Esc + Command                  Page Up + Command 
 
Esc + Command + Shift            Page Up + Command + Shift 
 
Num Lock + Command            Page Down + Command 
 
Home + Command                Page Down + Command + Shift 
 
Home + Command + Shift          Caps Lock + Command 
 
End + Command                  Caps Lock + Command + Shift 
 
Insert + Command                 Backspace + Command 
 
Insert + Command + Shift           Backspace + Command + Shift 
 
Speaker Key + Command           Enter + Command 
 
Speaker Key + Command + Shift     Space bar + Command 
 
Tab + Command + Shift              Space bar + Command + Shift 
 
Tab + Command                    Return + Command 
 
H + Command                      Return + Command + Shift 
 
Q + Command                      Enter + Command + Shift 
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Preferences: Plot 
Open the Plotter page to set your printer / plotter, select drivers and configure 
different settings and preference accordingly.  
 
You can select the plotters already connected with COM Port (Windows / Linux) 
or Serial Port (Linux) of your workstation / servers. You can select and system will 
scan and detect if there is any printer / plotter connected.   

 
Note: You may require a Keyspan adapter. 

 
 
 To configure plotter driver: 
 1 Select Options-> Preferences -> Plotter: 
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2 Click Add… Select the plotter driver from list. Click Add… to select  
  specific plotter. If you can’t find any suitable one from the list, you can   
  use “Plotter Configuration Wizard” to connect and set up the plotter at  
  ease.  
                  

   
 
 
 
 
 
 
 
 
 
 
       
 

To configure the port setting COM Port (Windows) / Serial Port (Macintosh) 
if necessary. 
Plotter Port: Drop-down menu to select the port that connected with 
respective plotter. 
 
Baud Rate: Drop-down menu with various bauds rate options - 2400, 4800, 
9600, 19200 or 38400 
 
Data Bits: Drop-down menu with data bits options - 7 or 8  
 
Parity: Drop-down menu with Parity options - EVEN, ODD or NONE. 
 
Stop Bits: Drop-down menu with data bits options - 1, 1.5 or 2. 
 
Enable Software Flow Control: Check to activate the software flow control 
 
Enable Hardware Flow Control: Check to activate the hardware flow 
control 
 
Click Next to continue the configuration process. 
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3 Choose the Plotter and click Next to continue. 
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Support Plotter Drivers 
 

Brand                  Model 
Algotex PowerJet-ProJet 
ENCAD CADJET2 
Gerber System SP 200 

GGT AccuMark 100 
GGT AccuMark 300 
GGT AccuMark 700 
GGT AccuMark Silhouette 

Graphtec CE2000 
CE3000 
CE5000 
FC8000 
GP3000 

Hewlett Packard HPGL 2 
HPGL 2 Basic 
HPGL 2 Color 

Ioline Flexjet 
Signature 5000 
Studio 8 
Studio Cutter 
Stylist 2000 
Summit 

Lectra E33 
FlyPen 
Investronica 
Microdynamic 
Plot CF 

Mimaki CG-90 AP 
CG-90 APR 

Mutoh AC-1650 
AC-1650 – Take-Up Roll 

PAD System PJET-2-180/205 
PJET-2-180/205 (Image) 
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Plotter Technology Neon 
TX 

Rui Zhou R Series 
Wild TA40 

TA400 
TA500 

Xerox 2230ij 
 

4 Define the paper sizes with some default options available. 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select Paper: Choose the default Paper Width from the list. 
Example: Roll Paper 157.48 cm width (62.00 in width) 
User had to enter the print margins since print size usually smaller than 
paper size. (measurement in cm)  
 
Custom Paper: If none of the default paper width found, you can check 
and customize the paper width 
 
Paper Margins: Set paper margins - Left, Right, Top and Bottom. 
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Configure Name: Show selected plotter name from previous settings.  
 
Click Finish to confirm. 
 
Paper Margin Setting  
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5 Default Plotter will be chosen in Plot dialog box. 

        

 
Configure…: Configure or Change the setting of selected driver. Click 
Configure… or double click on selected driver to change the setting 
Change the setting of the selected driver. Click Configure... or double 
click the mouse button on selected driver to change the setting or the 
driver of existing Plotter. 
 
Remove: Select and Click Remove to remove the driver. 
 
Set as Default: Select the Plotter then click setting as default. 
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To configure printer driver: 
Besides selecting plotter / driver, you also need to install driver of 
respective plotter; and it will update in Printer list once the driver 
successfully installed.   

      

   

 
Page Setup...: Choose paper size, set margins and/ or orientation. Click OK 
to confirm. 
 
 
 
 
 
 
 
 
 
 
 

 
Set as Default: If you want to save the previous changes of setting, click 
Set as Default to save all of the current setting as default.   
 
The printer driver will show on the File menu, Plot dialog box. 
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      Network Plotting 
Connect the plotter via TCP/IP (LAN, Wireless or Internet) and send plot 
command to network plotter directly. Please refer to Network section 
under Plot Chapter for details. 

 
  How to do: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Address: Enter the server IP Address that connected with the plotter. 
 
Port: Enter the TCP/IP Port number  
 
Account: Username (who is allowed to send the plot command) 
 
Password: Password for that account  
 

    Click OK to confirm 
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Options Menu: Snap to Grid 
Check to activate the grid that allows you to move the pieces or elements 
on the working area using pre-defined grid steps. You can deactivate it at 
any time. 
 
Please refer to the Snapping under Preference Chapter to learn on setup 
the grid. 
 
To check if the Snap to grid function is activated, a small tick has put next 
to it. Check the box to control function activation. 

                       

 

 

 

Info Bar shows the existing settings status. “Grid: On / Off” indicates the 
grid is activated or not. 
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Options Menu: Piece Name List... 
You can create the entire most used pieces name into a list so as to 
facilitate you in working with the pattern pieces. Select the Piece Name 
List… and a list of piece name drawn from Piece Info and Set Piece will be 
enlisted, making it easier to build and a list of the most frequently used 
piece names. The Piece Name List dialog box appears: 
 
 
 
 
 
 
 
 
 

 
Add: Add and name a new blank piece name at the end of the list. 
 
Insert: Insert and name a new blank piece name above the selected piece 
name of the list 
 
Remove: Remove the selected piece name from the List. 
 
Copy: Copy the Piece name from the List to clipboard where you can paste 
this onto target destination in the list or outside, like a database or word 
processing application.  This is particularly useful to move the name position 
within the list.  
 
Paste: Paste the Piece name from clipboard to the list. The source may be 
from current list or outside. Paste function will be activated if only you have 
copy something on the clipboard, regardless the source from.  
 
To rename an existing piece name: Select existing name and rename it, 
avoid duplication. 
 
All items in the Piece Name List are saved in the Pattern Preferences file. 



 

 140  

Options Menu: Reference Code List... 
Create or modify a reference code list and the list is available in Piece Info and 
Set Piece that facilitate you to build and access the most-used reference code 
list. Select the Reference Code List... from Options menu. It shows - 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
Add: Add and name a new blank reference code at the end of the list.  

 
Insert: Insert and name a new blank reference code above the selected 
reference code of the list. 

 
Remove: Remove the selected reference code from the List. 

 
Copy: Copy the Reference Code from the List to clipboard where you can 
paste this onto target destination in the list or outside, like a database or word 
processing application. This is particularly useful to move the reference code 
position within the list.  
 
Paste: Paste the Reference Code from clipboard to the list.  The 
source may be from current list or outside. Paste function will be 
activated if only you have copy something on the clipboard, 
regardless the source from.  
 
To rename an existing reference code: Select the existing reference code 
and rename it, avoid duplication. You can do it by simple cut and paste 
or direct entry. 
 
All items in the Reference Code List are saved in the Pattern Preference file. 
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Options Menu: Fabric List... 
Create or modify a Fabric List and the list is available in the Piece Info and Set 
Piece that facilitate you to build and access the most-used fabric list. 
 
Select the Fabric List from Options menu. It shows - 

 

           
 
Add: Add and name a new blank fabric entry at the end of the list.  
 
Insert: Insert and name a new blank fabric entry above the selected fabric 
name of the list.  
 
Remove: Remove the selected fabric from the fabric list. 

 
Copy: Copy the fabric name from list to the clipboard where you can paste this 
onto target destination in the list or outside, like a database or word processing 
application.  This is particularly useful to move the fabric within the list.  
 
Paste: Paste the Fabric name from the clipboard to the list .  The 
source may be from current list or outside.  Paste function will be 
activated if only you have copy something on the clipboard, 
regardless the source from.  
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To rename an existing fabric name:  Select the existing reference code 
and rename it, avoid duplication. You can do it by simply copy and paste 
or direct entry. 
 
Besides fabric name, you can also change the color by selecting the 
color from the drop-down menu (found at the right). 
 

            
 
 

All items in the Fabric List are saved in the Pattern Preferences file. 
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Options Menu: Notch List... 
 

PAD System™ Pattern software offers three types of system Notches:  
the Simple Notch, the Double Notch and the V Notch. 
 
To create new Notch types: 

Select the Notch List... from Options menu. It shows - 
 

       

 

New: Create a new Notch. 
 
Remove: Remove a Notch from the list. 
 
You can modify the characteristics of the notch easily by inputting 
specifications in the Notch Characteristic directly and click OK to confirm 
changes. Newly created notches are shown to the Notches function in the 
Treatment menu. 
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Creating a Notch 
Click Notch List…from Option menu and click New to create a new notch.. 
 
 
 
 
 
 
 

 
 

Notch Number: A number will assign to the new notch automatically and it 
also helps to identify the 16-button digitization process as well.  This number 
also determines the position of the Notch in the Notches sub-menu under 
Treatment menu.  You can select the notch and adjust by clicking Up or 
Down cursor to change the notch ranking. You can create a new or select 
to remove existing notch by clicking New or Remove.   
 
Notch Name: Name to identify each notch. 
 
You can use three measurements to define a Notch: (max. value 1 inch / 
2.56cm) 
 

 • Depth: Specify the length of the interior (positive value) or exterior 
(negative value) of the shape. 

 
 • Width Perimeter: Specify the width of the notch on the perimeter of 

the shape. 
 
 • Inside Width: Specify the width of the notch at its internal end. 

 
The full size notch diagram will be shown as per the perimeter you set. 

 
Note: All characteristics in the Notch list are saved in the Pattern Preferences 
file. 
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Options Menu: Punch Hole List... 

Create a new or modify existing punch holes by defining its characteristics  
 
Select Punch Hole List…from Options menu. It shows-  

 
 
New: Create a new punch hole. 
 
Remove: Remove a punch hole from the list. 
 
You can modify the characteristics of the punch hole easily by inputting 
specification in the Punch Hole Characteristics and click OK to confirm 
changes.  Newly created punch holes are shown to the Notches function in 
the Treatment menu.  
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Creating a Punch Hole 
Click Punch Hole List…from Option menu and click New to create new punch 
hole. 

  
Punch Hole Number: A number will assign to the new punch hole 
automatically and it also helps to identify the 16-button digitization 
process as well.  This number determines the position of the Punch hole 
in Punch Hole sub-menu under Treatment menu.  You can select the 
punch hole and adjust by clicking Up or Down cursor to change the 
punch hole ranking. You can also create a new or select to remove 
existing punch hole by clicking New or Remove. 
 
Punch Hole Name: Name to identify each punch hole 
 
You can create or customize the punch hole by selecting ten forms of 
punch hole with modifiable measurements in the list where each form of 
punch hole can be used individually or group together.  

      The full size punch hole diagram will be shown as per the perimeter you     
      set. Click OK to confirm and save the settings. 

 
Punch Hole Measurement: max. value 1 inch / 2.54 cm 
 
Click the OK button to confirm your punch hole. 
 

       Note: All characteristics in the Punch Hole List are saved in the Pattern  
       Preferences file. 
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Options Menu: Text List... 
Create a new and modify existing text list that include the most used text 
to facilitate your daily routine operation.  

 
To define or modify the text list: 

1 Click Text List... from the Options menu. It shows –  

 

      

 

 

 

 

 

 

 

 

 

 

2 Click Add to add and name a new text element at the end of the list;  
  click Insert to add and name a new text element above the item  
  selected.  

 
      3 Select the items and then edit the text at the bottom box   
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       The Text List dialog box offers the following options: 
 

Add: Add a new blank element at the end of the list. 

 
Insert: Insert a new blank element above the selected item. 
 
Remove: Remove the selected item from the list. 
 
Copy: Copy the selected text to the clipboard and the paste it to the 
system or outside. 
  
Paste: Paste the text from the clipboard to the list; however, you had to 
make sure something on the clipboard before pasting. 
 

 

Note: Text List is saved in the Pattern Preferences file. 
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Options Menu: Show Toolbox/Toolbars 
Check the Show Toolbox from Options menu to show 
toolbox and a tick () will show next to it accordingly. 
Click again to hide the Toolbox.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

On the other hand, check the Toolbars to show toolbars instead.  
However, you cannot choose both options at the same time.  Please 
refer to Toolbox section to learn more on using tools available in 
toolbox/toolbars. 
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Options Menu: Show Piece List 
Check the Show Piece List from Options menu to show piece list and a tick 
() will show next to it accordingly.  Please refer to Patter Basics to learn 
more on using Piece List.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: Pad Academic editions allow you to save 20 production pieces in 
style file format. 

 
 
 
 
 
 



 

 151  

Options Menu: Show Grading Arrows 
Show Grading Arrows from Options menu that you can use the Grading 
Arrow window to grade a point, a segment, a part of pattern or even 
several pieces at the time in more easier and practical way in doing so.  
A tick () will show if you choose to Show Grading Arrows. Please refer to 
Grading Basic section to learn more on Grading Arrows window. 
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Options Menu: Show Grading Info 
Choose Show Grading Info to show grading information of each selected point 
and a tick () will shows accordingly. Please refer to Grading Basics to learn 
more about Grading Info window. 
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Options Menu: Show Grading Library 

Choose Show Grading Library from Options menu to show the Grading 
Library that provides detail information of the Grading and a tick () will 
show accordingly. Please refer to Grading Basics section to learn more 
about the Grading Library window.  
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Options Menu: Show Frames 
Choose Show Frames from Options menu to show the Frame window and a 
tick () will show accordingly. Please refer to Frame section to learn more 
about Frame window.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: This feature is only available in Pattern Enterprise. 
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Options Menu: Show Technical Sketches 
Choose Show Technical Sketches to show the Technical Sketches window 
that use to build the link between related sketch with the pattern file and 
a tick () will show accordingly. Please refer to Basic Chapter to learn 
more about Technical Sketches window.  
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Options Menu: Show Pattern Assistant 
Choose Show Pattern Assistant to show the Pattern Assistant window that 
use to check error from the pattern file and a tick () will show accordingly. 
Please refer to Treatment menu to learn more about Pattern Assistant 
window.  
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Options Menu: Show Pattern Template 

Choose Show Pattern Template to show the Pattern Template window 
that use to save the most used pattern pieces into a list and a tick () will 
show accordingly. Please refer to Basic Chapter to learn more about 
Pattern Template window.  
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Options Menu: Show Seam Allowance Library 

Choose Show Seam Allowance Library to show the Seam Allowance 
Library window that use to create a list including the frequent used seam 
values and a tick () will show accordingly. Please refer to Basic Chapter 
to learn more about Seam Allowance Library window.  
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View Menu 
Open different views and use variety features of PAD System's Pattern 
applications. 

 

 
   

 

 

 

 Note: Some features and views are only available with the selected    
 options and versions, such as Frame View for PAD Enterprise edition only. 
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View Menu: Plan View 

Plan View is a working area that allows you to create or modify the pattern 
plan by using various tools from toolbox/toolbars, menu and the dialog 
boxes. 
 
You open a Pattern Design file in Plan View as default. You can also open 
the Grade View from the View menu to view the Construction Plan with the 
grading.  
 
You can simply open Frame View from the View menu to view the Pattern 
Frames in Plan view.  You can use Frame menu windows to modify the 
Frames measurements of the file with Frames. 
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View Menu: Pieces View 
 

Use the Set Piece function from Treatment menu to view the pieces 
extracted from the Construction Plan.  The pieces can be obtained from 
digitization or imported from other file format.  
 
You can add Seam Allowance of pre-defined Pattern Pieces in Pieces 
View mode only; and, pieces can be viewed or modified no matter 
whether Seam Allowances is visible or not. 
 
Select Work on Sewing Line from the View Menu or Contextual Menu to 
work on the sewing lines of a piece without altering Seam Allowances.  
You can control any modification that may affect the sewing lines 
until ……To work on the sewing lines of a piece while preserving the same 
Seam Allowances, select Work on Sewing Line in the View menu or 
Contextual Menu. The sewing line becomes non-editable to allow any 
type of internal modifications and is updated upon their return. 
 
You can select the piece then choose Piece Info from Treatment menu to 
modify piece information.  
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View Menu: Grade View 

Select Grade View from the View menu to view pieces’ grading or the 
construction plan.  The Grading View shows all sizes of Grading Nest.  To 
view specific sizes, you can select Edit Checked Sizes…from View menu 
then you can select and view sizes.   
 
You can use grading tools to modify the grading coordinates in both Plan 
View and Piece View. The grading coordinates can be adjusted by 
entering values in the field of Grading Evolutions under Grading Library or 
simply using Grading Arrows to determine.   
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View Menu: Show Checked Sizes... 
The Grading View displays all sizes on the grading nest. 
 
To view specific sizes: 

1 Click the Edit Checked Sizes... from View menu. 

2 Click Show / Hide to show / hide the select sizes 

3 Select Show Checked Sizes…from the View menu to open selected sizes.  
Meanwhile, the base size is always shown at the same time.  

 
 
The particular sizes with Grading information will show if both Grading View and 
Show Checked Sizes are selected from the View menu.  
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View Menu: Edit Checked Sizes... 
You are suggested to hide some sizes when you view particular sizes grading to 
have clearer view. 

 
To change the viewing status of one or more sizes: 
Select the Edit Checked Sizes...from View menu to select which sizes to 
be visible or not. The visible one will have a tick() on it, no matter you  
used Windows, Macintosh or Linux; and uncheck to change it to be    
invisible. 
 

       

                 
Note: All sizes will be shown, no matter whether it marks to be visible or not in 
the Checked Sizes box, if the Show Checked Sizes…is not open. 
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View Menu: Show Sewing Line Grading 

Check Show Sewing Line Grading option to show the sewing line grading. For it 
to work, you must be in Pieces View. To see the effect of this function, being in 
Grade View is mandatory. 
 
The Sewing Line Grading status after you have clicked on the Show Sewing Line 
Grading option changes according to the Sewing Line Grading status of the 
majority. For example, if the Sewing Line Grading of three pieces over four is 
hidden from view, the Sewing Line Grading of every piece is made visible. 
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View Menu: Clone View 

The Clone View item in the View menu (available in Pattern Enterprise) 
allows you to view the selected master pieces and all their corresponding 
clones lined up. 
 
Regular view: 

 
Clone View: 
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View Menu: Frame View 

The Frame View item in the View menu shows you the Frames. 
 
This function is available in PAD System™ Pattern Enterprise. 

 
 
Note: Given the complexity of the Frames, please refer to the MTM-Frames 
section of this User Manual for further details. 

 
 
 
 
 

 

View Menu: Save Changeset View 
 
Check Changeset View to view the changes on each piece in between 
two files. For it to work, you must choose to save the file in File menu and 
Save Changeset. Please refer to File Menu and Save Changeset to learn 
more about Save Changeset. 
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View Menu: Work on Sewing Line 

To work with the seam allowances on the pieces and have them 
recalculated, select the Work on Sewing Line item in the View menu. 
 
The seam allowances remain visible in grey and follow the modifications 
made to the sewing lines. 
 

 
 
 
Note: Manual modifications made on the Seam Allowances do not modify 
sewing lines and are not necessarily maintained after internal modifications. 
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View Menu: Template 

The Template item in the View menu allows you to view or hide specific 
information about templates: 
 
• The template of the contour 
• The template of the grading 
• The template of the sewing line 
 

             

 
Template: By checking Template, you can display the defined templates 
on the pieces according to the Piece Information (Treatment menu). 
 
Template Grading: It shows all the template grading. You must be in Grade 
View to view the result. 
 
Template Sewing Line View: It shows all the template sewing lines. The Show 
Sewing Line Grading option must be active for that function to work. 
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View Menu: Show 

The Show item in the View menu allows you to view or hide the following 
elements in the working area: 
 
• The grid on the background 
• The text in each piece 
• The grain line of the piece 
• The numerical sewing value of the sewing lines 
• The numerical value of the segments 
• The image in each piece 

 

 
 
 
Grid: By checking Grid to show Grid in background 

 
 

Text: By checking Text, you can display the Text on the piece and place it to 
the required location. Show Text posts the defined text on the piece 
according to the Piece information (Treatment menu). 
 
 
Grain Line: By checking Grain Line, you can display the grain line and place it 
on the piece. You can define the length of the line using Piece info (Treatment 
menu) and clicking the Grain line... button. 
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Sewing Value: By checking Sewing value, you can display all the 
numerical sewing values on all the sewing lines. 

  

 

Segment Value: By checking Segment Value, you can display all the numerical 
sewing values on all the segments. 
 

Image: By checking Image to show Image on the piece 
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View Menu: Zoom 
The Zoom item in the View menu allows you to select from the menu a preset 
visualization of the working area or a customized zoom level. The zoom level 
can be set at any value between 0.5% and 2000%. 
 
Global View: It displays all the pattern pieces on the screen, regardless of  
their position on the working area. 
 
Zoom on Selection: It zooms on the selection and displays it in the center of 
the screen. It is available if one or more pieces are selected. 
 
Click the Zoom Out/Zoom In icons to obtain preset zoom views based on the 
screen resolution (0.5%, 1%, 2%, 3%, 4%, 5%, 6%, 8%, 10%, 20%, 25%, 33%, 50%, 
100% and 200%). 
 
These options are available in the Zoom Menu as well, which is located to the 
bottom left side of the Pattern application. For further details, refer to the 
Basics chapter of this user manual. 
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Navigating Through the Open Files 
In the last section of the View menu, you can see the files that you have 
opened. The active file has a check mark next to it. It is unlimited on files 
opened at the same time. 
 
First file is selected                        Second file is selected 
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Treatment Menu 

 

 

 
The Treatment menu provides many useful tools to create and/or modify 
your work. One or more pieces must be selected to unlock the different 
items of the menu. 
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Treatment Menu: Set Piece and Piece Info 

The Set Piece and Piece Info functions are very alike, so they are 
explained together. 
 
You must first identify the pieces to create the pattern pieces from the 
Construction Plan to the Pieces View. 
 
There are two methods to set a piece. 

 
To set pieces using the Treatment menu: 

   1 Select the polygon to set as a piece, including its internal references,  
  which must be grouped to the piece. 
2 Select the Set Piece... item from the Treatment menu to describe the  
  piece. 

3 The Set Piece dialog box appears. You can enter information about    
  the piece. 

 
 

To set pieces using the Contextual menu: 

1 Right-click the piece (Windows / Linux) or click the piece while  
  holding down the Control key (Macintosh). 

2 Select the Set Piece… or the Piece Info... item from the Contextual  
  menu. To set a piece, you have two options: 

 • Set Piece from Cut: The system detects the contour of the smallest    
  polygon within the click position and set it as a piece. 
 • Set Piece from Contour: The system selects the contour of the Pattern      
  piece, including the internal darts and punch holes. 
 

 
          To set pieces using double Left Clicks to select the polygon and set it as a  
       piece. 

1 Put the cursor on the piece  
2 Double left clicks on the piece and the cursor will change to “+” sign. 
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3 Then drag the cursor to the polygons, a guideline in Pink color appears  
  to identify the pieces. The contour lines of the selected pieces activated  
  as follows. 

  
 

 

4 Then right click on mouse, Piece Info dialog appears. 
 
 
Note: To ensure the success of this operation, all the lines of the piece must 
be attached and/or grouped together. 

 
 
 

The Piece Info... item allow you to view or edit information about the selected 
piece(s). You can access this dialog box via the Piece Info function in the 
Treatment menu, using the Contextual menu, or through the Piece List window 
by pressing on the button. 
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To get the info of a piece: 

1 Activate the piece you want to get info about. 

2 Click the Piece Info... item in the Treatment menu. The Piece Info...  
  dialog box appears. 

 
 The Set Piece and Piece Info dialog boxes offer the following options: 
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The first section in the dialog box indicates the number of selected pieces. 
 

The second section is the piece identification. It displays piece information 
as it appears on the piece. 
• Pattern #: It is the style number. It has to be entered for the first piece only.  
  The subsequent pieces set get the same number, but it can still be    
  changed if needed. 
• Piece Name: The piece name, which can be selected from a predefined    
  list in the Piece Name List… dialog box. 
• Description: Additional information describing the piece. 
• Piece Code: It indicates the need for special piece treatment or any  
  additional information. 
• Reference Code: It is an identification code for the piece or any  
  additional information that can be selected from a predefined list    
  in the Option menu –> Reference Code List... by clicking the  
  pop-up menu that has the shape of a triangle next to the text field. 
• Quantity to Be Cut: The quantity of pieces needed for a complete  
  garment. Single means a right-side-up piece and Paired means two  
  pieces: a left piece and a right piece. 
• Fabric: It identifies a fabric for a given piece or group of pieces,  
  which can be selected from a predefined list in the Options menu – 
  Fabric List item by clicking the pop-up menu that has the shape of  
  a triangle next to the text field. If a color code is given, the piece  
  changes/adds color automatically. 

*The item of Fabric in Set Piece’s dialog box, it can memorize the last 
selected fabric. Then the next piece will choose to the same fabric until 
you choose the new one. 

 
 
The third section allows you to add a Marker ID on chart pieces when a 
marker is made with this pattern. 
• Marker ID: A two-letter code to identify special treatment of the piece on  
  the chart of the Marker Experience and Marker Enterprise products. You can    
  modify or add this information at the marker level. It does not affect the link   
  function if the pattern is linked to the marker file (the marker user has priority). 
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The fourth section allows you to identify or determine whether the piece is in 
Plan View or Pieces View, or if it is set as a Cloned piece. 
 
Additional information indicates the piece status: whether the piece 
is Locked or Unlocked, or Editable from master only. 
• Plan: It indicates that a pattern piece is set in Plan View for future   

        modifications. 

• Plan Clone : It indicates that a piece in Plan View is linked to the Master    
 Piece in the Plan. All modifications made to the master are reflected on  
 the Clone Piece. 

• Piece: It indicates the creation of a Pattern piece for the Piece List  
  window. This allows you to add seam allowances and modify  
   patterns. Pieces in Pieces View appear in Pad System Marker product. 

• Piece Clone : It indicates that a piece in Pieces View is linked to the  
 Master Piece in the Plan / Pieces. All modifications made to the master  
 are reflected on the Clone Piece. 

 

      • Unlocked: It allows modifications on the piece. 
   • Editable from Master Only: When checked, it blocks the cloned piece from  

    any modifications made on its contour, allowing modifications only from the  
   master on the contour. Internal references can still be added, modified or  
    removed from the clone. 
• Locked: It disallows any modifications. The piece is available as a reference 

        (read only) until unlocked. 
• Save as Default: It saves the current settings as default. 

 
The fifth section allows you to Add, Remove, Detach or Reset a Template 
to/from the selected piece(s). 
• Template: It creates a carbon copy (Template) of selected pieces. The  
  carbon copy remains intact, even if the pieces are moved or modified 
  with any graphic tools. To remove the template, simply uncheck this box. 
• Detach: It retrieves the original piece used as a carbon by selecting the  
  Detach check box. Detach becomes available once the Template check  
  box is not selected. 
• Reset Template: It deletes the template of the piece and creates a new  
  one according to the current shape of the piece. 
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The Set Piece and Piece Info dialog boxes’ buttons: 
 

Sizes...: It brings up the Sizes Info dialog box, which allows you to view the 
following size information: 
 

        
 
 

• Show Areas and Perimeters: It displays the area and perimeter of the  
   selected piece(s) for all sizes. 
• Show Widths and Heights measurement: It displays the width and 
height measurements of the selected piece(s) for all sizes. 
• Show Width and Height Differences: It displays the width and height     
  differences of the selected piece(s) from the Medium for all  
   established Working Sizes in the Grade menu for all sizes. 

• Show Special: It displays the special name used in the Working sizes  
  dialog box, in the Grade menu. 
 

      Click the Done button to close the Sizes Info dialog box. 
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Grain Line…: Click the Grain Line… button to establish grain line options. 
You can set the location of the arrowhead (to the left and/or to the right) 
and adjust the length of the arrow (in percentage [%] within the piece). 
This option is available in Pieces View. 

 
 

                    
 

• Left Arrowhead: You can obtain a left arrowhead on the grain line. 
• Right Arrowhead: You can obtain a right arrowhead on the grain line. 
• Length %: It determines the length of the grain line using the total  
  length of the piece. 
• Save as Default: It saves the current settings as default.  
 
Click the OK button to validate the settings. 

 

Color…: It brings up the Piece Color dialog box. It allows you to assign a color 
to the piece, providing better visual identification of the piece on the current 
working area or when making future modifications. If the color of the fabric 
has been preset in the Options menu > Fabric List, the OK button is not be 
available. 
    

          
                                               
Click the OK button to save your selection and close the dialog box. 
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Options...: It brings up the Piece Treatment Tolerance dialog box, which lets you 
remove or allow various manipulations on the piece in Pad System's marker 
applications. 

           
 
Piece Treatment Tolerance: By selecting the Save as default check box, you 
can assign treatment tolerances to each piece or the entire garment. These 
characteristics constrain the manipulation of a piece in the PAD System™ 
Marker application. 

 

The Tolerances for piece treatment are: 
 
• Rotation: At 45°, 90°, 180° or none. 
• Fine Rotation Tolerance: It allows you to use or inhibit a fine rotation (tilt). 
• Symmetry: In X, Y or both or can be allowed or inhibit. 
• Paired Piece Follow-up: It applies symmetry and rotation to the other side of 
  a paired piece. 

  • Paired Piece Symmetry on X or on Y: It places the other side of the  
  paired piece – in X or Y symmetry – next to the first piece in the pair. 
• Save as Default: It saves the Piece Treatment Tolerance parameters 

  as default. They are applied to all other pieces set afterward 
 
Press the OK button to validate the settings. 
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Set Pieces in Pieces View 
You can define pieces in Pieces View.. This function is very useful when you 
want to obtain an identical piece in another type of fabric. 

 
To set a piece with the active seam allowances: 

1 Select the entire piece. 

2 Select the Set Piece function in the Treatment menu. 

3 Enter the fabric in the appropriate zone. 

4 The piece appears on the list with the associated fabric. 
 
 
To set part of a piece when a piece already has Sewing Lines: 

1 Select the Work on Sewing Line item in the View menu to  
  suspend seam allowance values. 
2 Select the entire piece or the portion to be set as a new piece. 

3 Select the Set Piece function in the Treatment menu. 
 
 
For example, if style lines are drawn and a piece is set from a portion of 
it, the original seam allowance is created.  If the two extremities of the 
style line have the same seam allowance, the seam on the separated 
edge gets the same value. If the extremities have a different seam 
allowance, a variable seam allowance is added to the edge. 
 
 
Note: Any type of pattern modification may be applied to the pattern piece 
when the Working on Sewing Line function is active. 

 
 
 
 
 
 
 
 



 

 184  

Treatment Menu: Item Info 

The Item Info… option in the Treatment menu allows you to obtain/edit 
information on selected elements. Using this command, you can modify all 
types of Points, curved Segments and PAD System™ intelligent objects, such 
as Mirrors, Darts, Pleats, Shirring, Seam Allowances, Seam Corners and Seam 
Ends. 

 
To get the information about selected elements: 

1 Select the item(s) you want to obtain information about or edit  
  information of. 

2 Select the option Item Info… in the Treatment menu. 

3 You obtain a different dialog box depending on the item(s) you  

  selected (Notch, Darts…) which contains useful information. Each 

  one is described on the following pages. 
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Point Characteristics… (Points, Notches, Punch holes) 
If you selected a point, the Point Characteristics dialog box appears, allowing 
you to modify a selected type of point. You can modify a point type by 
combining it with other types of points, depending on the required result. 
 
The Point Characteristics dialog box is divided into two sections: 
 
The first section displays the number of selected points. 
 
The second section displays the types of points that can be modified or 
combined with a different type of point attribute. 

                                 
 
 
 
 
 
 
 

 

 Regular point: This type of point appears at the beginning and at the  
      end of a segment. The system reads a segment from one Regular point  
       to the next Regular point, including all points between the two ends.  
      Regular points are added when working on the pattern piece. 

 
          Mark point: Mark points are added to the contour of a pattern piece,  
                by using either the Add a point to a line or Add point tool. 

 
   Control point: These points pull on the segment to hold your curve.  

     They are based on the Bezier curve principle. 
 
Piece Matching Points: It is used by the Marker product to align pattern pieces 
to guidelines or plaid and striped lines. 
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Pre-Set CNC Cutter Functionalities in Pattern application 
Start Points: This option allows you to pre-set the cutting Start Point from 
pattern application. These points are control where, on an automatic cutter, 
the knife will plunge to start cutting a piece.  
 
Lift and Plunge: This option allows you to pre-set the Lift and Plunge command 
from pattern application. The Lift and Plunge point tells the cutting knife 
where to lift, pivot and plunge while cutting a piece. This tool is particularly 
useful to ensure precision when cutting a sharp corner or other detail. 
 
Symmetrical Start / End Point: This option allows you to pre-set the Symmetrical 
Start / End command from pattern application. The Symmetrical Cut tool tells 
the cutting knife to cut in two directions at once while cutting a piece 
from the fabric. The knife will cut half of the piece clockwise and the other 
half of the piece counter-clockwise. By doing so, you can obtain a more 
precise cut. 
 
Internal Start Point: This option allows you to pre-set the start point command 
on the Internal Lines from pattern application. The Internal Start Point controls 
the knife will plunge to start cutting on the internal line. 

 
Note: Some of Points features for CNC cutter are available in Pattern 
Enterprise. 

 
Position: It indicates the X and Y coordinates of the point on the working area. 
 
Desizing: If a temporary desizing is applied, these fields will show the desizing 
value for the selected point. 
 
 
Note: If more than one point has been selected, the Position and Desizing fields 
are empty if the values for each point are not identical. 
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Curve Characteristics… 
You can obtain information on a curve by selecting the curve segment 
and selecting Item Info… in the Treatment menu. 
 
The Curve Characteristics dialog box calculates the Length and the 
Depth of the selected curve (the deepest point of the curve from a 
straight line calculated between the two [2] stand points). 
 
You can modify both Length and Depth, but not during the same 
operation. 
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Dart Characteristics… 
You can obtain information on a dart by selecting the dart and clicking the 
Item Info… item in the Treatment menu. Select the dart by clicking its center 
segment. All information in the Dart Characteristics dialog box can be 
modified.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can add punch holes and notches to the dart. In the Dart Characteristics 
dialog box; simply click the small circles inside the dart representing the 
location of punch holes and notches. 
 
Along with the Width and the Length, the Dart Characteristics dialog box 
allows you to view and modify the following characteristics: 
 
Cut Jug at: It gives a specific length to the tip of a dart. 
 
Closing Side Clockwise: It folds the dart clockwise, if checked, or counter 
clockwise, if unchecked. 
 
Finished Length: It calculates the position of the punch hole from the top for 
an open dart. 
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Pleat Length: It obtains a pleat dart, applies the value of the dart width parallel 
to a distance calculated from the top of the dart. 
 
Punch Hole Distance: It calculates the distance of the punch hole from the 
pivot point of the dart. 
 
Punch Hole Distance from Side: It customizes the distance of the punch hole 
from the edges of the dart for punches of open darts and pleat darts (does 
not apply to pivot point punches). 
 
Save as Default: It saves the dart's settings and reapplies them on all future darts 
and its punches. 
 
Remove Characteristics: It removes the dart graphic and leaves the contour 
information and its punch holes and notches. 
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Pleat Characteristics… 
You can obtain information about a pleat by selecting the pleat and clicking 
the Item Info… item in the Treatment menu. All information in the Pleat 
Characteristics dialog box can be modified.  

 
  
You can add punch holes and notches to the pleat. In the Pleat 
Characteristics dialog box, simply click the small circles inside the pleat 
representing the location of punch holes and notches. 
 
The Pleat Characteristics dialog box allows you to view and 
modify the following characteristics: 
 
Width: It is used to enter or modify the width of the pleat. If you 
require a radial pleat, enter measurements into the A and B text 
boxes. 
 
Pleat Type: To choose the pleat type to develop; Pleat, Box Pleat and 
Inverted Pleat. 
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Punch Hole Distance: It marks a finished measurement from the end of 
your pleat. You can assign different values to Side A and Side B. 

Punch holes and notches can be added to each side of the pleat (Side A and 
Side B) using the pleat graphic in the dialog box. Simply click the small circles 
that represent the location of punch holes and notches. 
 
Closing Side Clockwise: It folds the pleat clockwise, when checked, or 
counter- clockwise, when unchecked. 
 
Punch Hole Distance from Side: It customizes the distance of the punch hole 
from the edges of the pleat. 
 
Remove Characteristics: It removes pleat information from the pattern shape. 
 
Save as Default: When checked, it keeps the settings of the pleat (punch 
hole distance and notch locations) and reapplies them on all future pleats. 
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Shirring Characteristics… 
You can obtain information on a shirring by selecting the shirring and clicking 
the Item Info… item in the Treatment menu. All the information in the Shirring 
Characteristics dialog box can be modified. 
 

                      
 
The Shirring Characteristics dialog box allows you to view and modify the 
following characteristics: 
 
New Length: It modifies the length of the selected segment. 
 
Measure to Add: It adds a measure to the selected segment. 
 
% of Actual Length: It adds a value in percentage (%) to the selected 
segment. 
 
Smoothing Algorithm: Select Tangents to keep tangents at the intersection of 
lines, while opening the piece. Select Best Fit if the tangent cannot be reached. 
The algorithm chooses the best fit possible. 
 
Modifications can be made to side A and B (if applicable). 
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Seam Characteristics… 
You can obtain information on a seam by selecting the seam's internal line and 
clicking the Item Info… item in the Treatment menu. All information in the Seam 
Characteristics dialog box can be modified. 

                   

 
The Seam Characteristics dialog box allows you to choose between two 
types of seam allowances: 
 
Constant: It is a seam allowance that is parallel to the piece perimeter. 
 
Variable: It is a seam allowance with a different value at the beginning and 
at the end of the selection. 
 
Notches can be added independently for each extremity if the Notch for 
Value on Side 1 and Notch for Value on Side 2 check boxes are checked. 
 
Follow Notch Orientation: It projects notches on the sewing line(s) according  
to the notch orientation. 

 

 
 
 
 
 
 
 
 



 

 194  

Seam Corner Characteristics… 
A seam corner is created whenever two seam allowances meet. A seam 
corner can be created on any sewing line's mark or regular points. 
 
You can obtain information on a seam corner by selecting the seam corner 
and clicking the Item info… item in the Treatment menu. All information in 
the Seam Corner Characteristics dialog box can be modified. 
 

          
 
 
 
 
 
 
 
 
 
        
 
           

The Seam Corner Characteristics dialog box offers the following options:  
 
Standard: It creates an even seam allowance all around the pattern pieces. 
 
Hem (Symmetry) on Side 1: It mirrors the hem allowance on identified side 1. 
 
Hem (Symmetry) on Side 2: It mirrors the hem allowance on identified side 2. 
 
90° Corner on Side 1: It squares off the seam allowance on identified side 1. 
 
90° Corner on Side 2: It squares off the seam allowance on identified side 2. 
 
90° Corner on Both Sides: It squares off the seam allowances on both seam 
allowances (sides 1 and 2). 
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Cut Corners on Notches: It removes the corner edge at the seam allowance 
value. 
 
Cut Corner: It enters a value to remove calculation from the garment. 
 
Cut Corner on Bias: It removes the seam allowance from both seams, on the 
bias. 
 
Seam's End Corner Characteristics… 
Each extremity of a seam allowance is called the Seam's End. You can 
adjust Seam's Ends if no other seam allowance is to be added. 
 
You can obtain information on a seam’s end by selecting the Seam's 
end reference(s) and clicking the Item Info… item in the Treatment 
menu. All information in the Seam’s End Corner Characteristics dialog 
box can be modified. 

                    

 
The Seam’s End Corner Characteristics dialog box offers the following options:  
 
Perpendicular: It adds a parallel seam allowance. 
 
Extension: It adds the seam allowance on the same axis. 
 
Hem (Symmetry): It mirrors the seam value. 
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Text Info 
When a text element is selected, this Item Info... item in the Treatment menu 
opens the Text Info dialog box. 
 

         
 
Note: For further details about this box, see the Text tool section in this user manual. 
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      Treatment Menu: Points 
 
 
PAD System™ offers three different types of Points (Regular, Mark and Control), 
which are described in Chapter 1. The Points function is available through the 
Treatment menu. 
 
You can modify or swap Points depending on whether they are being used for 
a pattern, marker or automatic cutter. 
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Treatment Menu: Notches 
PAD System™ offers three types of Notches by default. These Notches are 
available in the Treatment menu under the Notches option. 
 
• Simple Notch 
• Double Notch 
• V Notch 
 
To create a Notch: 

1 Select the Point(s) on the piece (regular or mark) that you want to       
  define as a Notch. 

2 Select the desired Notch in the Treatment menu. 
 

You can personalize System Notches using Plot and Symbols in the File 
menu. The Symbols item in the Plot window lets you set the length of plotted 
or cut notches (up to a maximum of 2.56 cm or 1 inch) and adjust the type 
to either a Slit or T Notch. 
 
You can create your own User Notch List. To customize a variety of shapes, 
open the Option menu and select Notch List. Once created, the customized 
list is available in the Treatment > Notches item. 
 
To restore a Notch to a Point, select the Notch you wish to convert and return 
to the Notches option in the Treatment menu and select Point. 
 
Example of system notches:  
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Treatment Menu: Punch Holes 
To create a system Punch Hole, you must group a Point inside the piece 
that is to be converted to a Punch Hole. To do so, use the Punch Holes 
function that is in the Treatment menu. 
 
System Punch Holes can be modified using Plot and Symbols in the File 
menu. The Symbols item in the Plot window lets you set the size of the 
plotted Punch Holes (28, 18, 12 and 10) and the Shape to X, Bow or Drill 
Hole. 
 
You can create your own Punch Hole List. To customize a variety of shapes, 
open the Option menu and select Punch Hole List. Once created, the 
customized list is available in the Treatment menu under Punch Holes. 
 
To restore a Punch Hole to a Point, select the Punch Hole you wish to convert 
and return to the Punch Hole option in the Treatment menu. Select the Point 
option. 
 
Example of punch holes
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Treatment Menu: Segments 
The Segment type dialog box enables you to edit the appearance of an 
internal segment. 

 

                

To use this function: 
 
1 Select the segment(s) you wish to change (internal segments only). 

2 Select the Segment item in the Treatment menu. 

3 Select the desired type of segment. 

4 Enter the desired value (by Dash Length, Gap Length and/or Height) 

  into the text boxes at the bottom of the dialog box. 

 
Note: You can cut Straight Line Segments. Other types of lines can be plotted, 
but not cut. 
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Example of segments: 
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      Treatment Menu: Group/Ungroup 

The Group item in the Treatment menu group elements from the plan 
together. Alternately, the Ungroup item ungroup elements. 
 
A point or a piece can be a primary group. You can group these elements 
together so that they are selected as if they were one element. The internal 
references, like punch holes or pockets, can be created and grouped to 
Pattern pieces prior to setting the pieces. 
 
To group items, select the elements to be grouped and select the item Group in 
the Treatment menu. 
 

To ungroup items, select the elements to be ungrouped and select the 
Ungroup item from the Treatment menu. 

 

        

 
Note: The Group/Ungroup functions are available in Plan View. 
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Treatment Menu: Align Shapes... 
To align selected shapes together in the Construction plan or in Piece view, 
select two or more points, with at least two of which are on two different 
pieces. Select the Align Shapes… item from the Treatment menu. 
 
There are two different types of alignment available 
 
Align on Enclosing Rectangles 
 
When two points or more per shape (or group) are selected, the shapes are 
tilted to align on the selected axis identified by the selected points. Different 
alignments are offered for a Horizontal or Vertical Axis: Left Side, Vertically 
Centered, Right Side, Top, Horizontally Centered and Bottom. 
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Align on Selected Points 
Alignment can be based on two or more selected points (including curve 
points).When one point per shape (or group) is selected, the shapes can be 
moved horizontally or vertically (or both) to be aligned on those selected 
points. 
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Treatment Menu: Scale... 
 
The Scale… item in the Treatment menu scales the selected Pattern pieces. The 
scale can be done independently in X and Y or measured around the piece. If 
you wish to scale the piece according to one axis but want the other axis to 
scale proportionately, check the Lock Proportions check box. 
 
To scale a shape, activate the desired shape and click the Scale... item in 
the Treatment menu. The Scale dialog box appears. To scale a piece, 
select the appropriate radio button and enter the desired scale values. 
 

         
 
The Scale Measure reflects values entered in the Scale Measure dialog box. If 
the value is negative, a portion with the entered value parallel to the contour of 
the piece is removed (going inside the piece, making it smaller). If the value is 
positive, a portion with the entered value parallel to the contour of the piece is 
added (going outside the piece, making it bigger). 
 
When using a percentage (%) scale, select the Scale Grading check box 
to proportionately scale grading evolutions. 
 
Master Pattern remembers the original size of the piece that is scaled. That way, 
you can always get the piece back to its original size. If you wish to make the 
scaling permanent, you must check the Permanent Scaling check box in the 
Scale dialog box. The new size is considered the original size for any subsequent 
scaling. 
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Treatment Menu: Optimize 

        
 
The Optimize submenu modifies your pattern to give you optimal results. 

 
 

Optimize: Simplify 
 

 
In some instances, after gathering shapes and style lines and finishing the initial 
manipulation for creating new starting blocks or basic shapes, it is necessary to 
optimize shapes. 
 
The Simplify... command removes any superficial points (curve and regular) on 
a shape, within the user’s defined values. 
 

   
 

Treatment > Optimize > Simplify... is useful after importing files from other CAD 
Systems, which may create too many points. 
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To simplify a shape: 

1 Activate the desired shape(s). 

   2 In the Treatment menu, select the Simplify… item in the Optimize  
  sub-menu to open the Optimize dialog box: 

           

 
3 Select the appropriate check box: 
 

    • Merge Overlapping Points (Regular and/or Mark): It removes    
    any extra points within a defined value. 
  • Merge Small Curves: It remove any extra curves within a defined value. 
 
4 Press the OK button to execute the function. 
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Optimize: Create Graded Shape 
The Create graded shape command creates a graded pattern shape from 
separate pattern pieces. This command is useful when you cannot obtain a 
grading nest in a usual way. For example, to create a graded pattern shape 
from pieces that were digitized separately or imported from plot files. 
 
To create a graded shape from independent shapes: 

1 From the Grade menu, select the Working Sizes... item to establish the  
  desired grading nest in the dialog box. 
2 On all pieces, select a common point and change it to the start point  
  (Treatment > Points > Start Point). 

3 Select and align as desired the pattern pieces along the desired  

  grading nest. 

4 Keep the start point selected and go to Create Graded Shape in the  
  Treatment menu, Optimize sub-menu: 

 
Some conditions are mandatory to create a graded pattern shape through 
Create graded shape. 
 
You must have: 
 
• The same number of regular points for each pattern piece. 
• The same start point on each pattern piece. 
• All curves must be located at the same position on each pattern piece. 
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Optimize: Create curves 
 

The Create curves command creates PAD System™ curves in imported files 
from other systems (Gerber, Lectra, etc.). 
 
To create curves out of straight lines: 

1 Select the straight lines you wish to convert to curves. You must  
  select a minimum of three points. Selected points must not pass  
  through darts, pleats or shirring. 

2 In the Treatment menu, select the Create curves item from the  
  Optimize sub- menu. 

 
Example of a created curve: 
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Treatment Menu: Pathfinder 

       

The Pathfinder sub-menu in the Treatment menu finds the intersecting point of 
two intersecting segments, creates an outline of superimposed shapes and 
transform corners into smooth edges. 
 
Pathfinder: Intersect Lines 

 
Intersect Lines, in the Pathfinder sub-menu, Treatment menu, finds an 
intersection point between two segments. This is useful when you wish to project 
a point on a segment based on a selected line. 

 
To intersect lines: 

1 Select the two segments (only two points per segment) that intersect  
  each other. 
2 Select the Pathfinder > Intersect Lines option, in the Treatment menu.  
  This adds a point each time the two lines intersect each other. The  
  point will be projected if the segments do not touch one another. 
 
  Example of the Intersect lines function result: 
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Pathfinder: Create Outlines 
 

Create Outline finds the outline of superimposed shapes and builds a clean 
polygon out of internal lines. This function is useful when you need to 
define a new contour. 
 
To create an outline: 

1 Select all polygons (they must touch or intersect one another). 

2 Select Pathfinder > Create Outline in the Treatment menu. Create  
  Outline adds a point each time a segment intersects another.  

  All internal segments will be retained. 
3 Erase the internal segments if you wish the pieces' juncture to  
  create a new, clean polygon. 

 
  Example of the Create Outline function: 
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Pathfinder: Smooth Curves 
 
The Smooth Curves function in the Pathfinder menu, Treatment menu, 
transforms corners and sharp edges into a smooth shape by creating curves. 
 
To smooth curves: 

1 Select the segment(s) you wish to modify. 
2 Select Pathfinder > Smooth Curves, from the Treatment menu. 

 
This process modifies all the selected lines and adds curve points to the 
reshaped pattern pieces: 

 
      Before                                After 
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Treatment Menu: Pattern Assistant 
The Pattern Assistant… option in the Treatment menu assists users to check 
error from the pattern file.  
To do so: 
1 Select the option Pattern Assistant in the Treatment menu. 

   
 

2 A dialog box appears and all of options to be default on it. 
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3 Press Start button and search the error for all of pieces. The floating 
window for Pattern Assistant displays all of the items of the error pieces. 

 

 

4 Click one of the items from the floating window. It will indicate the piece   
on full screen. Here is the error message for Seam Allowance. 
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An error message for grading 

    

 

An error message for Point overlap, it will indicate the position (coordinates) 
of the overlapped point. 
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An error message for Notch overlap, it will indicate the position 
(coordinates) of the overlapped point. 

 
 

An error message for Line overlap, it will indicate the position (coordinates) 
of the overlapped point. 

 

5 Once the error message is being chosen, it will turn it to Grey color. 
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Check Error on the Selected Piece 
 
Right click on mouse to choose Pattern Assistant. A dialog box appears 
and press Start button to search the error on the selected piece. 
 

 
 

 

 

Check Error When Closing File 
 
Go to Option menu, Preference and General tag page. 
The item is checked, it will start Pattern Assistant if you close the existing file. 
You may press “Esc” button from keyboard to Force Quit this function. 
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Grade Menu 

 

 
 

 
 
 
When developing a new style, the grading of pattern pieces is updated, 
according to the grading of the original pattern pieces. 
 
If you require a specific Grading evolution, the modification can be 
done in a number of ways, by: 
 
• Using Grade View tools 
• Modifying the coordinates of a point in the Grading Info dialog box 
• Using the Grading Library to apply an evolution 
• Using the Grading Arrows function 
 
This menu is described in the Grading chapter of this manual. 
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Base Menu 
 

                 
 

   

   

                   

To open Pattern Basic Blocks: 

1 Select the New item from File menu.  

  A dialog box appears: 

              

 
2 Select one of the four Algorithms, for example, the Skirt. 

3 Click the Open button. 

 

Once the block is open, the Base menu becomes accessible for 
modifications.  

 

Different types of adjustments are possible through the four items of the 
menu. For each Base, the measures can be changed and saved as a 
new Base files (*.bas) for future pattern developments. 
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Base Menu: Standard Measures... 
The Standard Measures... item in the Base menu displays the basic 
measurements according to the chosen algorithm.    
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can modify all these measurements as a total body measurement. 
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Base Menu: Specification Measures... 
The Specification Measures... item in the Base menu allows you to modify 
specific pattern values according to the chosen algorithm. 
 

 
 

 

 

 

 
 Note: There is no specification measures for the Sleeve. 
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Base Menu: Ease Measures... 
The Ease Measures... item in the Base menu allows you to modify the ease 
measurements of the pattern according to the chosen algorithm. 
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Base Menu: Grading Evolutions 
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Help Menu: About Pattern Design... 

  
 
      License Manager… item, a dialog box appears to show the info of the license 

code. 

        
 

Check Updates… item, a dialog box appears to remind you the updates is 
available to download. 
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By clicking the About Pattern Design... item from the Help menu, you can view: 
 
• The name and version of the application installed. 
• The License Code and User’s Name as entered during the initialization of  

the application. 
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Chapter 3 
The Toolbox / Toolbars 
• • • • • • 

  
The Toolbox allows you to make and types of pattern modification. 
 
Pattern pieces can be modified using different views: Plan, Pieces,  
Clone and Grading. 

             
The Toolbars allow you to make and types of pattern modification.  
Toolbars are divided by 8 sections: Selection, Drawing, Point, Segment, 
Characteristics, Grading, Base and Frame. 
 
Pattern pieces can be modified using different views: Plan, Pieces, Clone and 
Grading. 
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Description of the Tools 

Function of each tool in the Toolbox / Toolbars 
Pointer Zoom In/Out Ruler  

                                             

Text                        Symmetry                Rotation 

                            

Orient in X               Orient in Y                    Align Two Points in X 

                                                  

Align Two Points in Y      Align Points                   Ellipse / Circle 

                                     

Ruffle Rectangle                Polygon 

                                                  

Segment                Curve                      Point 

                                             

Attach Segments         Add Point to Segment        Divide Segment 

                                                  
Intersection Points        Segment Length             Walking Piece 

                                             

Segment Angle            Copy/Paste Shape/Measure   Irregular Scale 

                                                   

Segment Sync          Join/Split Shapes              Mirror 

                                                                                              

Pleat                      Dart                           Dart Pivot 
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Dart Transfer               Shirring                        Seam Corner  

                                                   

Parallel Line               Seam Allowance 

                        

 

 

 

Function of each grading tool in the Toolbox / Toolbars 

Symmetry Grading     Rotate Grading            Manipulate Grading 

                                             

      Copy/Paste Grading        Parallel Grading           Align Grading 

                                                          

Copy/Paste Path        Smooth Path               Distribute 
Grading                 Grading                   Grading            
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Pointer  
       The Pointer tool activates or selects the desired elements and/or move them  
         within the working area. 

 
To move the selection using the keyboard arrows: 
1 Select the Pointer tool. 

2 Select the element(s) you wish to move. 

3 Use the directional arrows (Up, Down, Left, Right) to move the elements to  
  the desired location. 

                                  
 
Select the Snap to Grid item, in the Options menu, to move elements according 
to the active grid. 
 
Activate the grid by selecting the Snap to Grid item from the Options menu to 
move the symmetry reflection line according to the active grid. 
 

       Snap to Grid is OFF                    Snap to Grid is ON 
 

         

 
 

 
 
  Note: For more information about Snap to Grid, please refer to the  
  Options menu, select Preference, Display section. 
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To move the selection using the mouse: 

1 Select the Pointer tool. 

2 Select the element(s) you wish to move. 

   3 Move the selected element(s) by clicking one of its sides with the left  
  mouse button (Windows / Linux) or the mouse button (Macintosh) and  
  holding your click. 
 
 

Hold down the Shift key (Windows, Linux and Macintosh) to constrain the 
movement either in X, Y or in every 15°. (Define the angle by the setting 
“Round Angle” in the Preference menu.) 

         
 
 
 
 
 
 
 
 
 
 

To activate the Pointer tool when another tool is selected: 
 
Hold down the Ctrl key (Windows / Linux) or the Command key (Macintosh). 
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To select several segments of a piece: 
 
With the Pointer tool, hold down the Shift key (Windows, Linux and Macintosh)    
and click as many elements (points, segments...) as you want. 

 
 
 
 
 
 
 
 
 
 
 
 
To select the entire piece with just one click: 
 
With the Pointer tool, hold down the Alt key (Windows) or the Option key 
(Macintosh) or Alt +Windows keys (Linux) and click one segment of the 
piece you want to select. 
 

 
 
 
 
 
 
 
 
 
 
You can combine these functions, if you wish. 
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To adjust or move the selection using numeric values: 

1 Select the Pointer tool. 

2 Select the element(s) you wish to move. 

3 Hold down the Alt + Ctrl keys (Windows / Linux) or the Option + Command  
  keys (Macintosh). 

4 Click the Pointer tool icon in the Toolbox. 
                                                                    
 
 
 
 
 
 
 
 
 
   
A dialog box appears: 
 
  
 
 
 
 
 
 

5 Enter the X and Y values (in user predetermined measurement  
  units) to move the selected element(s) in precise horizontal (X) or  
  vertical (Y) directions. A positive value moves the selection to the  
  right/top. A negative value moves the selection to the left/down. 

6 Click the OK button to save your changes. 
 

 

 

 



 

 234  

      Or, 
 

1 Select the Distance radio button and enter the distance and angle    
  from X. 
   
 
 
 
 
 
 
 
 
 
 
2 Click the OK button to save your changes. 
 
To orient a notch: 

1 Select the tip of the notch. 

  2 Move the notch tip to the desired notch orientation.  

 
   The notch is oriented like a radius on a pivot: 
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The Pointer tool allows you to move the origin of the Grading Nest around 
the shape. The grading can be moved according to one or two selected 
points. 

 
To move the Grading Nest: 

1 Click Grade View in the View menu if you are not already in Grade view. 

2 Select the Pointer tool. 

3 Select the point or the segment associated to the grading you want to  
  move. 

4 Hold down the Alt + Ctrl keys (Windows / Linux) or the Option + Command  
  keys (Macintosh) and click the Pointer tool icon in the Toolbox. 

 
 
                      
 
 
 
 
 
 
                        
The Grading Nest moves to the new origin or orient itself according to 
the selected points. 
 
Before moving                       After moving 
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Zoom In/Out  

The Zoom In/Out tool allows you to enlarge or reduce the general working 
area view. 
 
To get a closer view of the working area: 

1 Select the Zoom In/Out tool in the toolbox. 

2 The Pointer converts to a magnifying glass. The Zoom In tool is activated  
  by default. 
3 Click the area you want to enlarge, and repeat if necessary. You can  
  enlarge the view to a maximum of 200%. 

 
To get a farther view of the working area: 

1 Select the Zoom In/Out tool in the toolbox. 

2 The pointer converts to a magnifying glass. 

3 Hold down the Alt (Windows) key or the Option (Macintosh) key or Alt +  
  Windows (Linux) keys. 

4 Click the area you want to get a farther view of, and repeat if necessary.  
  You can reduce the view to a minimum of 0.5% 

 
To get a closer view of a specific section: 
 
Use the Zoom In/Out tool to click and drag the area that you wish to see more 
closely. This displays a temporary enclosing rectangle around the selected 
area. When you release the mouse button, this enlarged area appears at the 
center of the screen. Using this method, you can set a zoom level up to a 
maximum of 2000%. 
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When another tool is selected, the pointer can be transformed into the 

Zoom In / Out tool. 
 
To activate the Zoom In tool when another tool is selected, hold down the  
Ctrl key + Space bar (Windows / Linux) or the Command key + Space bar 
(Macintosh). 
 
 
 
 
 
 
 
 
 

 
To activate the Zoom Out tool when another tool is selected, hold down the  
Alt + Ctrl + Space bar keys (Windows / Linux) or the Command + Option + 
Space bar keys(Macintosh) . 
 
 
 
 
 
 
 
 

 
 
  Or, 

        To activate the Zoom In when another tool is selected, 
  hold down Space bar key + Move up mouse wheel. 

 
  To activate the Zoom Out tool when another tool is selected, 
  hold down Space bar key + Move mouse wheel down. 
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 Ruler  
The Ruler tool allows you to get information on the distance between any 
two clicks, which can be on points or anywhere else on the working area. 
When the cursor closes to the point or the segment, a text (point, control, 
outline, center and 1/3 segment) shows next to the cursor. 
 

If you do not see the Ruler tool in the toolbox, it may be hidden beneath the 
Text tool. To activate it, hold down the left mouse button (Windows / Linux) or 
the mouse button (Macintosh) on the Text tool until the Ruler tool appears. 
Move the mouse over the Ruler tool and release the mouse button. The Text or 
the Ruler tool is the third tool in the Toolbox, at the top-right corner. 

 

To take a measurement based on two references: 

1 Select the Ruler tool. 

2 Click a first reference, Click a second reference 

 

   Or, 
 

1 Click on first point and hold down left mouse button (Windows / Linux) or  
  the mouse button (Macintosh).Then drag to second point. 

  The Point to point distance dialog box opens: 
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The information displayed includes: 
• Distance on a straight line between the two points. 
• Distance on the X axis between the two points. 
• Distance on the Y axis between the two points. 
• The Angle formed by the line created by the two points and the X axis. 
• The Opening calculation of the angle formed by the line created by the     
  two points and the X axis. 
 
The Copy button copies the selected values to the clipboard. Check a value to 
include it in the copied information, uncheck a value to exclude it from the 
copied information. You can paste these values into Notepad or another word 
processing application.  
 
You can keep the dialogs open and take measure on another piece. Two 
dialogs appear and allow you to compare the measurement. 
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Graded Selection’s Lengths 

This function allows you to get information on the Graded Selection’s Lengths 
of the selected segment(s). You can access information on many related 
segments if you select all of them. 
 
To do so: 

1 Select the segment(s). 

2 Select the Ruler tool. 

3 Hold down the Alt key (Windows) or the Option key (Macintosh)  
 or Alt +Windows keys (Linux) and click anywhere within the working  
 area. 

  

 

 

 

 

 

A dialog box appears. It displays all the Graded selection’s lengths information. 
 

 
 
 
 
 
 
 
 
 
 
 
The dialog displays the length for each size, the measurements between each 
size and the medium (Difference) and the measurements between each size 
(Step). 



 

 241  

To select and copy Grading Values: 

1 Select the sizes you wish to copy using the Graded Selection’s Lengths  
  dialog box. Click the Copy button. 

 
To make a multiple continuous selection in the list, select the first item then, 
while holding the Shift key (Windows, Macintosh and Linux), click the last one; 
this selects all items in between as well. 
 
To make a discontinuous multiple selection in the list, hold the Ctrl key (Windows 
/ Linux) or the Option key (Macintosh) and click all the sizes you wish to select; 
do the same procedure to deselect a selected item. 
 
2 These values can be pasted into Notepad or another compatible  
  word processing application. Alternately, you can paste them into  
  the Graded Segment Lengths dialog box. 
 
 
Show Special 
Select the Show Special item to show the special alphanumeric values 
established in the Grading Working Sizes dialog box. 
 
 
Note: For more information about Graded Segment Lengths, please refer to 
the section on the Segment Length tool. 
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 Text 
The Text tool allows you to write notes on the selected piece or on the working 
area. While this information remains independent, you can group it with a 
Pattern Piece. 
 
The Text tool may be hidden under the Ruler tool in the toolbox. To activate it, 
hold down the left mouse button (Windows / Linux) or the mouse button 
(Macintosh) on the Ruler tool until the Text tool appears. Move the mouse 
over the Text tool and release the mouse button. The Text or the Ruler tool is 
the third tool in the Toolbox, at the top completely at the right. 
 
To input new text: 
1 Select the Text tool. 

   2 Click the desired text location inside a pattern piece. Or Click  
  on the desired text location (Start Point)along any segments. Or  
  anywhere else on the working area (if you want the text inside a  
   shape to be grouped with it, the piece has to be activated  
  prior typing the text). 

3 When the dialog box appears, write the text in the space and select  
  the text size as well as the preferred alignment. The size affects the  
  printed version of the text and not the way it is displayed on the  
  working area. 

   4 To use the text list, click the arrow drop-down menu next to the Text List  
  label. The text elements entered in the text list are listed. Click the Edit...  
  item to open the Text List dialog box. For further information about this     
  box, see the section of this user manual about the Text List... option in the  
  Options menu. 
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To see the content of the Text, you must check the text item under the menu 
View -> Show. 

 
 
The Text Info dialog box offers the following options: 
 
Text List: It is a drop-down menu that includes text from a list defined by the 
user. For further details about this list, refer to the section of this user manual 
about the Text List... item in the Options Menu. 
 
Letter Size: It sets the text size to be plotted. You can select 10, 18, 24, 27, 30 and 
36 Point text sizes. 
 
Angle: It sets the angle of the text on the piece. 
 
Horz. Alignment: It defines the alignment of your text according to where you 
click on the working area or on the segment. You can select Left, Center, or 
Right. 
 
Vert. Alignment: It defines the alignment of your text according to where you 
click on the segment. You can select Above, Middle, or below. (This function is 
active when Align Text Along Segment is being selected.) 
 
Align Text Along Segment: It allows setting the text along any segments. 
 
Reverse Direction: It reverses the text to another direction. (This function is 
active when Align Text Along Segment is being selected.) 
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When the text area is displayed on screen, a small “T” icon is next to the text 
point. The text is permanently visible on screen at a Zoom Level of 100% or 
higher. (Text is hidden when the Text option is unchecked in the View -> Show 
menu.)  

 

To read the text: Simply click the small “T” and hold your click. 

                   
The text point can be moved around, graded and/or grouped to any shapes 
or pieces. But it does not apply on the text with Align Text Along Segment 
function. 
 

To modify Text or Text of Piece Information: 

                  

1 Select the text reference point right next to the text icon. 

 

2 Select Item Info… in the Treatment menu. The Text info dialog box  
  appears, allowing you to change the text. 

 

3 Click the OK button to validate the changes and close the dialog box. 
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  Symmetry 
The Symmetry tool allows you to flip selected element(s) or a complete 
pattern piece on an axis defined by two reference points. 

 
To apply symmetry by two clicks: 

1 Select the element(s). 

2 Select the Symmetry tool. 

3 Click a first reference point. 
4 Click a second reference point and hold down the left mouse button  
  (Windows / Linux) or the mouse button (Macintosh), it previews an image  
  of the symmetry piece. A line represents the symmetry axis appears. 
5 Move the line to the desired symmetry axis. 
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Or, 
 
To apply symmetry by one click: 

1 Select the element(s). 

2 Select the Symmetry tool. 

3 Click the first reference point and hold down the left mouse button  
 (Windows / Linux) or the mouse button (Macintosh), then drag to the  
 second reference point. It previews an image of the symmetry piece.  

       A line represents the symmetry axis appears. 

4 Move the line to the desired symmetry axis. 
 
 
When you hold and move the point, you can view the symmetry 
angle in the info bar. 
 

 
 

 

 

 
 
 
 
 
 
 



 

 247  

Hold down the Shift key (Windows, Macintosh or Linux) if you want to  

constrain the symmetry axis in either the X or Y axis, or 15°.(Define the  

angle by the setting “Round Angle” in the Preference menu.) 
 

                
 
Select the Snap to Grid item, in the Options menu, to move elements according 
to the active grid. 
 
Activate the grid by selecting the Snap to Grid item from the Options menu, 
select Preference and Display to move the symmetry reflection line according 
to the active grid. 
 
Snap to Grid is OFF                                  Snap to Grid is ON 
 

       

 
 
 
Note: For more information about Snap to Grid, please refer to the Options 
menu, select Preference and Display section. 

 
 



 

 248  

To flip a selection according to a precise axis using numeric values: 

1 Select the element(s). 

2 Select the Symmetry tool. 

   3 Hold down the Alt key (Windows), the Option key (Macintosh)  
  and the Alt + Windows Keys (Linux) and click anywhere on the  
  working area. 
                                  
                  
 
 
 
 
 
 
 
 
 
 
4 The Symmetry dialog box opens. Select the axis of symmetry 

(Horizontal or Vertical) or angle. 
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5 Click the OK button to execute the function. 
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 Rotation  
           
The Rotation tool allows you to rotate the selection freehand or to a precise 
angle X, Y or every 15° (Define the angle by the setting “Round Angle” in the 
Preference menu.) 

 
To rotate selected elements: 

1 Select the element(s) you wish to rotate. 

2 Select the Rotation tool. 

3 Click the fixed point (pivot point). 

4 Click the second reference point and hold down the left mouse  
  button (Windows/Linux) or the mouse button (Macintosh). A  
   reference dash guideline going from the first point to the second   
  point appears. Those two lines represent an angle. 
5 Pivot the guideline to the desired rotation angle. 
 
Hold down the Shift key (Windows and Macintosh) to constrain the rotation 
angle (X, Y or every 15°). 

 
 
 
 
 
 
 
 
 
 
             
 When you hold and move the reference guideline, you can view  
 the rotation angle at the fixed point (pivot point) or in the info bar. 
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Select the Snap to Grid item, in the Options menu, to move elements 
according to the active grid. 

 
Activate the grid by selecting the Snap to Grid item from the Options 
menu, select Preference and Display to move the rotation according 
to the active grid. 
 
 
Snap to Grid is OFF                 Snap to Grid is ON 
 

       

 
 
Note: For more information about Snap to Grid, please refer to the Options    
menu, select Preference and Display section. 
 
 
To rotate the selection to a precise angle using numerical values: 
1 Activate the element(s) you wish to rotate. 

2 Select the Rotation tool. 

3 Hold down the Alt key (Windows), the Option key (Macintosh),    
  the Alt + Windows keys (Linux). 
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4 Click the pivot point. The Rotate dialog box appears: 

                        
5 Enter the desired value of rotation. 

6 Click the OK button to execute the function. 
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When you enter a positive angle, the rotation occurs counter-clockwise. 

When you enter a negative angle, the rotation occurs clockwise. 
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 Orient in X 

The Orient in X tool (horizontal) allows you to orient the activated piece(s) 
starting from two reference points on the horizontal axis. 
 
The Orient in X tool may be hidden beneath the Orient in Y tool in the 
Toolbox. To activate it, hold down the left mouse button (Windows / Linux) 
or the mouse button(Macintosh) on the Orient in Y tool until the Orient in 
X tool appears. Move the mouse over the Orient in X tool and release 
the mouse button. 
 
To orient activated elements in the X axis: 
 

 1 Activate the element(s). 

 2 Select the Orient in X tool. 

 3 Click the first reference point. 

 4 Click the second reference point. 
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The activated element(s) are oriented on a horizontal line according to the 
reference points. 
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   Orient in Y 
The Orient in Y tool (vertical) allows you to orient the activated piece(s) 
starting from two reference points on the vertical axis. 
 
The Orient in Y tool may be hidden beneath the Orient in X tool in the Toolbox. 
To activate it, hold down the left mouse button (Windows / Linux) or the mouse 
button (Macintosh) on the Orient in X tool until the Orient in Y tool appears. 
Move the mouse over the Orient in Y tool and release the mouse button. 
 
To orient activated elements on the Y axis: 

      1 Activate the element(s). 

2 Select the Orient in Y tool. 

3 Click the first reference point. 

4 Click the second reference point. 

 
The selected element(s) are oriented on a vertical line according to 
the reference points. 

 

 
 



 

 258  

  Align Two Points in X 

The Align Two Points in X tool allows you to align two points or more on the 
same horizontal axis. 
 
To align two points on the X axis: 

1 Activate the piece(s) the two points you want to align are on. 

2 Select the Align Two Points in X tool. 

3 Click the fixed reference point. 

4 Click the point to be aligned. 
 
 
The second point moves according to a vertical axis for horizontal alignment 
with the fixed reference point. 
 

 
     

 
To align many points on the X axis: 

1 Activate the piece(s) on which are the points you want to align. 

2 Select the Align Two Points in X tool. 

      3 Click the fixed reference point. 
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4 Hold down the Shift key (Windows, Macintosh and Linux).  

  A plus sign appears next to the cursor. 
         

 
 
 
 
 
 
 
 
 
5 Align as many points as you want with the reference point by  
  clicking each one of them. Release the Shift key for the last  
  point to align. 
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   Align Two Points in Y 

 
The Align Two Points in Y tool allows you to align two points or more on the 
same vertical axis. 
 
To align two points on the Y axis: 
 
1 Activate the piece(s) the two points you want to align are on. 
2 Select the Align Two Points in Y tool. 
3 Click the fixed reference point. 
4 Click the point to be aligned. 
                     
The second point moves according to a horizontal axis for vertical 
alignment with the fixed reference point. 
 

 
 
 
 
 To align many points on the Y axis: 

 1 Activate the piece(s) the points you want to align are on. 

 2 Select the Align Two Points in Y tool. 

 3 Click the fixed reference point. 
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4 Hold down the Shift key (Windows, Macintosh and Linux).  

  A plus sign appears next to the cursor. 

 

 
  

 
 
 
 
 
 
 
        
5 Align as many points as you want with the reference point by  
  clicking each one of them. Release the Shift key for the last  
  point to align. 
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  Align Points   
The Align Points tool allows you to align all the points that are on the selected 
segment(s) according to two reference points. 
 
To align points by two clicks: 

1 Select the segment(s) the points you want to align are on. 

2 Select the Align Points tool. 

3 Click the first reference point. 

4 Click the second reference point. 

     Or, 
To align points by one click: 

1 Select the segment(s) the points you want to align are on. 

2 Select the Align Points tool. 

3 Click the first reference point and hold down the left mouse button     
  (Windows / Linux) or the mouse button (Macintosh). 

4 Drag to the second reference point and release the button. 
 
All points (except control points) within the selected segment(s) are aligned on 
the straight line created by the two reference points. 
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  Ellipse / Circle  

The Ellipse / Circle tool allows you to create a circle freehand or according 
to a precise radius or diameter.  
The Ellipse / Circle may be hidden under the Ruffle in the toolbox. To 
activate it, hold down the left mouse button (Windows / Linux) or the 
mouse button (Macintosh) on the Ruffle until the Ellipse / Circle appears. 
Move the mouse over the Ellipse / Circle and release the mouse button. 

 
To draw a Circle by free hand by one click: 
1 Select Ellipse / Circle 
2 Hold down Shift key and hold down the left mouse button 
3 Move the cursor to the desired radius and release the mouse button 
 Or, 
To draw a circle freehand by two clicks: 

1 Select the Ellipse / Circle tool. 

2 Click the starting point and release the left mouse button   
  (Windows/Linux) or the mouse button (Macintosh). The first click  
  point is the center of the circle. 

3 Move the cursor and click the mouse button to the desired radius. 
 
 
To draw a circle freehand by one click with Ctrl key (Windows/Linux) or 
Command key (Macintosh): 
 
1 Select Ellipse / Circle 
2 Hold down Shift key, click the starting point and hold down the left  
  mouse button (Windows/Linux) or the mouse button (Macintosh). The  
  first click point is the center of the circle. 
3 Move the cursor to the desired radius, hold down Ctrl key  
  (Windows/Linux) or Command key (Macintosh) and release the mouse  
  button. The first point changes to the corner of the rectangle bounding  
  the circle. 
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The radius measurement is indicated in the Info bar. 
 
 
 
                                                                                                                      
 

 
 

Select the Snap to Grid item, in the Options menu, to move elements 
according to the active grid 

 
 Snap to Grid is OFF                               Snap to Grid is ON 

                    

 
Note: For more information about Snap to Grid, please refer to the 
Options menu, Select Preference and Display section. 
 
 
To draw an Ellipse by free hand: 
1 Select Ellipse / Circle 
2 Move the cursor to the desired radius and release the mouse button 
 Or, 
To draw an ellipse freehand by two clicks: 

1 Select the Ellipse / Circle 
2 Click the starting point and release the left mouse button (Windows/Linux)  
  or the mouse button (Macintosh). The first click point is the center of the  
  ellipse. 

3 Move the cursor and click on the desired size of the ellipse. 

The measurements on the X and Y axis are indicated in the Info bar. 
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Select the Snap to Grid item, in the Options menu, to move elements  
according to the active grid. 

 

   Snap to Grid is OFF                 Snap to Grid is ON 

                

                        
 Note: For more information about Snap to Grid, please refer to the   
 Options menu, Select Preference and Display section. 
 
   
To draw an Ellipse freehand by one click with Ctrl key (Windows/Linux) or 
Command key (Macintosh): 

 
1 Select Ellipse / Circle 
2 Click the starting point and hold down the left mouse button  
  (Windows/Linux) or the mouse button (Macintosh). The first click point is  
  the center of the ellipse. 
3 Move the cursor to the desired radius, hold down Ctrl key(Windows/Linux)  
  or Command key (Macintosh) and release the mouse button. The first  
  point changes to the corner of the rectangle bounding the circle. 
 
 
To draw an Ellipse / Circle, using precise measurements: 
 
1 Select Ellipse / Circle 
2 Hold down the Alt key (Windows), the Option key (Macintosh) or Alt +  
  Windows Keys (Linux). 
3 The Draw Ellipse dialog box opens: 
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4 Choose the radio button for Full Axis or Half Axis 
5 Enter the desired Height, Width, Angle or Circumference measurement. 
6 Click the OK button to execute the function.  
 
Options in the Draw Ellipse dialog box: 
 
Full Axis or Half Axis: The height and width measurements represent either 
half of the full height and width or the full height and width of the ellipse. 
 
Height: It determines the height of the Ellipse/Circle. 
 
Width: It determines the width of the Ellipse/Circle. 
 
Angle: It determines the orientation of the Ellipse. 
 
Circumference: It creates a circle with a circumference equal to the 
value entered in the text field. 
 
Internal Segments: The Ellipse/Circle is drawn with internal segments 
attached to one another. They can be deleted so that the piece will not 
be a closed polygon anymore. Otherwise, the Ellipse/Circle is drawn with 
contour segments and remains a closed polygon if segments are deleted. 
 
Draw in Pieces View: The drawn Ellipse/Circle appears Pieces View. 
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 Ruffle 

The Ruffle allows you to create pieces as circle shaped piece. 
The Ruffle may be hidden under the Ellipse / Circle in the toolbox. To 
activate it, hold down the left mouse button (Windows / Linux) or the 
mouse button (Macintosh) on the Ellipse / Circle until the Ruffle appears. 
Move the mouse over the Ruffle and release the mouse button. 
 
1 Select Ruffle tool and click the desired location where you want the  
  shape to be. 
2 The Draw Ruffle dialog box opens. Enter the Length and Height  
  measurements: 
 

    
 

3 Press OK button to validate and get a piece as follows. 
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Or, make a Ruffle with a gap, enter Gap value as follows.   

 
Or, make a Four Flared Skirt as the following screen shot. 

  
Internal Segments: The Ruffle is drawn with internal segments attached to 
one another. They can be deleted so that the piece will not be a closed 
polygon anymore. Otherwise, the Ruffle is drawn with contour segments 
and remains a closed polygon if segments are deleted. 
 
Draw in Pieces View: The drawn Ruffle appears in Pieces View and is 
missing from the Plan View.  
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 Rectangle 

The Rectangle tool allows you to create a square or a rectangle freehand 

or according to precise measurements. 
 
To draw a rectangle freehand by one click: 

1 Select the Rectangle tool. 

   2 Click at the starting point and hold down the left mouse button  
  (Windows/Linux) or the mouse button (Macintosh).The first point  

     is the center of the rectangle. 

3 Drag the cursor diagonally to the desired dimension. 
 
 
To draw a rectangle freehand by two clicks: 

1 Select the Rectangle tool. 

   2 Click at the starting point and release the left mouse button  
 (Windows/Linux) or the mouse button (Macintosh). 

3 Move the cursor diagonally to the desired dimension and click    
  the left mouse button again. 
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      To draw a square freehand by one click: 

1 Select the Rectangle tool. 

2 Hold down the Shift key (Windows, Macintosh and Linux). 

            
3 Click the starting point and hold your click.  
4 Move the cursor diagonally until you reach the desired dimension.    
  The widest side of the clicked and dragged area is the measurement  
  taken for the square sides. 
  
To draw a square freehand by two clicks: 

1 Select the Rectangle tool. 

2 Hold down the Shift key (Windows, Macintosh and Linux). 

                        

3 Click at the starting point and release the left mouse button  
  (Windows/Linux) or the mouse button (Macintosh). 
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4 Move the cursor diagonally to the desired dimension and click    
  the left mouse button again. 
           

The square or rectangle measurements are indicated in the Info bar when  
you are creating it, before you release the button of the mouse. 

         
Select the Snap to Grid item, in the Options menu, to move elements according 
to the active grid. 
   
Activate the grid by selecting the Snap to Grid item from the Options menu                
to move the symmetry reflection line according to the active grid. 
 
Snap to Grid is OFF                   Snap to Grid is ON 

                 

 

Note: For more information about Snap to Grid, please refer to the Options menu,  
Select Preference and Display section. 

 
 

To draw a rectangle using precise measurements: 
1 Select the Rectangle tool. 
2 Hold down the Alt key (Windows), the Option key (Macintosh) or 
  Alt + Windows Keys (Linux). 
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3 Click the desired location where you want the shape to be. 

4 The Draw Rectangle dialog box opens. Enter the width and     

  height measurements: 

                
 
5 Click the OK button to execute the function. 
 
The Draw Rectangle dialog box offers the following options:  
 
Width: It is the width of the rectangle. 
 
Height: It is the height of the rectangle. 
 
Internal Segments: The Square is drawn with internal segments 
attached to one another. They can be deleted so that the piece will 
not be a closed polygon anymore. Otherwise, the square is drawn 
with contour segments and remains a closed polygon if segments are 
deleted. 
 
Draw in Pieces View: The drawn rectangle appears in Pieces View and 
is missing from the Plan View. 
 
To draw a rectangle with precise measurements using on the Alt 
key(Windows), Option key (Macintosh) or Alt + Windows Keys (Linux).  
You are able to combine with Ctrl key (Windows/Linux) or Command 
key(Macintosh) function. 
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   Polygon 

The Polygon tool allows you to create a polygon freehand. 
 
 
 
 
 
 
               
 
 
 
 
 
 

 
To draw a polygon: 

1 Select the Polygon tool. 

2 Click the starting point. 

3 Move to the desired location and click a mouse button. When   
  dragging the line, you can see the distance in X, Y and point to  
  point for each segment you create at each click in the Info Bar. 

                    
   
 
4 Repeat the last step as many times as necessary to get the polygon that  
  you want. 
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 To restrain movement according to the X or Y axis and/or 15° angle     
 (Define the angle by the setting “Round Angle” in the Preference  
 menu.), hold down the Shift key (Windows, Macintosh and Linux). 

               

 

The polygon shape closes itself once at least three points have been set. 
 
Select the Snap to Grid item, in the Options menu, to move elements  
according to the active grid. 
 
Activate the grid by selecting the Snap to Grid item from the Options 
menu to move the symmetry reflection line according to the active 
grid. 
   
 Snap to Grid is OFF Snap to Grid is ON 
 

    

 
 

 Note: For more information about Snap to Grid, please refer to the 
 Options menu, Select Preference and Display section. 
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  Segment 
The Segment tool allows you to draw a segment. It can start and/or end  
on an existing point or be drawn anywhere on the working area. 
 
To draw a segment freehand by one click: 

1 Select the Segment tool. 

2 Click the starting point and hold down the left mouse button  
  (Windows / Linux) or the mouse button (Macintosh). 
3 Drag the cursor to the desired location. 
 

        Or, 
 

To draw a segment freehand by two clicks: 

1 Select the Segment tool. 

2 Click the starting point and release the left mouse button  
  (Windows / Linux) or the mouse button (Macintosh). 
3 Move the cursor to the desired location and click the left mouse 
  button (Windows / Linux) or the mouse button(Macintosh)again. 

 
Note: For the segment to be attached/grouped to an existing piece, 
the piece must be activated prior drawing the segment. 
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To restrain movement on an X or Y-axis, or on an angle of +/- 15° (Define 
the angle by the setting “Round Angle” in the Preference menu.), as well 
as to get a straight line, hold down the Shift key (Windows, Macintosh 
and Linux). 

              
The X and Y coordinates and the distance of the segment are indicated 
in the Info bar while dragging the cursor.          
 

 
Select the Snap to Grid item, in the Options menu, to move elements 
according to the active grid. 
 
Activate the grid by selecting the Snap to Grid item from the Options 
menu to move the symmetry reflection line according to the active 
grid. 
 
 Snap to Grid is OFF Snap to Grid is ON 
     

           

 
Note: For more information about Snap to Grid, please refer to the  
Options menu, Select Preference and Display section. 

 
 



 

 277 

To draw a Segment with precise measurements: 

1 Select the Segment tool. 

2 Hold down the Alt key (Windows), the Option key (Macintosh) or  

  the Alt + Windows keys (Linux). 

             
 
3 Click the point where you want your segment to start. If the segment  
  has to be grouped or attached to a piece, the piece must be  
  activated prior drawing the segment. 
 
  The Draw Segment dialog box appears: 

                  

 
4 Enter the desired Length, Angle from X, Opening Value, or X and Y        
  distances of the segment. 

5 Click the OK button to execute the function. 
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The Draw Segment dialog box offers the following options:  
 

Length: To indicate the length of the segment to be drawn. 

 
Angle from X: To create an angle on the X axis. 

                     
 
Opening Value: When you enter a positive value, the rotation occur 
counter- clockwise. When you enter a negative value, the rotation 
occurs clockwise. 
 

             
 
 

If you prefer to draw a segment according to the X-axis and/or 
Y-axis, use the following measurements: 
 
Distance X: To indicate the length of the segment on the X-axis. 
 
Distance Y: To indicate the length of the segment on the Y-axis. 
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   Curve 
 
To curve a segment: 

1 Activate the piece of the segment you want to curve is on. 

2 Select the Curve tool. 

3 Click the segment that you want to curve and hold down the  
  left mouse button (Windows /Linux) or the mouse button (Macintosh). 

4 Drag the cursor to get the desired curve. 
 
 
To obtain information about a selected curve, select Item Info... in the 
Treatment menu. 
  

            
 
 
 
 
 
 
 

 
 
 

To manipulate the shape of a curve, select and move its control point. 
 

To get rid of a curve, select and delete the control point (Backspace   
key for Windows / Linux, Delete key for Macintosh).  
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To Draw a Curve Line by Freehand 
To select Curve tool and click on the define positions.  It allows drawing a 
curve line by three clicks only. 

 
 

To Move a Group of Control / Regular Points by Freehand 
1 To activate the segments you would like to modify curve on. 
2 To select the Curve tool 
3 Click one of the Control / Regular point on the selection 
4 Hold down the left mouse button and drag to the desired position,  
  the result will preview as stitch line on screen.  
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To Move a Group of Control / Regular Points with Numeric Values 
1 To activate the segments you would like to modify curve on. 
2 To select the Curve tool 
3 Click one of the Control / Regular point on the selection 
4 Hold down the Alt key (Windows), the Option key (Macintosh) or Alt +  
  Windows Keys (Linux). 
5 Move the cursor, click on the desired location where you want the  
  shape to be. A dialog box appears: 

         

6 Enter the X and Y values (in user predetermined measurement units) to  
  move the selected point in precise horizontal (X) or vertical (Y) directions.  
  A positive value moves the selection to the right/top. A negative value  
  moves the selection to the left/down. 
7 Click OK button to validate. 
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   Point 
       The Point tool allows you to add a point on a shape or within the working   
       area where the click is made. Points can be added freehand or by using 

       X and Y coordinate. 
 
 The Point may be hidden under the Attach Segments in the Toolbox.  
 To activate it, hold down the left mouse button (Windows / Linux) or                              
 the mouse button (Macintosh) on the Attach Segments until the Point  
 appears. Move the mouse over the Point and release the mouse button. 

  
           To add a point: 

 1 Select the Point tool. 

 2 Click the desired location. 

    
 
 Note: To add a point to a segment, activate the piece of the  
 segment is on. The point is grouped with the segment it has been 
 added to. 
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To add a point, using precise distances: 

      1 Select the Point tool. 

2 Hold down the Alt key (Windows), the Option key (Macintosh) or the  
  Alt + Windows keys (Linux). 

 

         
                  
3 Click a reference point, which represents the origin of the plan  
  (point with the coordinates 0, 0), to open the Point dialog box: 
 

                     
 

4 Enter the X and Y coordinates. 
 
 
  Distance X: Enter the length where the point is desired according to the X  
  axis from the origin click. 
 
  Distance Y: Enter the length where the point is desired according to the Y  
  axis from the origin click. 
 
  Distance: Enter the length where the point is desired according to the  
  specified distance from the origin click. 
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Angle from X: Enter the angle where the point is desired according to an 
angle based on an X axis based on the reference point (the origin). 
 

                         
                          

 
 

5 Click the OK button to execute the function. 
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   Attach Segments 

The Attach Segments tool allows you to add a point on an intersection 
between two lines or to merge two points one on top of the other. To attach 
segments, the elements you intend to merge must be part of the same 
group. To know how to make a group, see the part of this documentation 
about the Group item in the Treatment menu. 
 
The Attach Segments may be hidden under Point in the toolbox. To activate 
it, hold down the left mouse button (Windows / Linux) or the mouse button 
(Macintosh) on the Point until the Attach Segments appears. Move the 
mouse over the Attach Segments and release the mouse button. 
 
To attach two segments: 

   1 You must have 2 segments intersecting and they must be part of 
  the same group (if not, select the elements to be grouped and go  

     the Treatment -> Group item). 
2 Select the Attach Segments tool. 

3 Click the intersection. 
 

This process adds a point to the intersection, linking both segments together. 
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  Add Point to Segment 
 

To add a point to a segment: 

      1 Select the segment(s). 

      2 Select the Add Point to Segment tool. 

3 Click the starting point, which must be one of the extremities of  

  the segment(s).  

  The Add Point to Segment dialog box appears: 

           
 
4 Enter the distance and click the OK button to execute the function. 

                    

 
If the measurement exceeds the segment length, the point is added to 
the continuation of the selection. 
 
Enter a negative value to extrapolate a point when extending a selection 
outside of the shape from the starting point. 
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To add a Graded Point to a segment or to access its grading information: 

1 Select the segment(s) 

2 Select the Add Point to Segment tool. 

3 Hold down the Alt key (Windows), the Option key (Macintosh) and the  

  Alt + Windows keys (Linux). 

  

              
                  
4 Click the starting point.  
 
  A dialog box appears: 
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5 Select each size separately, if you need a different length for                  
  each size or select them all at once if they need the same  
  value. Enter the value of the desired distance in the text box. 
 
 
  Use the Paste button to paste the copied distance or copied     
  differences from the medium or copied step between each size.   
  The values must be copied from the Graded Selection’s Lengths  
  dialog box (Ruler tool with the Alt key for Windows, the Option key  
  for Macintosh and the Alt + Windows keys for Linux). 
 
  The Show Special check box allows you to hide the break name   
  and display special characters established in the Grading Working 
  Sizes dialog box. 
 
6 Click the OK button to execute the function. 
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   Divide Segment  
The Divide Segment tool allows you to divide a segment equally by 
adding as many points as necessary, all at an equal distance from each 
other, dividing the segment in as many divisions as you need, up to 1000. 

 

To divide a segment: 

1 Select the segment. 

2 Select the Divide Segment tool. 

3 Click the segment. 
 
 
The Division Segment dialog box opens: 
 

                                                             
                     

4 Enter the desired quantity of division. 

5 Click the OK button to execute the function. 
 

 
 
If several segments are selected, they are considered as one segment. 

 
 
 
 
 



 

 290 

   Intersection Points 
 

The Intersection Points tool allows you to add points on selected segments 
that are aligned from a projection guideline. 
 
To add points: 

1 Select the segment(s) where points are required. 

2 Select the Intersection Points tool. 

3 Click the desired location of the first reference point. 

4 Click the desired location of the second reference point and hold down  
  the left mouse button (Windows / Linux) or the mouse button (Macintosh). 
5 A guideline appears; drag it to the desired location. 

6 Release the mouse button. Points appear on all the selected segments  
  intersecting the guideline. 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: The Add Points tool does not function if two shapes are active 
at the same time. 
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You can restrain the projection guideline in X and Y by holding down 
the Shift key (Windows, Macintosh and Linux). 

                   

To add points on selected segment(s) with precise measurement from 
a reference point horizontally or vertically: 
1 Select the segment(s) where points are desired. 
2 Select the Add Points tool. 
3 Hold down the Alt key (Windows) or the Option key (Macintosh) or  
  Alt +Windows keys (Linux). 

                    
4 Click the desired location of the reference point to open the Add points 
  dialog box: 
 
 
 
 
 
   
5 Enter at which distance from the reference point you want to add a    
  point and select the radio button for the required axis (horizontal or  
  vertical). 
6 Click the OK button to execute the function. 
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 Segment Length 
The Segment Length tool allows you to obtain or modify information 
about the length of the selected segment(s). 

 
To obtain or modify information on the length of a segment: 

1 Select the desired segment(s). 

2 Select the Segment Length tool. 

   3 Click the fixed point where the measurement starts. The point must be  
  at the extremity of a segment. 
 
  The Segment Length dialog box opens: 
 

         
 
4 Change the measurements of the segment(s) if you want, and check 
  the required option check box(es). 
 
 
You can determine if the added measurement is allotted to the entire 
segment in a proportional way or added to its end. 
 
If no options are selected, the added measurement is added 
proportionally to the entire segment. 
 
You can modify the segment length by a different means: 
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New Length: It allows you to enter a new length value. 
 
Measure to Add: It adds the value entered to the actual length; a negative 
value subtracts the value from the actual length. 
 
% of Actual Length: The actual length represents 100%; enter the % value of  
the segment desired. 
 
Distances to Add on Axis 
Distance in X: It recalculates the shape after applying the distance move to 
the end point of the segment in X. 
 
Distance in Y: It recalculates the shape after applying the distance move to the 
end point of the segment in Y. 
 

Do Not Move Extreme Points: It keeps the two extreme points in their positions 
while changing the length of the segment. 
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Move the End Point Only: The measurement to be added or subtracted is 
done at the end of the segment, without taking into account the point(s) 
located on the selected segment. 

    
           
 
 
 
 
 
 

 
 
 

 
 
 
 
 
 



 

 295 

Move on X Only: To change the length of the segment while following  

the X axis. 
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Move on Y Only: To change the length of the segment while following 
the Y axis. 
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Graded Segment Lengths 

This function allows you to get grading information on a segment. 

 
To use the Graded Segment Lengths function: 

1 Select the segment(s). 

2 Select the Segment Length tool. 

3 Hold down the Alt key (Windows) or the Option key (Macintosh) or  
  Alt +Windows keys (Linux). 

 

               
 
4 Click the fixed point where the measurement starts. The point  
  must be at the extremity of a segment. The Graded Segment  
  Lengths dialog box appears. It displays the length for each size,  
  the difference in measurements from the medium, and the step  
  between each size. You can select and modify any size. 
5 Select the size(s) to be modified. 

6 You can select a size and select the Modify button to make any  
  modifications to it; this can be done successively for all sizes. Or  

  you can make a multiple selection of sizes in the list and paste  

  either the length, difference or steps of the corresponding sizes  

  previously copied in the Graded Selection Length dialog box.  

  (See the Ruler tool for more info) 
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The Graded Segment Lengths dialog box offers the following options: 
 

          
 

 
Modify: It modifies the selected size in the Graded Segment Lengths dialog box. 
 
Paste: It pastes the copied value(s) from the Graded Selection’s Lengths 
dialog box. 
 
Show Special: It hides the break name and displays special characters 
established in the Grading Working Sizes dialog box. 
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   Walking Piece 

Walking Piece allows you to view the walking process of two pattern 
pieces, and then modify the precise value through the measurement box. 
 
To do so: 
1 Select the segments from two pieces (Pattern A and Pattern B) 
2 Select Walking Piece tool 
3 The first click on one of the segment is the start point of the fixed piece.  
  The second click is the start point of the moving piece. 

 
 
 
 
 
 
 
 
 
 
 
 
 

4 Walking Piece dialog box appears to show the measurement for  
  Pattern A and Pattern B. 
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Change the measurements of the segment(s) if you need, and check  
the required option check box(es). 
 
● Press Space Bar key to skip the walking process 
 
Show Special: It hides the break name and displays special characters 
established in the Grading Working Sizes dialog box. 
 
Do Not Move Extreme Points: It keeps the two extreme points in their 
positions when changing the length of the segment. 
 
Move the End Point Only: The measurement to be added or subtracted is 
done at the end of the segment, without taking into account the point(s) 
located on the selected segment. 
 
Move on X Only: To change the length of the segment while following the 
X axis. 
 
Move on Y Only: To change the length of the segment while following the 
Y axis. 
 
Put the Piece Back to Its Original Position: The piece will put back to the 
original position after the measurements adjustment. 
 

 

Click the OK button to execute the function. 
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Apply Walking Piece function to Grading Nest   

  
To do so: 
1 Select the graded segments from two pieces (Pattern A and Pattern B) 
2 Select Walking Piece tool 
3 Holding down Alt key (Windows), Option key (Macintosh) or Alt     
  +Windows keys (Linux).  

The first click on one of the graded segment is the start point on fixed         
piece. The second click is the start point of the moving piece. 
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4 Walking Piece dialog box appears to show the graded measurement         
  for Pattern A and Pattern B. 

 

 
 
 
 
 
 
 
 
 
 
 
 

Change the measurement of the segment(s) if you need, and check the 
required option check box(es).  
 
Click the OK button to execute the function. 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 303 

  Segment Angle  
 The Segment Angle tool allows you to read the angle of a segment and      
 change it to a precise angle, if necessary.  
 The angle is calculated as follows: 

 
 
 
 
 
 
 
 
 
 
           To obtain or modify information for a Segment Angle: 

       1 Select a segment or segment path. 

       2 Select the Segment Angle tool. 

       3 Click one end point of the segment, which should be the starting point 

        of the angle you wish to modify. A dialog box displaying the actual   

        angle of the segment based on the X axis appears: 
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4 Enter the desired angle or a rotation value. The angle can change  
  positively or negatively and relies entirely on the X axis. The angle is  
  calculated from one end of the segment to the other end in a straight  
  line. When modified, the selection pivots from the first click to adjust the  
  end point to the new location corresponding to the new angle entered.  
  Modifications to the angle can be entered in degrees in the New Angle  
  text field or in CM or inch (according to your Options -> Preference   
  ->Display) by using the Opening Value text field. 

 
 
 
 
 
 
 
 
       5 Click the OK button to execute the function. 
 
         Example with the New Angle option: 
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Example with the Opening Value option: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
         Using the tool to slash and spread: 

1 Select the portion of the shape to be rotated. 

2 Select the Segment Angle tool. 

3 Hold down the Alt key (Windows), the Option key (Macintosh) or      
  Alt +Windows keys (Linux). 
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        4 Click the point to be slashed and spread (opening side) and the 

          Slash and Spread dialog box appears. 

        5 Enter the opening measure. 

        6 Click the OK button to execute the function. 
 
  

       Example using the Tool to Slash and Spread: 
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   Copy/Paste Shape/Measure 
The Copy/Paste Shape/Measure tool allows you to copy the shape and/or 
measure of a segment and paste it over another segment. 
 
The Copy/Paste Shape/Measure tool may be hidden under the Irregular Scale 
tool in the Toolbox. To activate the Copy/Paste Shape/Measure tool, hold 
down the left mouse button (Windows / Linux) or the mouse button (Macintosh) 
on the Irregular Scale tool until the Copy/Paste Shape/Measure tool appears. 
Move the mouse over the Copy/Paste Shape/Measure tool and release the 
mouse button. 

 
To Copy/Paste Shape/Measure: 

1 Select the segment you wish to copy. 

   2 Select the segment to be altered (over which the first segment shape    

     and/or measure will be pasted) using the Shift key (Windows, Macintosh  

     and Linux). 

 

 

 

 

 

 

 

 

 
   Important: The two segments cannot be from the same shape! 
 
 3 Select the Copy/Paste Shape/Measure tool. 
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4 Click the starting point of the segment to be copied. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5 The Copy/Paste Shape /Measure dialog box opens. Select the  
  required options: 
 
 Paste Shape: It pastes the segment shape (the copied shape stretches  
 or shrinks to fit). 
 
 Paste Measure: It pastes the segment measurements. 
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 Do Not Move Extreme Points: It pastes the segment measure without     

 moving the extreme points, if possible. 
 
 Report Intermediate Points: It reports all intermediate points (Marks,   
 Notches, etc.) on the second segment and transform them into  
 Mark Points (This is not available with the Paste Shape option). 
 
 6 Click the OK button in the dialog box. 

 7 Click the starting point of the shape to be pasted upon. 
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 Pasting a Shape Multiple Times 
  To paste a segment shape multiple times: 

1 Select the segment you wish to copy. 

2 Select the segment(s) to be altered (overwritten by Pasted segments). 

3 Select the Copy/Paste Shape/Measure tool. 

4 Click the starting point of the segment to be copied. 

   5 Select the desired options in the Copy/Paste Shape/Measure dialog box,  
  as seen above and click the OK button. 
6 Hold down the Shift key (Windows, Macintosh and Linux) and click the  
  starting point of the shape to be pasted upon. 

   7 Continue holding down the Shift key to paste the shape/measure on as  

     many segments as you require, by clicking their respective starting    
  point. Release Shift when you paste the shape for the last time. 

 

 

 

 

 

 

 

 
 

Note: If you wish to paste the shape on the same piece as it is copied, you need 
to select the segment to copy and click the starting point to copy with the tool. 
The dialog box appears. Select the appropriate options and click the OK button. 
To paste the shape, you have to select the segment where to paste it using the 
Ctrl key (Windows / Linux) or Command key (Macintosh). This activates 
temporarily the pointer tool, allowing you to make your selection without losing 
the copied information. Once the selection is done, click the starting point of the 
selection where you wish to paste the shape. You can use Shift to paste the  
shape multiple times using this technique, too. 
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   Irregular Scale 

The Irregular Scale tool allows you to reshape a piece on selected points,   
using X and Y measurements. 
 
The Irregular Scale tool may be hidden under Copy/Paste Shape/Measure 
tool in the Toolbox. To activate the Irregular Scale tool, hold down the left 
mouse button (Windows / Linux) or the mouse button (Macintosh) on the 
Copy/Paste Shape/Measure tool until the Irregular Scale tool appears. Move 
the mouse over the Irregular Scale tool and release the button. 
 
To scale a segment in an irregular way: 

   1 Select a segment with at least three contour points to be moved 
     according to measurements in X and Y. 

2 Select the Irregular Scale tool. 
3 Click the first selected point of the path. 
4 Click the last selected point of the path.  
 
   The Irregular scale dialog box appears: 
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Each point in the list corresponds to a selected regular or mark point on the 
shape. 

 

 

 

 

 

 

 
5 Select the points and enter the appropriate moving value where    
  required. 

   6 Select Show X and Y Distances to enter the X and Y distances or select       

     Show distance and angle to enter distances and angles. 
   7 Select Permanent to move the selected points or select Simulation to 

  keep the original segment and add a new one with the modifications. 
 
 

Permanent example: 
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Simulation example: 
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  Segment Sync 

Segment Sync is to copy the selected segments as image and join with 
another segment. Then it allows modifying the shape on the IMAGE and 
able to put modification to the original pieces.    
 

      Several Pieces Combine Together 
To do so: 
1 Select the segments need to join together as the follows: 

 
 
2 Choose Segment Sync tool 

 
3 Click on each piece of the joined point, and the first click on the piece  
  that is the fixed piece. 
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4 Then all of selected segments will join as following screen. 
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5 Move the cursor to the desired position and adjust the shapes what you  
  need. 

             
 
 

 6 After modified, please right click on mouse to validate. You can see the  
  difference if the pieces added with Template. 
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Close a Dart and Change the Shape 
Closing a Dart temporary and let you to adjust the shape of this piece 
To do so: 
1 Select the segment with a Dart located  

          

 

2 Choose Segment Sync tool and click on the fixed point 
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3 The Dart is closed and may change the shape as follows. 

        

 
4 After modified, please right click on mouse to validate. You can see the  
  difference if the pieces added with Template. 
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Close a Pleat and Change the Shape  
Closing a Pleat temporary and let you to adjust the shape of this piece. 
To do so: 
1 Select the segment with a Pleat located  

          
 

2 Choose Segment Sync tool and click on the fixed point 
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3 The Pleat is closed and may change the shape as follows. 

   
 

4 After modified, please right click on mouse to validate. You can see the     
  difference if the pieces added with Template. 
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 Join/Split Shapes  

The Join/Split Shapes tool allows you to join two different shapes. You can 
attach and adjust a secondary shape to a primary shape. And it allows you to 
split one piece into two split pieces (with the internal points and lines) from a 
created style line. 

 
How to JOIN Shapes: 
1 Select two segments need to join together 
2 Select Join/Split Shapes 
3 Click the fixed point of the first segment or segment path (this shape  
  remains in position). 
4 Click the corresponding fixed point of the second segment or segment  
  path (this shape moves to fuse to the first one) 

   

   The secondary shape gets adjusted to the primary shape. 
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  To save the style line as an internal line, use the Shift key (Windows,  
  Macintosh and Linux) while doing the steps 3 and 4.  
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How to SPLIT a Shape: 
1 Select the style line and all the segments that are on one side of the  
  shape need to be split. (It does not matter which side you choose). 
2 Select Join/Split Shapes 
3 Click on the style line.  

   
 
4 The piece splits to two pieces. 
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  Mirror 
The Mirror tool allows you to mirror a shape or create a reflection of the 
shape and its internal information at a defined width. 
 
To mirror the piece: 

1 Select the axis of reflexion of the piece you wish to reflect. 

2 Select the Mirror tool. 

3 Click the selected segment. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
    Note: If your application supports the intelligent mirror (Pattern Professional or  
     Pattern Enterprise ), make sure that the resulting piece is a polygon, otherwise the  
    mirror tool does not work. Refer to the Clone chapter for additional information  
    on how to use the intelligent mirror. 
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To mirror a piece and cut the reflection at a defined width: 
 
This feature is very useful to create cross-over or facing. It creates  
a mirror image on the reflection line but cut it at a specific value. 
 
1 Select the axis of reflection of the piece you wish to reflect. 

2 Select the Mirror tool. 

3 Hold down the Alt key (Windows) or the Option key (Macintosh) or  

  Alt + Windows keys (Linux). 
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4 The Mirror dialog box opens. Enter the value the reflection must be     
  cut at. You can request the reflection to keep the same width for 
  all sizes by checking the option box. Otherwise, the grading at the cut    
  remains the same as the original side. 
5 Click the OK button to execute the function. 

 

Cut Reflexion examples: 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

Note: If you use Pattern Professional or Pattern Enterprise with Clone 
option, please refer to Intelligent Mirror in the Clone chapter in this 
manual. 
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   Pleat 
 The Pleat tool allows you to develop a pleat on a shape using existing  
 points. 
 
 
To develop a pleat: 

1 Activate the shape. 

2 Select the Pleat tool. 

3 Click the first reference point (A). 

4 Click the second reference point (B). 

5 Click the fixed part of the pattern piece.    
  
 
 
 
 
 
 
 
 

 The Pleat Characteristics dialog box opens: 
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6 Enter the desired values. 

7 Click the OK button to execute the function. 
 
 
To select a Pleat: On the working area, click the central segment of 
the pleat to select all attached points 
 
To modify a Pleat: Select the pleat and select Item Info from the  
Treatment menu and the Pleat Characteristics dialog box opens. 
 

To remove a Pleat: Select the pleat and press Backspace (Windows / Linux) or 
Delete (Macintosh). 

 

 

 

 

 

 

 
 

 
Piece with completed pleat: 
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You can add notches and punch holes to each side of the pleat (side A and   
side B). Click the small circles representing the location of notches and the 
punch holes in the pleat. 
 

Options in the Pleat Characteristics dialog box: 
 
Width: To enter the width of the pleat. For a radial pleat, enter 
measurements in both A and B. 
 
Punch Hole Distance: It assigns the location of the punches from the 
edge of a the piece. You can assign different values in A and B. 
 
Pleat Type: To choose the pleat type to develop; Pleat, Box Pleat and 
Inverted Pleat. 

 
Closing Side Clockwise: It closes the pleat clockwise if checked or 
counter- clockwise if not checked. 
 
Punch Hole Distance from Side: It sets a distance from the Punch Hole 
starting from the side of the pleat going inward. 
 
Cut Jug at: It assigns a specific measurement at which to cut the 
extremity of the head of the pleat. 
 
Remove Characteristics: It erases the characteristics of a pleat and 
keeps its contour and references (punch holes and notches). 
 
Save as Default: It keeps the current settings of a pleat and reapplies 
these settings to all future pleats. 
 
The Pleat tool allows you to restore a pleat after the digitization process. 
 
 
To add pleat characteristics: 

1 Draw a segment to define the center of the pleat. 

2 Select the segment and the surrounding points that form the pleat. 

3 Select the Pleat tool. 
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      4 Hold down the Alt key (Windows), the Option key (Macintosh) or  

        Alt +Windows keys (Linux).  
 

 

 

 

 

   

 
 
 

5 Click the central segment of the pleat position that you added at step  
  1.The Pleat Characteristics dialog box appears with the width already  
  filled in. You can add any other necessary information in the dialog box. 
6 Click the OK button to execute the function. 
 
Example of adding a pleat characteristic: 
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To Develop Multiple Pleats 
The Pleat tool allows you to develop multiple pleats in one step. 
 
To develop multiple pleats: 
1 Activate existing points on the shape 
2 Select the Pleat tool 
3 Click the first reference point (A) 
4 Click the second reference point (B) 

  
 

5 Click the fixed part of the pattern piece 

  The Pleat Characteristics dialog box opens: 
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6 Enter the desired values. Click the OK button to execute the function.    

  Each pleat has a symbol for folding direction. 

 
 

 

New Pleat Characteristics  
There are 2 items in Pleat Type for you to choose: 
Box Pleat  
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Inverted Pleat 

 
 

 

Support 0 Value on Pleat A 
It supports the value in 0 of the Width for Side A (Pleat A). 
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  Dart 

The Dart tool allows you to create a dart within a shape from its contour. 
The Dart is opened and the shape rotated on a pivot point located on 
the contour. 
 
 
To develop a dart: 

1 Draw a segment attached to the contour of the piece where  
  you want to set your dart. 

2 Select the pivot point (#1) and the segment (#2). 

3 Select the Dart tool. 

4 Click the pivot point (#1). 

5 Click the segment (#2) indicating the position of the dart. 

6 Click the part of the piece (#3) that remains fixed. 

7 The Dart Characteristics dialog box opens. Enter the dart  
  parameters in the dialog box (detailed on next page). 

8 Click the OK button to execute the function. 

      Example: 
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You can add punch holes and notches to each section of the dart.  
Click the little circles, representing punch hole and notch locations 
in the dart. 

 
To Select a Dart: Select the dart by clicking its center segment. 
This selects the whole dart. 
 
To Modify a Dart: Select the dart and select Item Info... in the Treatment 
menu to reopen the Dart Characteristics dialog box. 
 
To Delete a Dart: Select the dart and press Backspace (Windows / Linux)  
or Delete (Macintosh). This removes the attributes of the dart and keeps  
the opening of the dart. 
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The Dart Characteristics dialog box offers the following options:  
 
Cut Jug at: It assigns a specific length to the dart head. 
 
Closing Side Clockwise: If checked, this option folds the dart clockwise. If 
unchecked, this option folds the dart counter-clockwise. 
 
Finished Length: It calculates the position of the punch hole from the dart 
head to create an open-end dart. 
 
Pleat Length: It applies the dart width value at a distance calculated from 
the dart head. This results in a dart pleat. 
 
Punch Hole Distance: It is the distance of the punch hole from the dart pivot 
point. 
 
Punch Hole Distance From Side: It customizes the distance of the 
punch hole from the sides of the dart. 

 
Save as Default: It keeps the settings of the dart (finished length, punch hole, 
etc.) and reapply these settings to all future darts. 
 
Remove Characteristics: This option is only available when you edit a dart 
already created. Check it to remove the characteristics you set to your piece. 
 
To Select a Dart: Select the dart by clicking its center segment. This selects the 
full dart. 

 
Without Dart Characteristics: 
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With Dart Characteristics: 

 
 

Deleted Dart: 

 
 

The Dart tool allows you to add an Internal Dart to a segment. 
 
 
To develop an internal dart: 

1 Activate the piece that you want to add a dart in. 

2 Draw a segment of the desired internal dart length inside the activated  
  piece. 

3 Select the Dart tool. 

4 Click one extremity of the segment. 

   5 The Internal Dart Characteristics dialog box opens. Enter the  
  internal dart parameters in the dialog box. 
6 Click the OK button to execute the function. 
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Example of an Internal Dart: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can add punch holes and notches to each section of the internal dart 
(Dart A and Dart B). Click the little circles, representing punch hole and notch 
locations, located on the shape of the dart in the center of the Internal Dart 
Characteristics dialog box. 
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The Internal Dart Characteristics dialog box offers the following options:  
Width: Width of the internal dart. 
Closing Side Clockwise: If checked, this option folds the internal dart 
clockwise. If unchecked, this option will fold the internal dart 
counter-clockwise. 
Length: Length of the internal dart. 
Finished Length: It calculates the position of the punch hole from the top of 
the internal dart to create an open dart on one or both sides. 

 
 
 
 
 
 
 
 

 
Pleat Length: To apply the internal dart width value to a distance calculated 
from the center of the dart. This results in a pleated dart. It can be done on 
one or both sides. 

 
 
 
 
 

 

 

 

Punch Hole Distance: To provide the distance of the punch hole from the 
internal dart pivot point. 
Punch Hole Distance from Side: To customize the distance of the punch hole 
from the sides of the internal dart. 
Save as Default: To keep the current settings of the internal dart (finished 
length, punch hole distance, etc.) as default and reapply these settings to  
all future internal darts. 
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Adding a dart into an opening 
 
The Dart tool can assign dart characteristics into an opening after 
digitizing or in pattern development. 

 
To Add Dart Characteristics: 

1 Activate the shape where you want to add the dart into an opening. 

2 Select the Dart tool. 

   3 Hold down the Alt (Windows), the Option (Macintosh) key or  

     Alt +Windows keys (Linux) and click the dart pivot point. 

 

 

 

 

 

 

 

 

 

 
4 The Dart Characteristics dialog box opens. The width and length  
  of the dart corresponds to the size of the opening. Modify the  
  values and characteristics as needed. 

5 Click the OK button to execute the function. 
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Example of adding a dart into an opening: 
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Create Multiple Darts & Define Dart Orientation 
The Dart tool allows you to create multiple Darts within a shape from its 
contour.  
 
To create multiple darts: 
1 Draw segments attached to the contour where the darts are located.  

 
2 Select the Dart tool 
3 Click the pivot point (#1) 
4 Click one of the segments (#2) indicating the position of the dart 
5 Click the part of the piece (#3) that remains fixed 

      
 

6 The Dart Characteristics dialog box opens. Enter the dart parameters in 
the dialog box. 
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7 Click the OK button to execute the function 
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Dart Orientation at the Center 
To do so: 
1 Draw a segment attached to the contour where the dart is located.   

   
2 Select the Dart tool 
 
3 Click the pivot point (#1) 
 
4 Click on the segment (#2) indicating the position of the dart 
 
5 Click the segment again (#3) that remains fixed 
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6 The Dart Characteristics dialog box opens. Enter the dart parameters in  
  the dialog box. 

    
 
7 Click the OK button to execute the function. 
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Enhance Dart Characteristics 
 

The Dart tool can assign dart characteristics into an internal line after 
digitizing or in pattern development. 
 
To do so: 
1 Activate the internal line where you want to add the dart characteristics. 
2 Select the Dart tool. 
3 Click on the tip of the internal line. 

 
 
4 The External Dart Characteristics dialog box opens. The length of the  
  dart corresponds to the length of the internal line. Put the values and  
  characteristics as needed. 
5 Click the OK button to execute the function. 
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Example of adding a dart width with 2 difference values into an  
Internal Line: 
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Example of adding a dart into an Internal Line: 
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The External Dart Characteristics dialog box offers the following options: 
Length: Length of the internal dart. 
Punch Hole Distance: It is the distance of the punch hole from the dart 
pivot point. 
Internal Width: Width of the internal dart. 
Finished Length: It calculates the position of the punch hole at the center 
(Internal Width of the Dart) to the Dart tip. 
External Width: Width of the external dart (locate at the contour line). 
Finished Length: It calculates the position of the punch hole from the dart 
head to the center of the Internal Dart. 
Pleat Length: It applies the dart width value at a distance calculated from 
the dart head to the center of the Internal Dart. This results in a dart pleat. 
Closing Side Clockwise: If checked, this option folds the dart clockwise.  
If unchecked, this option folds the dart counter-clockwise. 
Punch Hole Distance From Side: It customizes the distance of the punch 
hole from the sides of the dart. 
Cut Jug at: It assigns a specific length to the dart head. 
Save as Default: It keeps the settings of the dart (finished length, punch 
hole, etc.) and reapply these settings to all future darts. 
Remove Characteristics: This option is only available when you edit a dart 
already created. Check it to remove the characteristics you set to your 
piece. 
 
To Select a Dart: Select the dart by clicking its center segment. This selects 
the full dart. 
To Modify a Dart: Select the dart and select Item Info... in the Treatment 
menu to reopen the External Dart Characteristics dialog box. 

To Delete a Dart: Select the dart and press Backspace (Windows / Linux) 
or Delete (Macintosh). This removes the attributes of the dart and keeps 
the opening of the dart. 
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  Dart Pivot 
The Dart Pivot tool allows you to pivot a dart to a new location. 
 
The Dart Pivot may be hidden under the Dart Transfer in the Toolbox. To 
activate the Dart Pivot, hold down the left mouse button 
(Windows/Linux) or the mouse button (Macintosh) on the Dart Transfer 
until the Dart Pivot appears. Move the mouse over the Dart Pivot and 
release the mouse button. 
 
 
To pivot a dart: 
1 Select the dart. 

2 Select the point where you would like to move the dart. 

3 Select the Dart Pivot tool. 

4 Click the point where the dart has to be closed. 

5 Click the point where you would like to move the dart. 

   6 The Dart pivot dialog box opens. Enter the required pivot  
  percentage (%) or pivot value (inch or cm). The remainder of  
  the dart stays at the original location sharing the same pivot    
  point. 

7 Click the OK button to execute the function. 
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Example of dart pivot with Pivot %: 

 

 
 

Example of Dart Pivot with Pivot Value: 
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  Dart Transfer 

The Dart Transfer tool allows you to transfer a dart to a new location on a 
segment. You can transfer the same dart on multiple segments, at once. 
 
The Dart Transfer may be hidden under Dart Pivot in the Toolbox. To activate 
the Dart Transfer, hold down the left mouse button (Windows/Linux) or the 
mouse button (Macintosh) on the Dart Pivot until the Dart Transfer appears. 
Move the mouse over the Dart Transfer and release the mouse button. 
 
 
To transfer a dart: 

1 Draw an internal segment attached to the contour where you wish to  
  transfer the dart. You can draw more than one segment if you wish to  
  transfer portions of the same dart to more than one location. 

2 Select the dart and destination segment(s). 

3 Select the Dart Transfer tool. 

4 Click the point on which the dart will be closing. 

5 The Dart Transfer dialog box opens. Enter the transfer percentage (%)  
  or transfer value (inch or cm). 

6 Click the OK button to execute the function. 
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Examples of dart transfer with Transfer %: 

 
 
 
 
 
 
 
 
 
 
 
 

 
Example of Dart Transfer with Transfer Value: 
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   Shirring 
The Shirring tool creates shirring. You can open the shirring and rotate it on a 
pivot point located on the contour. 
 
 
 
To develop shirring: 
1 Select a pivot point (#1) and the segment where you wish to place the  
  shirring (#2). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2 Select the Shirring tool. 
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3 Click the fixed point of the shirring. 
 
 
 
 
 
 
 
 
 
 
 
 

The Shirring Characteristics dialog box opens: 

 
 

4 Enter the desired values either in New Length, Measure to Add or % of  
  Actual Length. 

5 Click the OK button to execute the function. 
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Pattern piece with shirring: 
 
 
 
 
 
 
 
 
 
 

 

 

 
The Shirring Characteristics dialog box (for two ends of a piece) offers 
the following options: 
 
New Length: This value modifies the length of the selected segment. 
 
Measure to Add: This value adds a measure to the selected segment. 
 
% of Actual Length: This value takes a percentage of the actual length 
and adds it to the selected segment. 
 
 
Smoothing algorithm 
 
Tangents: It keeps tangents at the intersection of the lines while 
opening the piece. This option works best on curves. 
 
Best Fit: It allows you to add points to calculate the best curve, 
without tangents. This option works best on straight lines. 
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To Restore a Shirring after Digitizing 
 

The Shirring tool allows you to restore or assign shirring characteristics following 
digitization. 
 
To add shirring characteristics: 

1 Select a pivot point (#1) and the segment where you wish to place the  
  shirring (#2). 

 
 
 
 
 
 
 
 
 
 
 
 
 

2 Select the Shirring tool. 

3 Hold down the Alt (Windows) ,the Option (Macintosh) key or  

   Alt +Windows keys (Linux). 
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4 Click one of the end points of the segment. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

5 The Shirring Characteristics dialog box opens. Enter the desired values. 

6 Click the OK button to execute the function. 
 
 
Result: 
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To add shirring characteristics at each end of a pattern piece: 

1 Select the two segments where you wish to place the shirring. 

 
 
 

2 Select the Shirring tool. 

3 Hold down the Alt (Windows) or the Option (Macintosh) key or  

   Alt +Windows keys (Linux). 
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4 Click one of the end points of one of the segments 

 

 
5 The Digitized Shirring Characteristics dialog box opens. Enter the desired  
  values. 

 
 
 
 
 
 
 
 
 
 

 

6 Click the OK button to execute the function. 
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Result: A pattern piece with shirring characteristics: 
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   Seam Corner 
The Seam Corner tool allows you to create a Seam Corner on any 
sewing line’s mark or regular point. This tool creates a Seam Corner 
whenever two Seam Allowances meet. To use this tool, you need seam 
allowances. See the Seam Allowance section of this manual. 
 
 
To add a seam corner: 

1 Activate the shape you wish to add a seam corner to. 

2 Select the Seam Corner tool. 

   3 Click the sewing line point that requires the seam allowance  
  corner. The chosen point can be neither the end of seam  
  allowance nor a seam allowance corner. 
 
 
The Seam Corner Characteristics dialog box appears: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4 Select the radio button corresponding to the characteristics  
  of the desired seam corner and enter the required information. 

5 Click the OK button to execute the function. 
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Standard 

     For an even seam allowance  
     all around the pattern  
     pieces.     

           
Hem (Symmetry) on Side 1 
It symmetries the hem value on 
identified side one (1). 
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         Hem (Symmetry) on Side 2        90° Corner on Side 1 

       It symmetries the hem value on    It squares off the seam value  
       identified side two (2).             on identified side one (1). 
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90° Corner on Side 2 90° Corner on Both Sides 
It squares off the seam value on identified 
Side two (2). 

 

It squares off the seam value of both seam 
allowances. 
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Cut Corner on Bias 
 

It removes, on the bias, the seam value on both seam allowances. 
  

 

 

 

 

 

 

 

 

Both extremities of a seam allowance are called Seam’s End. They can be 
adjusted to create a proper Seam’s End if no other seam allowance is to be adde

Cut Corner on Notches Cut Corner 
It removes the corner edge at 
seam value. 

It enters value to remove calculation 
from the garment. 
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 To modify existing Seam’s End(s) Characteristics: 

 1 Select the Seam’s End reference(s). 
 
          
 

 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 

 
2 Select Item Info… in the Treatment menu. 

3 The Seam's end characteristics dialog box appears: 
 
 
 
 
 

 
 
 

 
 
 

4 Change the Seam’s End Characteristics to meet your needs. 

5 Click the OK button to execute the function. 
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Seam’s End Characteristics dialog box options are defined below:  
 

Perpendicular: It adds a perpendicular seam allowance. 

 

          
 
 

Extension: It adds the seam allowance on the same axis. 
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Hem (Symmetry): It mirrors on the seam value. 
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  Seam Allowance 
The Seam Allowance tool allows you to add seam allowances to the contour of 
a pattern piece. This tool works on Pieces View, not on Plan View. 
 
The Seam Allowance may be hidden under the Parallel Line in the Toolbox. To 
activate the Seam Allowance, hold down the left mouse button (Windows / Linux) 
or the mouse button (Macintosh) on the Parallel Line until the Seam Allowance 
appears. Move the mouse over the Seam Allowance and release the mouse 
button. 
 
Two types of seam allowances are available: 
 
Constant: A seam allowance that is parallel to the perimeter of the piece. 
 
Variable: A seam allowance with a different value at the beginning and at the 
end of the selection. 
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To add a Seam Allowance: 

1 Make sure that you are in Pieces View and working on a piece item,  

  not a plan item. See the section about the View menu to know more  
  about Pieces View. 
2 Select the segment(s) the seam allowance is to be added to. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 
3 Select the Seam Allowance tool. 

4 Click any selected segment. Seams are not added on segments that  
  already have one. 
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The Seam Characteristics dialog box opens: 

 

 
5 Enter the desired values and characteristics. 

6 Click the OK button to execute the function. 
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You can add notches independently for each extremity if the respective 
Notch for Value on Side 1 and Notch for Value on side 2 check boxes are 
checked. 
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No Sewing Line Does not Follow Notch 

Orientation 

Follows Notch 

Orientation 

Follow Notch Orientation: To project any notches on the contour line(s) 
according to orientation.  

 
 

 

 

 

 
 
 

 
To follow the notch orientation, check Follow Notch Orientation in the Seams 
Characteristics dialog box. 

 

To add a variable seam allowance, make sure that you have 
selected Variable in the Seams Characteristics dialog box. Then, you 
can choose which value to add on both side 1 and side 2 of your 
segment(s). 
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 Parallel Line 

The Parallel Line tool allows you to make multiple parallel lines on the 
contour and internal lines. 
 
The Parallel Line may be hidden under the Seam Allowance in the 
Toolbox. To activate the Parallel Line, hold down the left mouse button 
(Windows / Linux) or the mouse button (Macintosh) on the Seam 
Allowance tool until the Parallel Line appears. Move the cursor over 
the Parallel Line tool and release the mouse button. 
 
 
To draw parallel lines: 

1 Select the segment(s) next to which you want to draw parallel   
  line(s). 

2 Select the Parallel Line tool. 

3 Click either side of the selected segment(s), depending on which    
  side you want the parallel line(s) to be. 
 
  The Draw Parallel Lines dialog box opens: 

 
 

4 Enter the desired values or data. 

5 Click the OK button to execute the function. 
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The Draw Parallel Lines dialog box offers the following options:  
 
Value: The distance from the selected segment(s). 
 
Number of Lines: The desired quantity of lines. 
 
Distance from Side 1: Enter a value; it will be subtracted from side 1 of the new  
line. 
 
Distance from Side 2: Enter a value; it will be subtracted from side 2 of the new    
line. 
 
Attach to Contour: It attaches the new line(s) to the contour line. 
 
Keep Exterior Segments: When attaching to contour, to keep the segments  
that are outside the contour of the piece. 
 
Permanent: This option is available when you create one line from the contour. 
It allows you to move the contour line to its new location. When you select 
Permanent, you can move towards the interior or exterior.  
To pre-select this option, hold down the Alt key (Windows) or Option key 
(Macintosh) or Alt +Windows keys (Linux) while clicking the desired side.   
 
 
 

 
 
 
 
 
 
Perpendicular: It makes the extended segment perpendicular to the contour. 
 
Extension: The contour extends to complete the new segment (projection). 
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Parallel Lines created on a pattern piece: 

 
 

 

 

 

 

 

 

 

 

 

 

 
   Note: You may have to readjust grading after creating parallel lines. 
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Draw Parallel Line by Free Hand 
To do so: 
1 Activate the shape to create a parallel line 
2 Select Parallel Line tool 
3 Click on the shape and drag the direction to create a parallel line. 

 

      

 

4 Dash line appears and indicates the position of the parallel line. The  
  distance value displays on the Info bat at the right side bottom.  
  Mouse left click to confirm the location.  
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Grading Tools 
 

The Grading Toolbox / Toolbar section allows you to modify the grading 
coordinates of a grading nest. These tools are useful to further manipulate the 
grading evolution. 

 
 

 

 

 

 

 
 
 

          
 

For more information about the Grading tools, see the Grading chapter of this 
user manual. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Toolbox 

Toolbar 
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Chapter 4 
The Grading 
• • • • • • 

 
 
The Grading Basics 
 
 
The PAD System Pattern product offers a wide variety of tools and 
options to grade your patterns. The PAD System grading process allow 
you to easily apply the principle of proportionally increasing or 
decreasing your master pattern according to any customized set of 
body measurement to assure the fit your need. 
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Grading Arrows 
 
If the Grading Arrows window does not appear on screen, click the Show 
Grading Arrows item in the Options menu. Or the mouse right click on menu 
bar. 

 

  
        
 

To perform grading using Grading Arrows: 

1 Select the points to be graded. 

2 Select the increment in the pop-up menu at the bottom of the window. 

3 Select (highlight) the sizes to be graded or modified in the list. 

   4 Use the arrows and click as many times as necessary to get the desired  
  grading. Successive clicks increase the grading value according to the  
  increment you chose. For example, 4 clicks at 1/32” give you a grading  

     of 1/8”. 

 
 

   Note: You must be in Grade View to view the changes on screen. 
 
 



 

 382 

By using the Grading Increment list located left lower corner of the 
Grading Arrows dialog box. You can drag the end of the list. Click on 
Edit… item. 

 
 Evolutions dialog box opens: 

 
 
 
 
 
 
 
 
 
         

The Evolutions… option allows you to Edit / Add the list of Grading increments 
to create a personalized list. In the drop-down menu at the top of the window, 
select Inches or Centimeters. The lower window displays the available 
increments; check the increments on to display from the pop-up menu in the 
Grading Arrow window.  
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Or Click on the New button on the right upper corner, a new item creates 
and shows at the end of the Grading Increment list. Check and input the 
measurements. 

 
 
 
 
 
 
 
 
 
 
 

 
The newly-added item will show in the Grading Increment list on the 
Grading Arrows window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   

Ex: input the value to 3 in 
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Display Options 
 
The Grading Arrows dialog box allows you to determine what size name 
appears in the window. To show the option by choosing mouse right click on 
the title bar. 

 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 

Show Special displays the customized name that you may have assigned to 
each size in the Grade Working Sizes dialog box. If Show Special is not 
activated, Breaks defined in the Preferences –> Breaks & Colors item in the 
Options menu are displayed. 
 
Show Break Colors displays the list in the same color as the grading. You can 
define break colors using the Breaks & Colors function under the Preferences 
sub- menu in the Option menu. If Show Break Color is not selected, the list is 
displayed in black. 
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Modify Grading 
 
The Modify Grading button allows you to restore the grading of the selected 
size(s) to zero. Click the Modify Grading button and do not release the mouse 
button. Drag your cursor to the Reset option and release the mouse button. 

     

           
 
 

Distance/Steps  
 
 
The Distance/Steps function allows you to view: 
 

 • The distance between the Medium size and other sizes 
 

 • The step between each size 
 
 
This function is only active for irregular grading.    
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Regular/Irregular 
 
The Regular/Irregular function allows you to transform an Irregular Grading 
into a Regular Grading for each group of sizes.  
 

• The Regular Grading function can be found under the icon.  
 

 • The Irregular Grading function can be found under the icon.  
 

 
 

Grading/Modification 
 

If you wish, you can add or withdraw a value from the existing grading for one 
or many sizes. To do so, simply click the eye icon. Only the current modification 
is posted rather than the cumulative grading modifications. 
 
Example: 

 
 

 

Black Eye = Cumulative of the grading 
 

Before 

modifications 

 

X  
 

Y  

 

4  
 

X-Small 
 

0.125 
 

0.250 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Red Eye = Current Modification 
 

Before 

modifications 

 

X  
 

Y  

 

4  
 

X-Small 
 

0.00 
 

0.00 
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Black Eye = Cumulative of the grading 

 
Result 

 
X 

 
Y 

 
4  

 
X-Small 

 
0  

 
0.375  

 
 
 

The current modification is posted if you do not modify the position of 
the respective points or the previously modified selection. 
 
As soon as you modify the selection (i.e.: removing or adding a 
point to the selection, selecting or deselecting a segment), the 
value is reset to zero in the Modification View. 

 
 
 
 
 
 
 
 
 
 
 
 

 

Red Eye = Current Modification 
 

Modifications 

Made 

 

X  
 

Y  

 

4  
 

X-Small 
 

-0.125 
 

0.125 
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Grading Info 

The Grading Info window gives information about the grading of each 
selected point. If the Grading Info window does not appear on screen, click 
the Show Grading Info item in the Options menu. Or the mouse right click on 
menu bar. 

 

To get information about the grading of selected points, select the point(s) you 
want to get grading information about. A number appears next to each 
one of the selected points. In the Grading Info window, the grading 
information about the selected point(s) is displayed, sorted by the number 
that has been assigned to each point. 

 
 

 
 
 
 
 
 
 



 

 389 

The Grading Info dialog box displays the number of selected points in 
the top left corner of the window. It has three buttons in the bottom 
right corner, which are described below. 

 
   Grading/Library: If at least one point has a library value,  

         the Grading/Library button shows or hide from view 
     the library values. 

 
 

 Distance/Steps: This button allows you to view: 
 

• The distance between the Medium size and other sizes 
  

• The step between each size 
 

 This function is only active for irregular grading. 
 
 

 Regular/Irregular: This button allows you to view: 
 

 • The grading in Regular format 
   

 • The grading in Irregular format 
 

The Regular/Irregular function is not available if at least one 
selected point is irregular. In this instance, the grading of all 
selected points are shown in irregular format. 
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The Grading Info dialog box allows you to determine what size name  
appears in the window. To show the option by choosing mouse right  
click on the title bar. 

 

 

Show Special displays the customized name that you may have assigned to 
each size in the Grade Working Sizes dialog box. If Show Special is not 
activated, Breaks defined in the Preferences –> Breaks & Colors item in the 
Options menu are displayed. 
 
Show Size Colors displays the list in the same color as the grading. You can 
define break colors using the Breaks & Colors function under the Preferences 
sub- menu in the Option menu. If Show Size Colors is not selected, the list is 
displayed in black. 
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Grading Library 

A grading library allows you to keep the grading evolutions, or points, in 
a database. 

 

 
      

You can create as many grading libraries as you need. Each library may 
contain up to 999 grading evolutions available on screen through the 
Grading Library window. The Grading Library window lists the number 
and name (if any) of each grading evolution. 
 
Next to each element of the Grading Library, there is an arrow that 
opens a drop- down menu showing the X and Y coordinates of the 
element. At the top of the window, you can see each size. 
 
The Grading Library is displayed on the screen in a window that 
contains the numbers and names of the Grading Evolutions. Irregular 
Evolutions appear in bold characters. Only one Grading Library can 
be open at a time. 
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If you see a padlock icon next to an element, that means that the Medium 
size of this element has grading and the Grading Evolution of this element 
cannot be applied on a selected point because the Medium size is locked. 
To unlock it, uncheck the Lock medium size check box in the Grading 
Working Sizes dialog box. 

 
Grading Library Drop-Down Menu 

 
Library commands are available in the drop-down menu, to the upper 
right of the Grading Library window. The first three commands are 
accessible via the Grading Library drop-down menu or the Library 
sub-menu in the Grade menu. 
 
The Library drop-down menu offers the following options: 
 
New...: It creates a new Grading Library. 
 
Open...: It opens a Grading Library that already exists. 
 
Open & Reaffect...: It replaces the current Grading evolutions of the pattern 
pieces with those from a chosen Library. 
 
Print…: It prints the open Grading Library. 
 
Library…: It adds Grading Evolutions to another Grading Library. 
 
Close: It closes the open Grading Library. 

 
 
 



 

 393 

The Grading Library dialog box allows you to determine what size name  
appears in the window. To show the option by choosing mouse right  
click on the title bar. 

 
A special is a customized name that you may have assigned to each size in the 
Grade Working Sizes dialog box. If Show Special is not activated, Breaks 
defined in the Options > Preferences > Breaks and Colors dialog box is 
displayed. You can define break colors using the same dialog box. 

 
To create a New Grading Library: 

   1 Select the New… item in the Library sub-menu that can be  
  found in the Grade menu. Alternately, you can click the New...  
  item in the drop-down menu of the Grading Library window.  
  The Save new library as dialog box opens. 

2 Enter the library name in the File name text field. 

3 Press the Save button once you have located the proper folder.  
  The library window appears, with the name you gave to the  
  library. To return to the previous window, press on the Cancel  
  button. 
 
 
To open a Grading Library (.grl) file that already exists: 

1 Select the Open… item in the Library sub-menu in the Grade   
  menu. Alternately, you can click the Open... item in the   
  drop-down menu of the Grading Library window. A dialog box    
  opens. 

2 Select the library you wish to open and click the Open button. 
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        To replace Grading evolutions with evolutions from a chosen Library: 

  1 Select Open and Reaffect... in the Library sub-menu that can 
be found in the Grade menu. Alternately, you can click the 
Open & Reaffect... item in the drop-down menu of the Grading 
Library window. 

  2 An Open dialog box appears. Select the new library that will 
replace the current Grading evolutions. The grading of this Library is 
applied according to the numbering process on the open pattern. 
 
 
To add Grading evolutions to the current Grading library from another 
Grading library: 
 
1 Select the Library… item from the Grading Library drop-down menu. 
  The Grading Library dialog box opens: 

 
2 Click the Open button. An Open dialog box appears. 

   3 Select a Grading library and click the Open button.  

     The Grading Library appears: 
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4 To view the information about the selected Grading evolution  
  before merging it. You can click any Grading evolution to see its      

        information on the right side dialog box. 

 

 
 

5 Select the grading evolutions that you want to copy in the 
  Grading Library dialog box. 

6 Press OK. If you try to copy a number that already exists in the  
  library, the application asks you whether you wish to replace  
  the number that already exists. 
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Grading Library Buttons 

  

 
 

Distance/Steps: This button allows you to view: 
 

• The distance between the Medium size and other sizes 
  

• The step between each size 
 

 This function is only active for irregular grading. 
 
 

 Regular/Irregular: This button allows you to view: 
 

 • The grading in Regular format 
   

 • The grading in Irregular format 
 

The Regular/Irregular function is not available if at least one 
selected point is irregular. In this instance, the grading of all 
selected points are shown in irregular format. 

 
   New : It adds a new grading evolution to the     

     Grading Library. More details on next page. 
 

  Edit : It allows you to modify information about the      
       grading evolution that is selected. 
 

         Delete: It removes the selected grading evolution. 
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Creating or Editing a Grading Evolution 

 

At the top of the Grading Library window, select either the New button to 
create a new Grading Evolution or the Edit button to modify the selected 
one. Whichever choice you made, the Grading Evolutions dialog box 
appears. 
 
Two radio buttons allow you to decide whether it is a Regular or an Irregular 
Grading Evolution. 
 
For regular grading: 
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For irregular grading: 

 
Three different sections allow the entry of a new Grading evolution: 
 
• The first text box identifies the number under which the Grading evolution is  
  listed. 
• The second text box describes the name of the grading evolution. 
• The third section is different depending of the type of grading evolution  
   selected. Grading specifications contain dX and dY coordinates within  
   each break size for a Regular Grading Evolution; or within the sizes,  
   according to the current grading nest, for an Irregular Grading Evolution. 
 
Applying a Grading Evolution on selected points 
 
 
To apply a grading evolution on selected points: 
1 Select a grading evolution in the Grading Library window. 

2 Click the point(s) on the piece(s) that you want to apply the grading  
  evolution to. 
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The Grade Menu 

 
 
 

When developing a new style, the grading of pattern pieces is 
updated, according to the grading of the original pattern pieces. 
 
If you require a specific Grading evolution, the modification can 
be done in a number of ways, by: 
 
• Using Grade View tools 
• Modifying the coordinates of a point in the Grading info dialog box 
• Using the Grading Library to apply an evolution 
• Using the Grading Arrows function 
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Grade Menu: Working Sizes... 
 
At first, the Grading Working Size is always set at one size by default, which 
is the base size. There are two ways to create a grade nest with multiple 
sizes: you can either use the Change… button or the Generate… button in 
the Grading working sizes dialog box. 
 
To open the Grading Working Sizes dialog box, open the Grade menu and 
select Working Sizes... 
 
The Grading Working Sizes dialog box opens: 
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To create a new Grading nest using the Change… button: 

1 Press the Change... button to open the Grading nest information  
  dialog box. 

2 In the text box, enter the number of sizes needed for a particular style,  
  including the medium size (base). Alternately to press arrow up or down  

  from the Change dialog box. 

           
 

3 Press the OK button to validate the information. 
 
 

Establishing Different Grading Evolutions and Sizes 
Five regular breaks are available for grading. Their default names are 
X-Small, Small, Medium (being the base size), Large and X-Large. These 
names can be customized by going into Options -> Preferences -> Break & 
Colors .Different grading evolutions can be established per group. 
 
Establishing Size List 
In the Grading Working Sizes dialog box, select (highlight) the first item in the 
list and change the number in the Size text box on the right side of the 
dialog box to your smallest desired size. In the same manner, do the same for 
all the other items in the list getting to the last one, which would be your 
biggest size. 
 
If you do not work with numeric sizes, you can use special names 
(alphanumerical sizes) in the Special text box to identify the label of each 
one of your sizes. 
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Setting the Size Break 
 

 
In your size list, identify which size corresponds to your base pattern. The base size 
must be set at break medium. 

 

 
 

Modify the other size breaks according to the grading group you want them in. 
 
 
Note: Make sure that the plotter options item from the File menu are properly 
set up to plot either Sizes, Specials, or both. 
 

 
 
 
 
 
 

 
 
 



 

 403 

Locking the Medium size 
 

 
To lock the medium size to forbid future modifications to it, just check the  
Lock Medium Size check box. The grading of the medium size will be 
removed. Uncheck the Lock Medium Size check box to unlock the medium 
size. If you lock the medium size, the application warns you that you will lose 
all the changes made to the medium size and ask you whether you want to 
continue. 

 

 
 

To create a new Grading Nest using the Generate… button: 

1 Click the Generate… button in the Grading Working Sizes dialog box. 

2 The Generate Grading Nest dialog box opens. 

 

 

 

 

 

 

 

 

 

 

 
3 Set your medium size by entering the size that represents the medium  
  break (your base size) into the Medium Size text box. 
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4 Below, you can input the number of sizes you would like for each break  
  size(Amount), and enter the size interval between each size (Interval).  
   You can see a preview of the resulting size to the right of the window. 

5 Click the OK button to save your new grading nest. 

   6 Special names can be added afterward; Refer to Establishing Size List in  
  the previous section. 
 
 
Insert button 
The Insert button enables you to insert a new size, anywhere within the grading 
nest. 
To Insert a new size in the Grading nest: 

1 In the size window in the Grading Working Sizes dialog box, highlight the  
  place in the grading list above which you would like to add a new size. 

2 Click the Insert button. 

3 A new size appears above the size that you highlighted. 

4 Click the OK button to save your changes. 
 
 
Add button 
The Add button adds a new size to the end of the Grading Nest. 
To add a new size to the end of the Grading nest: 

1 Click the Add button in the Grading Working Sizes dialog box. 

2 A new size appears at the end of the Grading nest list. 

3 Click the OK button to save your changes. 
 
 
Remove button 
The Remove button deletes a selected size from the Grading Nest. 
To remove a size from the Grading nest: 

   1 In the size window in the Grading Working Sizes dialog box, highlight the  
 size that you wish to remove. 

2 Click the Remove button. 

3 The selected size is deleted from the Grading Nest list. 

4 Click the OK button to save your changes. 
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Color 
When you create multiple sizes of the same break (for example, 
several size breaks “small”), you can use the Color feature in the 
Grading Working Sizes dialog box to assign a unique color to each size. 
 
In the grading nest, each size within the same break group can 
appear as a different color. 
 
 
To assign a unique color to each size: 

1 Make sure that you have selected Use the Grading Nest Colors    
  in the Breaks & Colors dialog box that you can find in the   
  Preferences sub-menu, Options menu. See the section of this    
  User Manual about the Options menu for further details. 

 

 
2 In the Grading Working Sizes dialog box, select the size you wish to assign 
  a grading nest color to. 
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3 Click the color box next to the size. 

 

   
 

4 Select the color you wish to use from your Operating System’s color  
  picker. 

   5 Repeat these steps to add unique colors to the other sizes you wish    
  to customize. 

 
Your grading nest shows all sizes in the colors that you have selected. 
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Grading Nest List 
              Instead of going through the same process again, you can save your Grading 

Working Sizes information and reuse it for another pattern file if the same nest  
is required. 
 
Press the List… button in the Grading Working Sizes dialog box. A second dialog 
box opens where the previously saved grading nest information is listed (if any): 

 
 

To register the current grading working sizes to the Grading Nest List: 

1 Press the Add button. 

2 Enter the name of the current Grading nest. 

3 Click the OK button. 

4 Select the Grading Nest Name, the Grading Nest details shows on the   
  second part of the dialog box. 
  This grading nest appears in the Grading Nest list dialog box. 
 
Buttons in the Grading nest List dialog box offer the following options:  
 
Remove: To delete the selected grading nest from the list. 
  
Open: To validate the Grading Nest List to the open pattern file.       
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Grade Menu: Desizing... 
The Desizing... item in the Grade menu allows you to select another size 
from the Grading Nest and consider it as the working size (Medium). 
Desizing is always applied to all the pieces in the current style and you 
cannot Undo/Redo (Edit menu) a desizing. 
 
Two methods are available to desize a style: desizing without shape 
modification and desizing with shape modification. 
 
To desize Without Shape Modification: 

1 Select the Desizing item in the Grade menu.  

  The Desizing dialog box opens: 

 
2 From the drop-down menu, select the size that you want to  
  become your working size. 

3 Check the Without Shape Modification check box. 

4 Click the OK button to apply the desizing without shape modification. 

 
 
Note: You cannot select Without Shape Modification and Permanent Desizing     
check boxes at the same time. 

 
The desizing Without Shape Modification modifies the grading nest by 
moving the medium size to another size of the existing grading nest. The 
grading nest breaks (Grading working sizes dialog box) and the grading 
evolutions (Grading Info dialog box) change to keep the same shapes and 
measurements for all sizes in all pieces. 
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The desizing Without Shape Modification allows you to verify the 
measurements of a specific size. To go back to the original medium size, 
open the Desizing dialog box, select the original medium size number in the 
drop-down menu, select the Without Shape Modification check box and 
click the OK button. 
 
For example, if your medium size is 10, you can change it to size 14 or another 
size number. 
 
Before desizing Without Shape Modification – the Medium size is listed as Size 10: 
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After desizing Without Shape Modification – the Medium size is listed as Size 14: 
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To desize with Shape Modification: 

1 Select the Desizing item in the Grade menu.  

  The Desizing dialog box opens: 
 

 
2 From the drop-down menu, select the size that you want to   
  become your working size. 
3 Uncheck the Without Shape Modification check box. 

4 Click the OK button to apply the desizing with shape modification. 
 
The desizing with shape modification applies the measurements of the 
desired size to the medium size for all pieces. The grading nest (Grading 
Working Sizes dialog box) and the grading evolutions (Grading Info dialog 
box) remain the same. The shapes for all sizes are adjusted according to the 
new shape of the medium size. 
 
For example, if the medium size is size 10, after a desizing with shape 
modification to the size 14, the working size remains size 10, but with the 
measurements of size14. 
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If the Permanent Desizing check box is checked, the desizing is permanent. 
 
If the Permanent Desizing check box is unchecked, the desizing is temporary. 
To go back the original shapes, open the Desizing dialog box, select the 
medium size number in the drop-down menu and click the OK button. 
 
Desizing must be permanent to use a pattern file for the creation of a new 
marker file in PAD Marker Design. To convert a temporary desizing to a 
permanent desizing, open the Desizing dialog box, check the Permanent 
Desizing check box and click the OK button. 
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Grade Menu: Library 

 

 
A grading library allows you to keep the grading evolutions, or points, 
in a database. The Grading Library is explained in the Grading Basics 
section of this chapter. The three items contained in the Library 
sub-menu of the Grade menu are the same as the three first items of 
the drop-down menu of the Grading Library window. Refer to the 
Grading Basics section for further details about those three items. 
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Grade Menu: Grading Info... 

The Grading Info... item in the Grade menu allows you to create New Grading 
Evolutions, and view and/or modify grading coordinates on selected points. 

 
To create a New Regular Grading Evolution: 

1 Select the point(s) required on the shape(s). 

2 Select the Grading Info... item in the Grade menu. The Grading Info 
  dialog box appears. 

3 Enter the X and Y coordinate values of the point(s) in the dialog box. 

4 Press on the OK button to validate the operation. 
 
The Grading Info dialog box is divided into three sections: 
 
The first section is the Grading Library reference. If Grading Evolutions 
correspond to an evolution from the Library, the number and name are 
highlighted in the Grading Library. 
 
The second section contains the Grading Evolution coordinates in X and Y, 
according to the size group: X-Small, Small, Medium, Large and X-Large. Two 
radio buttons (Read evolutions and Library evolutions) allow you to verify if 
the coordinates have been modified according to those found in the open 
Grading Library.                                                 
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The third section contains two buttons: the Copy to Library button and 
the Find button. 
 
 
The Copy to Library button allows you to copy the coordinates of the 
selected point to an open Library: 

1 Open the Grading Info dialog box. 

2 Select the Copy to Library button. 

3 Enter the name and the number of the point. 
 
 
The Find button searches for Grading Evolutions in an open library. To 
find a Grading evolution that already exists: 

1 Click the Find button. 

2 Enter the name or the number of the grading evolutions that you want. 

3 Click the Search button. 
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When graded points with Irregular Grading are selected, the Grading 
Evolutions change and allow you to view and modify grading coordinates 
independently, on all sizes. 

 

 

The new Grading Info dialog box is divided into three sections:  

The first section displays grading library references. If Grading Evolutions 
correspond to an evolution from the library, the number and name are 
highlighted in the Grading library. 
 
The second section contains the Grading Evolutions in dX and dY, according 
to each size on the Grading Nest. The Grading Evolution can be displayed 
from the Medium size or by Step between Sizes, if you have selected the 
Step between Sizes check box. 
 
The third section contains the Copy to Library… button, which copies the 
coordinates of selected points to an open library. 
 
The Show Special check box hides the Break names and displays the Special 
size names established in the Working sizes dialog box. 
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To create an Irregular Grading: 

1 Select the Point(s) required on the shape. 

2 Select the Grading Info… in from the Grade menu. 

3 Select the Irregular radio button. 

4 Enter the desired dX and dY coordinates for each size. 
 
 
To copy the grading in the Library: 

1 Do the steps to create an irregular grading. 

2 Select the Copy to Library button. 

3 A new dialog box appears. Enter the name and number of the  
  point. 
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Grading Tools 
The Grading Toolbox / Toolbar section allows you to modify the grading 
coordinates of a grading nest. These tools are useful to further manipulate 
the grading evolution. 

 
              Toolbox 
  
 
 
 
                                          Toolbar 
 
  
 

Grading Evolution can be easily modified in four different ways, by: 
• Entering coordinates into the information of Grading Evolutions to the 
  dialog box (Grading Info… in the Grade menu). 
• Using the Grading tools. 
• Using the Grading Arrows. 
• Using a Grading Library. 

 
 
 
Note: To use the Grading tools, you must be in Grade View and have a 
defined grade nest. 
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  Symmetry Grading 

The Symmetry Grading tool allows you to apply symmetry freehand or with a 
precise angle. 
 
To symmetry the grading: 

1 Activate the piece. 

2 Select the Symmetry Grading tool. 

3 Click a reference point to be modified, click somewhere within the       
  working area and hold down the left mouse button (Windows / Linux)  

 or the mouse button (Macintosh); a line representing the axis of  

 symmetry appears. Drag this line to the desired position. 
 
Hold down the Shift key (Windows, Macintosh and Linux) to constrain the 
symmetry axis to X, Y, ± 15 º or ±165 º.Constrain a movement in X, Y or every 
15°. (Define the angle by the setting “Round Angle” in the Preference menu.) 
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The Symmetry Grading tool allows you to reverse the Grading Evolution 
according to the X axis, the Y axis, or a precise angle. 
 
 
To symmetry the grading in a precise angle: 

1 Activate the piece. 

2 Select the Symmetry Grading tool. 

3 Hold down the Alt key (Windows) or the Option key (Macintosh)  

  or Alt +Windows keys (Linux). 

 

 
 
 
 
 
 
 
 
 
 

4 Click the point you wish to modify. The Grading Symmetry dialog box  
  appears: 
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5 Select the appropriate radio button or enter the value of the  

  desired angle in the text box. The angle can be positive or  

  negative, depending of the sign of the value. 

 

 

 

 

 

 

 

 
6 Click the OK button to execute the function. 
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Rotate Grading 

      The Rotate Grading tool allows you to execute a freehand rotation of the  
      grading around the medium point. 

 
To rotate the grading of an activated point: 

1 Activate the piece. 

2 Select the Rotate Grading tool. 

   3 Click the reference point you wish to modify, click somewhere in the   
  working area and hold down the left mouse button (Windows / Linux)  

  or the mouse button (Macintosh); a line appears. Move this line to the  
  desired position. 

    
 
 
 
 
 
 
 
 
 
 

 
 

Hold down the Shift key (Windows, Macintosh and Linux) to constrain the 
rotation to X, Y or 15°. (Define the angle by the setting “Round Angle” in the 
Preference menu.)  
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The Rotate Grading tool allows you to rotate the grading coordinates to  

45°, 90° or at a determined angle. 
 

To rotate the grading coordinates in a precise angle: 

1 Activate the piece. 

2 Select the Rotate Grading tool. 

3 Hold down the Alt key (Windows) or the Option key (Macintosh) or Alt    
  +Windows keys (Linux) and click the point you wish to modify. 

 
 

 
 
 
 
 
 
 
 
 
 

The Grading Rotation dialog box opens: 
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4 Select the appropriate radio button or enter the value of the  
  desired angle in the text box. The angle can be positive or  
  negative, depending of the sign of the value. 

 
 
 
 
 
 
 
 
 

 
5 Click the OK button to execute the function. 
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Manipulating Grading 

 
The Manipulate Grading tool allows you to move each graded size of a 
selected point freehand. 

 
 

To manipulate the grading: 

1 Activate the piece and select the Manipulate Grading tool. 

2 Click a point. A small point appears on each grading line. 

3 Select and drag the size point(s) to the required position. 
 
 

The X and Y evolutions are indicated in the Info bar. You can modify any size. 

An Irregular evolution results if the sizes are moved individually. 

A Regular evolution remains as a Regular evolution if the selected size is the 
biggest size in a large or extra-large break size, or if it is the smallest size of a 
small or extra-small break size. 
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Hold down the Shift key (Windows, Macintosh and Linux) to restrain movement 
on the X or Y axis or at a 15°. (Define the angle by the setting “Round Angle” 
in the Preference menu.) 
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Copy/Paste Grading 
The Copy/Paste Grading tool allows you to copy grading evolutions from 
one point to another. 
 
To copy/paste the grading: 

1 Activate the pieces. 

2 Select the Copy/Paste Grading tool. 

3 Click the reference point to copy its information.  

  A dialog box appears: 

               
 
 
 
 
 
 
 
 
 
 

4 Select the appropriate radio buttons and/or edit the text box. 

5 Click the OK button to execute the function. 

6 The cursor changes to a dash cross. Click the point where you want to  
  paste the copied Grading Information. It can be a point of the same  
  piece or a point of another activated piece. 
 
Hold down the Shift key to apply these coordinates on more than one point 
and on other shapes. 
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The Copy and Paste Grading dialog box offers the following options: 
 
Replace Evolutions: It replaces existing evolutions with those previously copied. 
 
Add Evolutions: It adds previously copied coordinates to grading 
evolutions that exist. 
 
Copy X and Y: It transfers the coordinates of both X and Y axes. 
 
Copy X: It transfers the coordinates of the X axis. 
 
Copy Y: It transfers the coordinates of the Y axis. 
 
Select one of the optional check boxes to apply the grading:  
 
Perpendicular: It pastes the evolutions perpendicularly on the Points.  
 
Symmetry X: It symmetries the copied coordinates on the X-axis.  
 
Symmetry Y: It symmetries the copied coordinates on the Y-axis. 
 
Rotation: It pastes the evolutions with a degree of rotation. 
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Copy/Paste Grading, before and after: 
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Parallel Grading 

The Parallel Grading tool allows you to select a segment or an entire shape 
and assign a Parallel Grading to it. 
 
 
To apply a parallel grading to a segment or an entire shape: 
1 Select the segment(s). 

2 Select the Parallel Grading tool. 

   3 Click the side (inside/outside the piece) where positive values need  
  to be assigned. 
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The Parallel Grading dialog box opens: 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

4 Select the size(s) that need parallel grading and enter the desired     
  grading values in the Distance text box. 
 
 
  The Result: Parallel Grading 
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Parallel Grading Dialog box options are defined below: 
 
Step between Sizes: Shows the grading difference from the Medium 
size (if unchecked) or the difference between each size (if checked) 
in the dialog box. 
 
Show Special: Allows you to hide the break name and display special 
characters established in the Grading working sizes dialog box. 
 
Check / Uncheck: Allows you to select or deselect sizes on which the 
Parallel Grading should or should not be applied. 
 
Calculate Extremities Intersection: 

 
 
 
 
 
 
 
 
 
 
 

Do not Calculate Extremities Intersection: 
 
 
 
 
 
 
 
 
 
 
 
 



 

 434 

Align Grading 

The Align Grading tool allows you to change the alignment of a grading 
evolution. 

 
To align the grading: 

1 Activate the piece. 

2 Select the Align Grading tool. 

3 Click the point you wish to adjust. 

   4 Click a reference point without releasing the mouse button. A guideline  
  appears; drag this guideline to the desired location and release the  
  mouse button. 
5 The Grading Evolution is adjusted along the guideline. 
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To obtain a straight line, orient the shape on the required axis first. Hold 
down the Shift key (Windows, Macintosh and Linux) on the keyboard 
to constrain the line movement in X, Y or 15°. (Define the angle by the 
setting “Round Angle” in the Preference menu.) 
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Copy/Paste Path Grading 
The Copy/Paste Path Grading tool copies the grading of one path and  
pastes it to another path. The path of points you want to copy the grading  
of and the path of points you want to paste the copied grading to must 
have matching regular points and notches. All intermediate points must be 
either contour points or mark points without notches. 

 
 

To copy/paste a grading path if the paths are on a different shape: 

1 Select the point(s) of the path you want to copy the grading of. 

   2 Using the Shift key (Windows, Macintosh and Linux), select the point(s)  

     of the path you want to paste the grading to. 
 
 
 
 
 
 
 
 
 
 
 
 

3 Select the Copy/Paste Path Grading tool. 

4 Click an extremity point of the first path you selected. 

5 Click an extremity point of the second path. The grading of the first  
  extremity point you clicked on is pasted to the second point you  
  clicked on, and the grading of every following point on the first path is  
  pasted to the other points on the second path, in sequential order. 
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Pasting a Path Multiple Times if Paths are on Different Shapes 
 
To paste a path multiple times: 

1 Select the path you wish to copy. 

2 Select the path(s) to be altered (overwritten by the copied path). 

3 Select the Copy/Paste Path Grading tool. 

4 Hold down the Shift key (Windows and Macintosh) and click the starting  
  point of every path where to paste the grading. 
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Smooth Path Grading 
 
The Smooth Path Grading tool allows you to apply grading on a selected path. 
You can apply grading according to the X or Y axis alone or on both axes 
simultaneously. 
 
To apply grading on a smooth path: 

1 Select one or more segment that form a continuous path. 

2 Select the Smooth Path Grading tool. 

3 Click an extremity point. 
 
The Smooth Path Grading dialog box appears: 

 

 
 

4 Select the appropriate algorithm corresponding to your needs and   
  select the axis that the smoothing is required on. 
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The Smooth Path Grading dialog box offers the following options: 
 
Progressive from End to End: It establishes a progressive grading 
evolution on a selected path. 
 
Smooth Keeping the Ends Path Angles: It establishes a progressive 
grading evolution of all sizes on a selected path, keeping the 
original end path angles. 
 
Distribute Respecting the Path’s Enclosing Rectangle: It performs a 
distributive grading as if you were using the Distribute Grading Tool 
inside a partial selection. 
 
Keep Grading on Other Axis: This option is available when you select 
the X or Y axis, but not both. Will apply the grading on the selected 
axis, but will keep the grading as is on the other axis. 
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Perpendicular: It applies a perpendicular progression on a segment. 
 

 
Axis: The axis on which the grading will be appllied. You can apply the     
      grading on both axes. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 441 

 Distribute Grading 

The Distribute Grading tool allows you to perform grading distribution tasks 
within a shape/group or on a selection. 
 
Distribute Grading is available according to two methods of distribution: 
 
• Inside a partial selection of a group or a piece (for armholes, crotches, etc.) 
• Inside a group or a piece (for Punch Holes, Style Lines, Internal Darts, etc.) 
 
To distribute the grading inside a partial selection: 
 
This distributes an existing grading, inside a partial selection of a group 
or a piece to adjust the armholes, crotch, etc. 
 
1 Select the segment(s) and/or point(s) on which the grading is to be  
  distributed. 

2 Select the Distribute Grading tool. 

3 Click two points that represent the enclosing rectangle within  
  which the grading has to be distributed. 

4 The Distribute grading dialog box opens, allowing you to select  
  on which axis the distribution will be made. Select the Radio  
  button according to the desired grading distribution axis, as follows: 
 
 
  In X and Y: Distributes the grading according to the X and Y axes. 
  In X: Distributes the grading according to the X axis. 
  In Y: Distributes the grading according to the Y axis. 
 
  The option Keep grading on other axis is available with the In X and   
   In Y distribution methods. When checked, it allows you to modify  
  the grading of the selected axis without affecting the grading of  
  the other axis. 
 
5 Click the OK button to execute the function. 
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Example of distribution inside partial selection: 
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To distribute the grading inside a group: 
 
 
1 Select the segment(s) and/or point(s) on which the grading is to be  
  distributed. 

2 Select the Distribute Grading tool. 

3 Hold down the Alt (Windows) key or the Option (Macintosh) or  
  Alt +Windows keys (Linux) key and click a selected point. 

 
 
 
 
 
 
 
 
 
 

4 The Distribute Grading dialog box opens. Select the Radio button  
  according to the desired grading distribution axis, as follows: 
 
• In X and Y: Distributes the grading according to the X and Y axes. 
• In X: Distributes the grading according to the X axis. 
• In Y: Distributes the grading according to the Y axis. 
 
The option Keep Grading on Other Axis is available with the ln X and 
ln Y distribution methods. When checked, it allows you to modify the 
grading of the selected axis without affecting the grading of the 
other axis. 
 
5 Click the OK button to execute the function. 
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Example of distribution inside a group: 
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Chapter 5 
PAD SYSTEM MTM-FRAMES 
• • • • • • 
 

The Frame Environment, available in the View menu, contains advanced 
tools to obtain the precise measurements of the medium size and/or the 
graded sizes. 
 
Frames are construction lines applied to a construction plan. The Frame 
values are customizable and allow the user to rapidly change the 
proportions of the corresponding pieces. 
  
Frames on pieces can be linked together to obtain circumference 
measurements. They can be related to one another through a formula 
editor allowing modifications to follow from piece to piece. 

 

 
 
 

Note: The Frame feature is available in Pattern Enterprise only. 
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The User Environment in Frames 

 
 
 
 

Note: Prior to creating the Frame, all the points used to apply the Frames 
must already be on the Pattern Piece. 

 
 
 
 
 
 
 
 
 
 
 
 



 

 447 

To open or close the Frames window: 

1 Select the Frame View item in the View menu. 

2 From the Options menu, select the Show Frames item. If this item        
  is already activated, the menu displays with a check mark ()  
  next to the item. The Frames window should be visible on 

  screen. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3 You can use the icons located at the top of the window to manipulate  
  the Frames. 
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Medium/All sizes: This toggle button allows you to select whether you 
want to modify the measurements of the medium size or of all the 
sizes of the Grading nest.  When you define the Grading Working 
Sizes, the Frames window displays all the sizes in an edit text box if you 
click the Edit Medium/All sizes icon. 
 
The Medium button maintains the grading values between sizes. 
 

The All Sizes button allows you to modify the grading values between 
sizes.     
 
View Options: It shows the graded measurement: Lengths, Differences 
or Steps. 
 
 
Delete: This button erases selected undefined elements. 
 
 
 
Link Frames: It links selected Frames to get their combined values. 
 
 
 
Cancel: It cancels the last entries up until the last Apply. 

 
 
 

Apply: It applies the last entries in the Frames window. 
 
 
 

 
 

Note: You can undo the changes you made anytime by clicking the Undo 
item in the Edit menu. 
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The Frames window sub-menu, on the upper right side of the Frames 
window, features a black arrow with an icon that opens a drop-down 
menu with the following options: 

 
 

New Set…: It creates or adds a new set of Frames 
 
New Specs…: It assembles combined Frame results to create garment 
specification sheets for quality control purposes. 
 
Open Sets…: It opens existing Sets (Frame Libraries) to apply and use 
them on a similar pattern. 
 
Save Sets…: It saves a Frame Set for reuse on similar pattern shapes. In the 
Save type drop-down menu, select the file that you want to save in V5 or 
the previous version. Ex: Select the file type to Frame Library File 5.0, it 
supports in V5. And choose to the file type to Frame Library File 4.80, it 
supports in 4.8 or below. 
 
Select Spec…: There are four categories (Body, Sleeve, Collar and 
Bottom) in the dialog box of Select Spec. And each category will 
pre-set the most used items to each category and let you to choose. 
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And each category will pre-set the most used items to each category. 
 
The first drop-down menu let you to select all existing sets. You may select 
the set of the new spec belongs to. If there are no existing sets, Set 1 will be 
created by default. 
 
New: Add and name a new item at the end of the list. 
 
Delete: Remove the selected item from the list. 
 
Center Segment List…: It allows creating the most used Center Segment 
into a list.  

 



 

 451 

Frame Name List…: It allows creating the most used Frame Name into a list.  

 

 
Frame Segment List…: It allows creating the most used Frame Segment 
into a list. 

 
 

Delete Undefined Objects…: It deletes undefined Frame Sets, Frame Links, 
Segments and Specs from the Frames window list. 
 
 
*All items in the Center Segment List, Frame Name List, Frame Segment List   
 and Select Spec are saved in the Pattern Preferences file. 
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The Frames dialog box allows you to determine the size details appears 
in the window. To show the option by choosing mouse right click on the 
title bar. 

 
 
 
 
 
 

 
Show Header: It shows or hide the Frames window header. 
 
Show Special: It shows or hide the Special name established in the Working 
Sizes dialog box. 
 
Show Break Colors: It shows or hide the break colors established in the Breaks 
and Colors dialog box. 
 
Always Show All Sizes: It works with a complete view of the Frames window, 
showing all the sizes, if checked, or the Medium size only, if not checked. 

 
 
 
 
 
 
 
 
 
 
 
 
 

C 
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Contextual Menu in Frame View 
There are four new items (Item Info, Specify Calculation (Measure), Specify 
Calculation (Level) and Reverse Segment Orientation) on mouse right 
click sub-menu.  

  
 
Item Info To select one of the Frames and right click on mouse to choose 
Item Info. A dialog box appears; you can enter the frame name to the text 
box or click on the Name drop down menu to select the frame name 
pre-set from Frame Name List. 
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Specify Calculation (Measure) / Specify Calculation (Level) 
To select one of the Frames and right click on mouse to choose Specify 
Calculation (Measure) / Specify Calculation (Level). A dialog box appears 
as follows.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You will get the dialog box if you click on the  icon next to the Measure / 
Level items.  
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Reverse Segment Orientation 
To select one of the Segment and right click on mouse to choose Reverse 
Segment Orientation. The selected Segment will reverse to opposition 
direction.  
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Frame Tools 
 
The toolbox/ toolbar allows you to make any types of action on plan pieces in 
Frame view. 

        
                   Toolbox 
 
 
 
 
 
                                      Toolbar 
 
 
 
 

Pointer  
 The Pointer tool activates or selects elements. 
 
  

Zoom In/ Out 
  

 The Zoom In/ Out tool allows you to enlarge or reduce the    
 general working area view. 
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Ruler 
The Ruler tool allows you to get information on the distance between any 
two clicks made on reference points, or anywhere else within the working 
area. It allows you to get the graded length of the selected elements when 
you click the extremity of one of the selected element while pressing the Alt 
key (Windows) or the Option key (Macintosh) or Alt +Windows keys (Linux). 

         
 
 
 
 
 
 
 
 
 
 

Text  

       The Text tool allows you to write notes anywhere on the working area. 
 

Create Frame 
       The Create Frame tool creates center frames, level 0 frames and all  
       other construction Frames attached to a piece. 

 

Make Frame Segment 
       The Make Frame Segment tool creates a Frame segment on the perimeter 
       of a piece. 
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Using Frames 
 

Create a New Set of Frames 
To create a New Set in the Frames window: 

1 Select the New Set… item from the drop-down menu in the Frames  
  window. 

 
 

2 The Set dialog box opens. Enter the name of the desired Set. 

3 Press the OK button to validate the information. 

 
Note: You cannot begin the title of a new set with a number, nor can you  
Insert symbols, such as % : ( ) + - * / . 
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Your set name appears in the Frames window. Press the + icon next to its name  

to see the set attributes. 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Once you have created a Set, there are four categories listed below the  

Set name: 

 

 

 

 

 
C
e
n
t 
 

 
Centers: It identifies the center of a Pattern Piece, gathers the Points of 
measurements and the levels of a piece. 
 
Links: It gathers dependent frames that are linked together to obtain the 
total measurement of garment circumferences. 
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Segments: It gathers the perimeters identified on the pattern pieces. They 
adjust graded measurements and create formulas and/or specification 
measurements. 
 
Specs: These are specification measurements by formulas between all  
of the above. It gathers combined results by adding together different 
components such as Frame measurements without the Frame Levels or 
Link measurements to create garment specification sheets for quality 
control. 

    
Measurement Charts: These are specification measurements by formulas 
between all of the frames. User can define various items and set value 
on it accordingly. Once the value of item in Measurement Charts is 
modified or changed, all corresponding items (Frames, Segments or 
Links) will be automatically updated. 
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Create Center Frame 
 

Frames can be applied on plan pieces while in Frame View. You must create 
a first frame which will be the Center Frame for each piece that is part of a 
Set. This center frame is displayed in pink on the piece. It gives the 
orientation of the measurement of the other frames related to the piece. The 
Center Frame is your main construction line, which generally follows the 
grain line. 

 
To establish a Center Frame: 

1 Activate the pattern shape(s) 

2 Select the Create Frame tool in the Toolbox. 

3 Click a first point on the contour of the shape where you want to   
  place your Center Frame. 

4 Click the second point on the contour of the shape where you want 

  to place your Center Frame.  

The Center Segment dialog box opens: 

 
5 Enter the Center Frame name to the text box or click on the Name drop 

down menu to select the Center Frame name pre-set from Center 
Segment List. Center Frame names within a Set must be unique. Frame 
names within a Center Frame must be unique. 

6 If you have more than one set in the file, use the drop-down menu to  
  select the Set the Center segment belongs to. 

7 Select Center Frame Characteristics from the drop-down menu. 



 

 462 

 You can select among the following Center segment characteristics: 

 
Folded: For a piece that is folded or symmetrical with an intelligent line 
(i.e.: The front or back of a shirt).     

                                                   

Opened: For a piece that is opened (i.e.: The sleeve). 
 
Half: For an opened piece required twice on the final garment (i.e.: 
The side piece of a princess skirt). 
 
See the different types of Center Frames section following next for examples 
on how to select best the appropriate center characteristic for your pieces. 
 
8 Click the OK button to execute the function. 
 
Newly created Center frames appear gathered below the Centers category: 

 
 

 
 
 
 
 
 
 
 
 
 

To view the Set Categories or their sub-items: 

• Click the plus (+) sign to expand the list. 
• Click the minus (-) sign to collapse the list. 
 
 
Hold down the Alt key (Windows) or the Option key (Macintosh) or Alt 
+Windows keys (Linux). And click on the plus (+) or minus (-) sign to 
expand or collapse an entire category, respectively. 
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Place the cursor on the Center name to view its attributes. 
 

 

 

 

 

 

  
 
 
 
 

The attributes of a Frame can be: 

• Define or Not Define 
• Linked or Not Linked 
• Level Zero 
• Based on a formula 
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Different Types of Center Frames 
 
There are three types of Center Frames: 

• Folded 
• Opened 
• Half 

 
Folded Type Center Frame 
 
This function is used when Frames are to be applied on one side of a folded 
Pattern Piece or an open piece with an intelligent mirror. You use it on paired 
pieces that would be joined at their center point (ex: from jacket). 
 
Since the piece is considered folded, the value calculated on its related 
frames is doubled to get the total of the finished garment. When a 
modification to a value of its frame is made, the value to be distributed is 
divided in two and applied to the side opposite the center. This allows you 
to obtain the total value once the garment is completed. 
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Opened Type Center Frame 
 
For opened pattern pieces (ex: sleeve or pant legs). 
 
When a piece is considered opened, the total value of its frames is the 
total of the finished piece. When a modification to a value of its frames is 
made, the value can be distributed in two ways: 
 
• By Proportion: The value is divided proportionally. The piece center 
  positioning is compared to the overall geometry of the piece and the    
  values are distributed according to the proportion of each side from  
  the center. 
 
• By Percentage: The percentage of the value to be added on each side 
  is determined by the user, using the dialog box. 
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Half Type Center Frame 
 
For an opened piece that is required twice in the final garment (ex: a side  
panel of a jacket or skirt). 
 
Since the piece is considered half, you need two halves to obtain the total 
garment value so the frame length is calculated doubled to get the total of 
the finished garment. When a modification to a value of its frames is made, 
the value is divided in two and the result distributed in one of two ways: 
 
• By Proportion 
• By Percentage 
 
(See Opened type center frame on the preceding page for more 
details about these two options.) 
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Examples of different types of center frames: 
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Create Frames Automatically 

Frames are added to the piece automatically. And all of Frames 
details display on the Frames window. The first Frame (First click on 
the Center Segment) created on a Center Frame is the Level Zero. 
Level Zero is the starting position for measurements of the pattern 
pieces according to the length. It should be placed at the same 
position on all related pattern pieces. The Level Zero frame line 
appears blue and thicker than other frames on the piece. Once you 
have defined Level Zero, all other Frame Levels for that pattern 
piece are calculated from that Level Zero frame. 
 
Once you have defined Level Zero, all other Frame Levels for that pattern 
piece are calculated from that Level Zero frame. 
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Frames are added and named to be a Digital and display on the Frames 
window. You may rename the Frames by choosing the Item Info on mouse 
right click or double click the item on the Frames window. 

 
 
Note: All Frame levels are measured starting from Level Zero, which is the first 
Frame created. We recommend that you establish Level Zero in a place that 
is not height graded. 
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To create Frames Level Zero: 

1 Activate the pattern shape(s). 

2 Select the Create Frame tool. 

3 Click an existing point, located on the pattern piece where you want  
  your Level Zero frame to be set. 

4 Click the Center segment for a Folded Center or on an existing point 

  on the opposite side of the center for an Opened or Half Center   
  frame. 
 
 
 One of two Frame dialog boxes opens, depending on the selected   
 characteristic of the Center Frame. 
 
 Folded Center Frame: 

 
 
 
 
 
 
 
 

 Opened or Half Center Frame: 
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The Apply Measure on Perimeter check box measures the perimeter 
between the starting and ending points of the frame. Otherwise, the 
straight-line measurement is given on the frame. 

 
5 Enter the name of the Frame. 

6 In the instance of an Opened or Half center frame, select the  
  appropriate radio button. The Apply Proportionately on Each  
 Side and Apply with Fixed Proportions on Each Side options  
 determine how modifications should be applied on the piece. 

 

 
 

7 Check the Apply Measure on Perimeter check box, if needed. 

8 Click the OK button to execute the function. 
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The Frame appears beneath the Center Frame it belongs to. 
 
 

 
    
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Press the arrow at the left of the name of the Center frame to view its attributes. 
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Items are classified in the order they were created in. 

 
 

Note: If you click either the word Measurements or Levels under the 
title next to the Formulas button, you can copy and paste the whole 
row on selected elements of other levels or measurements. Using the 
button   or  , you can select to edit the Medium Size or 
All Sizes. 
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A Frame can be created on the Center Frame so it controls the level of 
certain pattern elements like the neckline depth. You create this by clicking  

a contour point that is positioned on the Center Frame. The frame appears  

as a square around the point. This frame controls level measurements. 
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Create Internal Frame 
Internal Frames could be added to the piece. And all of the Internal 
Frames details display on the Frames window and the feature is the same 
as Contour Frames. All Internal Frames level are measured starting from 
Level Zero, which is the first Frame created. 
 
To create Internal Frames: 
1 Activate the pattern shape(s). 
2 Select the Create Frame tool. 
3 Click an internal point, located in the pattern piece where you want the  

 Internal Frame to be set. 
4 Click the Center segment for the fixed position (Center Frame). 
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The Frame dialog box opens: 

 
 
5 Enter the name of the Frame and press OK button to validate. 
 
Internal Frame added on Opened piece or Half piece: 
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Manipulating the Frames on Pattern Pieces 
 
 
To remove a Frame item:  
The Frame must be deleted from the pattern piece. Select the Frame 
on the pattern piece and press the Backspace key (Windows/Linux) 
or the Delete key (Macintosh) on the keyboard. 

 
 
 
 
 
 
 
 
 
 

In the Frame window list, select the Frame. It should be shown as inactive (in 
Italic Type) and Not Defined should be indicated in the attributes menu. 
Click the Delete icon at the top of the Frames window to delete the 
selected Frame. 

 
 

 
Note: To delete a Level Zero frame, all other frames on the piece must be 
deleted prior as their level is calculated from this one. 
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To reapply a Frame that is undefined in the list: 
 
1 Activate the pattern piece and select the corresponding existing  
  Frame from the Frame window list. 

2 With the Create Frame tool, click the points where the frame is to be  
  positioned on the pattern. The following dialog box appears: 

 

 
 

 
 
 
 

3 Two options are available when reapplying a frame: 
 
• Apply Measure on Medium: The position of the new frame takes the  
  measurement already existing in the list for this frame. 
 
• Apply Difference between Sizes: The frame takes the graded measurement  
  already existing in the list for this frame. 
 
If none of the options are checked, the frame takes the actual measurement 
and grading of the pattern for the frame but keep the frame name and 
attribute already created in the list. 
 
4 Click the Ok button to confirm your choice. 
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 Create Links 
Frames between pattern pieces may be linked to obtain a total garment 
measurement. For example, you can obtain bust or chest circumference, 
waist circumference, hip circumference or any measurement that is 
continuous on more than one pattern piece. 
 
Frames linked with different levels measurement maintain their level 
difference. When the link level is modified, the difference between each 
Frame level retains its proportions. 
 
Frames that belong to a Link are listed in the Attributes menu (Place the 
cursor on the Center name to view its attributes); they can be modified 
individually in the Center category or modified as a Link in the Links category. 
Modification of a Link changes all its Frame components. 
 
 
To link Frames together: 

1 Select the Frames to be linked (two or more). 

2 Press the Link Frame icon located at the bottom of the Frames window. 
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The Link dialog box opens: 

 

 
 

3 Enter the name of the Link. 

4 Select the distribution mode for the values of your choice (proportionate,  
  even or percentage). 
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You can correct the difference between Frame Levels by selecting the 
Adjust All Segments on the Same Level check box. The two levels move 
to a median position. (For example, if there is a difference of 1 inch 
between two levels, the system moves a ½-inch level up and a ½-inch 
level down.) 
 
When the Frames are linked, they turn to green colour. 
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The Links dialog box gives you three options about how you can split the 
modification value on all the frames that are part of a link: 
 
• Apply Proportionately on Each Frame: It proportionally distributes the value to   
  be added to or removed from frames that are linked to each other so the  
  length of frames compared to one another justifies how the value is split. 
• Apply Even Measurements on Each Frame: Adjustments are distributed   
  equally on each linked frame so the quantity of frames justifies the value and  
  an even amount is given/removed to/from each one. 
• Apply with Fixed Proportions on Each Frame: Adjustments are distributed  
  according to a percentage defined by the user using the Ratio Field. The   
  user decides which frame in the link receives which ratio of the modification. 
 

Adjust All Segments on the Same Level: It adjusts all the selected levels on an 
average level. 
 
Frame: It displays the selected Frame characteristics in the list above. 
 
Ratio: It is a value in the text box after selecting one of the Frames. This item 
is available when the Apply with Fixed Proportions on Each Frame radio button 
is selected. 
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Manipulating the Links on Pattern Pieces 
 
To remove a Link item: 
The Link must be deleted from the pattern pieces. Select the Linked 
Frames on the pattern pieces and press the Backspace key 
(Windows/Linux) or the Delete key (Macintosh) on the keyboard. 

 
 
 
 
 
 
 
 
 
 
 

In the Frames window select the Link. It should be shown as inactive (in Italic 
Type) and Not Defined should be indicated in the attributes menu. Click the 
Delete icon at the top of the Frames window to delete the selected Link. 

 
 

To reapply an undefined link from the list: 

1 Select the Frames to be linked on the pattern pieces and select  
  the corresponding existing Link from the Frames window. 
2 Click the Link Frames icon at the bottom of the Frame window to  
  activate the link. 
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Using Segments 
Segments are used to: 
 
Obtain a precise measurement (Medium size and/or All sizes) and create 
formulas between two sewing lines (for example: sleeves and armholes, 
waistbands and waists, collars and necklines, etc.) to make sure that all 
related pieces follow if a modification is made somewhere. 
 
Obtain a precise measurement (Medium size and/or All sizes) for creation of 
Specs when the required measurement cannot be obtained by the Frames 
themselves (for example: trousers crotch, armhole value, etc). 
 
Segments can be used on pattern pieces with or without Frames. 

 
The Frame segments appear in Aqua color with arrows on both sides. The 
white arrow identifies the starting point of the Frame segment (reference 
point) and the colored arrow identifies the ending point of the Frame 
segment (moving point).                                   
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Make Frame Segment 
To create a Frame Segment: 

1 Activate the pattern shape(s) 

2 Select the Make Frame Segment tool in the Frame View Toolbox. 

3 Click the starting point of the segment (the reference point). 

4 Click the ending point of the segment (the moving point).  

  The Segment dialog box appears: 

   

 
 
 
 
 
 
 

5 Enter the name of the segment. 

6 Select the appropriate set from the drop-down menu. This option is  
  available if several sets exist. If there are no existing sets, Set 1 is  
  created by default. 
7 Select the appropriate characteristics. 

 
Segment characteristics: 
 
Move Following: Select the modification method: X Axis, Y Axis, Segment 
Orientation, or following Contour Line. A movement is proposed according 
to the direction of the segment. 
 
Zone of Influence %: It allows you to establish a percentage where the 
enclosing points move to the maximum value (for example: shaped 
collar, center front notches). 
 
8 Click the OK button to execute the function. 
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Frame Segment: Move Following and Zone of Influence 
 
The Frame Segment can move following four different values: the X Axis, the Y 
Axis, the Segment Orientation or the Contour Line. 
 
Move Following the X Axis constrains pattern modifications and/or grading rules 
on the X Axis. 
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Move Following the Y Axis constrains pattern modifications and/or 
grading rules on the Y Axis. 
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Move Following the Segment Orientation applies pattern modifications and/or 
grading rules according to the pattern piece position. 
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Move Following the Contour Line applies pattern modifications and/or 
grading rules along the existing contour line. The main use is to match 
notches. 
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The zone of Influence applies full grading rules to a pre-set portion of the 
pattern piece. The other portion remains the same through all the sizes.  

This is useful on collars, waistband tabs and cuff tabs. 
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Manipulating Frame Segments 
 
Segments can be re-applied to pattern shapes in the same manner as all 
other library components. 
 
They are applied on the pattern piece perimeters and follow the original 
given segment movement of the library. 
 
You can adjust these movements before applying the library. 

 

 
 

There is no need to have frames to apply segments. 
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To remove a Frame Segment item: 

1 The Frame Segment must be deleted from the pattern piece.  
  Select the Frame Segment item on the pattern piece and press  
  the Backspace key (Windows/Linux) or the Delete key(Macintosh)  
  on the keyboard. 

 

 

 

 

 

 

 
 
 

2 In the Frames window, select the Frame Segment that you wish to  
  erase. It should be shown inactive (in Italic Type) and Not Defined  
  should be indicated in the attributes menu. 

3 Click the Delete icon at the bottom of the Frame window to delete the  
  selected Frame segment. 
 

To reapply a Frame Segment on a pattern piece: 

1 In the Frames window, select the undefined segment name to be   
  applied on the pattern piece. 

2 Select the Make Frame Segment tool from the Toolbox. 

3 Click the appropriate two reference points on the pattern piece. The 

  first point is the fixed point; the second point is the moving point. 

4 A two-headed arrow appears on the selected perimeter. 

5 As the current segment is applied to the pattern, the selector moves  
  down the list to the next undefined element. The toolbox is adjusted if  
  the next undefined element is a different type – a Center, Frame or  
  Segment. 
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Using Formulas 
A Formula calculates the target measurements and/or levels by combining 
Frames, Links, Levels or Segments. 
 
Formulas can be used in four ways: 

• Between Frames (Measures and/or Levels) 
• Between Segments 
• Between Frames (Measures and/or Levels) and Segments 
• Between Segments and Frames (Measures and/or Levels) 
 
By definition, a Formula modifies measurements based on the 
calculations obtained with the measurements of other Frames, Links or 
Segments.  
For example: A formula between front and back armholes and sleeve 
head with ease would be the same across all sizes. If modifications are 
made to one item, all related items through the formula follow the 
modification. 
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To create a Formula: 

1 Press the Formulas button  beside the Frames, Links and/or Segments    
  to modify it by a result of calculation. 
 

 The Specify Calculation dialog box appears:  
 

 

The Specify Calculation dialog box displays a specific calculation dialog box 
for the corresponding Frames, Links, Segments and/or Specs. 
 
The Specify Calculation dialog box is divided into three sections: 
 
The first section lists Frames (divided by their centers), Links and Segments 
available through the drop-down menu. 
 
The second section contains buttons to create the mathematical formula: 
add, subtract, multiply and/or divide. 
 
• ( ): Creates brackets ( ) for longer or more complex formulas. 
 



 

 495 

• Measure( ): For Frames, Links and Segments, to specify the measure to   
  take. 

• Level( ): For Frames and Links, to specify the measure to take. 
 
The third section is the formula box, which displays the formula as it is 
created. This section includes a Delete Formula button, which erases 
the existing formula. 

 
 

To understand the Specify Calculation window, follow the example below: 
 
 
Formulas are created for identified Frames, Links or Segments. The name of 
the element can be seen at the center of the formula box, identified next 
to Measure for: (i.e.: Armhole Back Sleeve). 
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1 Click the Measure( ) button; Measure( ) appears in the formulas box   
  (i.e.: Measure()). 
2 Select the desired category from the drop-down menu (Centers,  
  Links and Segments) and select the measured element from the list;  
  it appears between the brackets (i.e.: Measure(Armhole Back Sleeve)). 
3 Establish the desired calculation by pressing the +, -, *, / buttons (i.e.:  
  Measure(Armhole Back Sleeve)+), if needed. 
4 Enter a number (from the keyboard) or a desired Measure( ) or  
  Level( ) from the list (i.e.: Measure(Armhole Back Sleeve)+.5), if  
  needed for ease or shrinkage. 
5 Press the OK button to validate the formula. 

 
The result of this formula is established and maintain the Armhole Back 
Sleeve +.5 (inch or cm) longer than the Armhole Back. 
 
To remove a formula from the formula box, press the Delete Formula 
button. 
 
Specific conditions to create Formulas: 
 
• Formulas are not available for linked measurements if one of the Frame  
  measurements, contained in the link, is a result of a formula, for example  
  A + B is not equal to A. 
• Formulas are not available for the Links Level if one of the Frame Levels,  
  contained in the Link, is a result of a formula. 
• Formulas cannot be a set of circular references, for example: A is equal to  
   B and B is equal to A (A=B and B=A). 
• Formulas must be validated after each modification. 
• In certain instances, a warning message identifies Formulas that can no  
  longer be used based on how the Frame library was applied to a new  
  pattern piece. 
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Create Formula between Measurements Intelligently 
 
To do so:  
1 Activate the Frame needs to be added formula. 
2 Right click on mouse to choose Specify Calculation (Measure) / Specify     
  Calculation (Level).  
 
  The Specify Calculation dialog box appears: 
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3 Select one of the frames as a Master frame that relates to the  
 corresponding frame “Across BK”.  

 
Or, 
Click one of the frames from the Frames window as a Master frame that 
relates to the corresponding frame “Across BK”.  
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4 The formula is automatically created and displayed on the formula box. 
  Example: Measure(Back:Shoulder BK) - 1.127  
  That means Across BK measures to Shoulder BK.  And the value (1.127)  
  at the end, that is the difference between Shoulder BK (Master Frame)  
  and Across BK. 
5 Press OK button to validate the formula. 
6 Put cursor to the corresponding frame “Across BK”. A tool tip appears as  
  follows. 
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Keep Frames to the piece if Split Piece & Combine Pieces 
PAD V6.0 will keep the frames, segments to the piece after splitting and 
combine. In previous version, the pattern piece set frames in Frame View, 
but if you may need to split it into 2 pieces, all frames will be removed 
completely. You have to apply all frames to the piece again. 
 
To split a piece into 2 pieces and keep frames on: 
Here is the original piece with setting Frames. 
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Once it splits to 2 pieces, it creates a new Center items for the split piece in 
Frame list. It creates a new Center item and adds suffix C to the piece 
name. 

  

 
If a piece with Frames is being split into 2 pieces, the split segments will 
create a point for the position of Frames. 
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To combine 2 pieces to a piece and keep frame on: 
Here is the example for 2 pieces set with frames. 

 
 
One of the pieces needs to be split, part of piece in Plan View as follows. 
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You will find the frames still keeping to the piece “Front Blouse” and create 
the new segments on Front Blouse and Front Yoke. 

 
 
Combine Front Yoke to Back Blouse in Plan View and go back to Frame 
View. Back Blouse still keeps all frames and segments on. 
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Rearrange the order of Frame items in Frame window 
It allows to re-arrange item order at five categories; Centers, Links, 
Segments, Spec and Measurement Charts in Frame window.  
To do so: 
1 Select the item need to be moved 
2 Click on it and hold down mouse button    
3 Move to the desired position and release mouse button  

          

 

Or it allows moving the item for a pattern piece in Centers category. 

                  

 

 



 

 505 

Creating Specs 
 
 
Each company has its own way of measuring garments. Applying Frames  
to a Pattern could be compared to measuring a pattern with a measuring 
tape. Specs(specifications), on the other hand, can be compared to 
making a combination of garment measurements to obtain overall 
measurements of the finished garment. 
 
Specs are created by combination, using Formula Editor (Specify 
Calculation) measurements obtained by Frames (Measures and/or Levels), 
Links (Measures and/or Level) and/or Segments. 
 
Specs are results and cannot be modified. You can create a Spec for your 
maximal and minimal tolerance for the finished garment measurement to 
be used for quality control purposes. 
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To create a New Spec: 

1 Select New Spec… from the drop-down menu in the Frames window. 

 
    
 
 
 
 
 
 
 

 
 
 
 
 
 

2 In the Specs dialog box, enter a name and select the set the new spec  
  belongs to. The Set drop-down menu lists all existing sets. If there are no  
  existing sets, Set 1 is be created by default. 

     
 
 
 
 

 
 

3 Click the OK button to execute the function. 
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Created specifications are listed in the Frames window under the Specs 
category. 
 
Using the same method as with Formulas, combine necessary Frames 
(Measures and/or Levels), Links (Measures and/or Levels), and 
Segments to obtain the specifications measurements you need. 
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Create Specs by Default Items from Select Spec 
 
To do so:  
1 To choose Select Spec… from Frames window sub-menu 
2 A dialog box appears; you can use mouse drag to select several items.  

 
 
 Or hold down Ctrl +Alt keys to choose your desired items from the list. 
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3 Press OK button to validate. Your desired Specifications are in the Frame  
  window under the Specs category.  

   
 
 
Delete Specs without Adding Formula from Frames Window 
It allows deleting the Specs without formula from Specs category by 
multiple selections. It does not delete Specifications one by one. 
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Measurement Charts 
Measurement Charts is an individual category in Frame View window, user 
can define various items and set value on it accordingly. Once the value 
of item in Measurement Charts is modified or changed, all corresponding 
items (Frames, Segments or Links) will be automatically updated. 
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To create a New Measurement Charts: 
 

1 Select New Measurement Charts…from the drop-down menu in the  
  Frames window. 
 

   
 
2 In the Measurement Charts dialog box, enter a name and select the set  
  for the New Measurement Charts belongs to. The Set drop-down menu  
  lists all existing sets. If there are no existing sets, Set 1 will be created by  
  default. 
 

   
 

3 Click the OK button to execute the function. 
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Created items are listed in the Frames window under the Measurement 
Charts category. 
 
Using the same method as with Formulas, combine necessary 
Measurement Charts to obtain Frames, Links and Segments value you 
need. 

 

Once the values in Measurement Charts are modified, all corresponding 
Frames, Links and Segment are updated automatically. 
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Exporting Frames 
Once you have established Frames on all related pattern pieces, you can 
export their measurements to an external database. 
 
To export Frame information: 

1 Select the Export… item in the File menu.  

  The Export dialog box opens: 

    
 
 
 
 
 
 
 
 

2 Select the Frame file format from the File Format drop-down menu. 

3 Click the OK button to execute the function. 

4 If more than one set exists in the Frames window, select the set you   
  wish to export. More than one set can be exported at once.(If all  
  sets need to be exported, press the Select All button.) 

   5 Click the OK button to execute the function. The Export Document as  
  dialog box opens. 
6 Enter the file name and click the Save button. 
 
 
Once exported, the exported Frame formatted file can be opened in any 
standard software that supports Text Files. 
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Importing Frames 
If frame information is modified in an external database or any other 
software that supports text files, it can be imported back in the pattern file. 
 
 
To import frame information: 

1 Select the Import… item in the File menu. The Import dialog box opens: 
   
 
 
 
 
 
 
 

2 Select the Frame file format from the File Format drop-down menu. 

3 Click the OK button to execute the function. 

4 If more than one set exists in the pattern file, select the corresponding  
  set from the list. 

  

 

 

 

 

 

 

 

 

 

  
5 Select the set to import and click the OK button to execute the  
 function. 
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Exporting Specs 
Once specs are created, their measurements can be exported to an 
external database. 
 
To export the Specs information: 

1 Select the Export... item in the File menu.  

  The Export dialog box opens: 

       

 

 
 
 
 
 
 

2 From the File format pop-up menu, select the Specs file format. 

3 Click the OK button to execute the function. 

4 If more than one set exists in the Frames window, a dialog box appears,  
  enabling you to select the set(s) you wish to export. You can export more  
  than one set at once. 
5 A Save dialog box opens. Enter the File Name and click the Save button. 
 
Once exported, the Exported Specs formatted file can be opened in any 
standard software that supports text files. 
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Exporting Measurement Charts 
Once Measurement Charts are created, their measurements can be 
exported to an external database. 
 
To export the Measurement Charts information: 
1 Select the Export... item in the File menu. 
  The Export dialog box opens: 

   
2 From the File format pop-up menu, select the Measurement Charts file  
  format. 
3 Click the OK button to execute the function. 
4 If more than one set exists in the Export window, a dialog box appears,  
  enabling you to select the set(s) to export. You can export more than  
  one set at once. 

   
5 A Save dialog box opens. Enter the File Name and click the Save button.  
  Once exported, the Exported file can be opened by any standard  
  software that supports text files. 
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Importing Measurement Charts  
If Measurement Charts information is modified in an external database or 
any other software that supports text files, it can be imported back in the 
pattern file. 
 
To import Measurement Charts information: 
1 Select the Import… item in the File menu. The Import dialog box opens:  

   

2 Select the Measurement Charts item from the File Format drop-down  
  menu. 
3 Click the OK button to execute the function. 
4 If more than one set exists in pattern file, select the corresponding set  
  from the list.  

    
5 Select the set to import and click the OK button to execute the function.  
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Saving a Frame Library 

 
 
 
 

You can save a Set of Frames in a Frame library for future use in 
another file. For example, the Frame library for Shirts/Blouses can be 
used on all other top styles. 
 
When a Frame library is applied to a pattern, you can make 
modifications to obtain the desired results. New Frames can be created 
to complete the Set and speed up the process. Unnecessary ones can 
be deleted. 
 
 
To save a set in a library: 

1 In the Frames pop-up menu (black arrow with an icon at the  
  upper-right of the Frames window), select the Save sets item. 

2 In the Save as dialog box, enter the Frame Library name. 

3 Click the Save button to save your Frame Library. In the Save type  
  drop-down menu, select the file that you want to save in V5 or the  
  previous version. Ex: Select the file type to Frame Library File 5.0, it supports  
  in V5. And choose to the file type to Frame Library File 4.80, it supports in  
  4.8 or below. 
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Deleting Undefined Frames, Links, Segments and/or Specs 

 

 
To delete all unused Frames, Links, Segments and/or Specs in a set, select 
Delete Undefined Objects… in the Frames window pop-up menu. Press the 
Delete button to validate. Only items that are used in the current pattern 
remain in the Frames window list. 
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Opening a Frame Library 

You can open an existing saved Set of Frames from a Frame Library 
and use it on your current pattern file. 
 
To open a Set from a Frame Library: 

1 In the Frames pop-up menu (black arrow with an icon at the  
  upper-right of the Frames window), select the Open Sets item. 

2 In the Open dialog box, select the desired Frame Library. 

3 A Frame Library may contain several Sets. Select the desired 

  Frame Set from the list and press OK. 
 
 
The selected set appears in Italic Type (undefined) in the Frame 
window. The user needs to define the Frames' position on the pattern. 
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Using a Frame Library 

To apply an existing set to the current pattern file, you must expand the 
categories or sub-items of the set. 
 
To view a the categories or sub-items of a set: 
• The plus (+) sign expands the list. 
• The minus (-) sign collapses the list. 
 
To apply Centers to pattern pieces: 

1 Activate the piece you wish the center to be applied on. 

2 In the list, select the name of the Center Frame that you wish to apply  
  to the pattern pieces. 
3 Select the Create Frame tool in the toolbox. 

4 Click the appropriate reference points on the pattern piece. The  
  Center Frame appears on the pattern piece and be defined in the list  
  (in black). 
 
To apply Frames to pattern pieces: 

1 Activate the piece you wish the Frame to be on. 

2 In the list, select the name of the Frame that you wish to apply to the  
  pattern pieces. 
3 Select the Create Frame tool from the toolbox. 

4 Click the appropriate reference points on the pattern piece.  

  A dialog box opens. 

    
 
 
 
 
 

Frames applied to the pattern pieces may alter measurements and/or 
grading by selecting either the Apply Measure on Medium and/or Apply 
Difference between Sizes options. 
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5 Check the appropriate check box to replace the measurements or  
grading on the pattern pieces with the measurements or grading from 
the Frame library if needed. 

 
To apply Segments to pattern pieces: 

1 Activate the piece you wish the segment to be on. 

2 In the list, select the name of the segment that you wish to apply to  
  the pattern piece. 
3 Select the Make Frame Segment tool from the toolbox. 

4 Click the appropriate reference points on the pattern piece. 
 
 
As the first frame is applied to the pattern, the selector moves down the 
list to the next undefined element. The tool adjusts itself according to the 
type of the next undefined element – Centers, Frames or Segments – to 
make the process faster. 
 
You can skip elements you do not need in the list for your pattern. You can 
add new Frames, Links, Segments and/or Specs to the set, according to 
your needs. When your pattern is completely framed, use the Delete 
Undefined Objects item from the Frames window arrow menu to remove 
all unnecessary items from your Frame Set. 
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Chapter 6 
PAD SYSTEM™ CLONE 
• • • • • • 
 
 

PAD System™ Clone applies modifications to the plan from the pattern 
development phase to the cloned production pieces phase. 
 
This powerful technology makes the interdependence of the pieces possible 
and eliminates several stages in the pattern modification process, thus 
helping to increase your productivity. 
 
The Clone Module allows you to: 
• Make automatic plan modifications to all the connected parts (principal  
  fabric, lining, enlacing, etc). 
• Update Grading and Seam Allowance modifications. 
• Obtain alternating views, between the Construction Pieces (Pieces in Plan  
  View) and their respective Clones (Pieces in Plan / Pieces View). 
• Allow creating more Clone generations 
• Lock the Cloned Pieces and the Intelligent Mirror. 
•The Clone piece can be modified individually, and once the Master  
piece has been modified, changes will be reflected to the Clone piece 
again. 
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Intelligent Mirror 
         
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In Pattern Professional or Pattern Enterprise, when the Mirror tool is applied in 
Plan View, it becomes an Intelligent Mirror by default. 
 
A dotted line represents the axis of reflection. When you use the Intelligent 
Mirror to make modifications to one side, the modifications are applied to 
the other “mirrored” side. 

 
Note: The Intelligent Mirror feature is available in the Plan View with 
Pattern Professional or Pattern Enterprise products. 
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To make modifications to one side only, remove the Mirror Line. 
To do so, activate the mirror on the piece by selecting the Mirror Line and press 
the Backspace key (Windows/Linux) or the Delete key (Macintosh) to erase it. 

 
 
 
 
 
 
 
 
 
 

Grading follows the Mirror Line reflection to the other side. 
 
Grading Alignment can be done on points found on the mirror line. In 
Grade View, select the point you want to align the Grading on. Click the 
Pointer tool while pressing the Ctrl + Alt keys (Windows/Linux) or the 
Command + Option keys (Macintosh). 
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To create a Regular Mirror in the Clone module: 

1 Select a segment, which serves as the reflection line. 

2 Select the Mirror tool. 

3 Hold down the Alt key (Windows) or the Option key (Macintosh)  
  or Alt +Windows keys (Linux) and click the segment that is your    
  reflection line. 

    

 

 
 
 
 
 
 
 
 
 

4 The Mirror dialog box opens. Click the OK button without entering any  
  values in the text box. 
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To close a shape that has an intelligent mirror (keeping original side without 
the reflection): 

1 Select the mirror line. 

2 Select the Item Info... item from the Treatment menu. 

3 The Mirror dialog box opens. Select the option Close Piece and click  
  the OK button. 
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Cut Reflection 
 
To mirror a selected shape and cut the reflection at a certain width: 

1 Select the Reflection Segment(s). 

2 Select the Mirror tool. 

3 Hold down the Alt key (Windows) or the Option key (Macintosh)  
  or Alt +Windows keys (Linux) and click the segment that is your   
  reflection line. 

       

 

 

 

 

 

 

 
 

The Mirror dialog box opens: 
 

         

 
4 Enter the value for the cut reflection in the text box. 

5 Select the Same Value for All Sizes check box if you want the   
  grading value to remain the same for all sizes of the nest. A  
  proportional grading value is applied by default if the check  

  box is unchecked. 
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Example of a cut reflection: 
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Master and Clone Pieces 

To obtain a cloned piece: 

1 To obtain a Cloned piece, you must first be in Plan View. 

2 Select the plan piece you want to clone. 

3 Set your piece (Treatment menu, Set Piece... item). 

4 The Set Piece dialog box appears. Enter the proper information,  
  as you would do for a regular piece (refer to the Set Piece section  

  of this manual for further info). Check Plan Clone /Piece Clone at 

the bottom of the dialog box. 
 
Your piece is cloned. The master plan is visible in Plan View and the clone 
piece is visible in Plan View / Pieces View. 
 
Every modifications made to the Master (the original plan piece) are 
reflected on the cloned piece(s). 
A small symbol appears next to the pieces to show their status of Master or 
Clone.  
 
The contours of the cloned pieces are modifiable through the master 
piece. To make a change to the contour of a piece without going through 
the plan, you have to check the Piece option rather than Piece Clone in 
the Set Piece dialog box to get a regular piece. 
 
When the Locked box is checked, no modifications can be made to the 
Clone or the Master. 
 
The Master piece can have many Clone pieces in different fabrics. All 
Clones of a Master are affected by its modifications. 
 
You cannot modify the geometry of the contour of a clone. However, all 
internal segments can be modified, added to or deleted. Grading can be 
modified on the clone. Be careful, as grading modifications made to a 
master overwrite the grading modifications made to a clone. 
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If you add internal points or segments to the Master, you can move 
them onto the Clone, bypassing the Master. If the latter undergoes a 
transformation, the Clone reflects the same change from its Starting 
Point, as illustrated in the example on next page. 
    
Example of a Master piece and its Clone: 
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Modification of a Master 
In the following examples, the first piece represents the Master and the 
second piece, the Clone. 

 
In the above illustration, you can view two identical pieces: the Master 
Piece and the Clone Piece. 

In the above illustration, if the collar facing has been removed from the 
Master Piece, the modifications are applied to the Clone Piece. 

 
In the above illustration, we have produced an Intelligent Mirror on the 
median of the Master Piece bodice. The modification is applied to the 
Clone Piece.                                                                                    
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In the above illustration, we have removed the style line on one side of the 
Master Piece bodice. Because the piece has an intelligent mirror, the 
modification is applied to the other side of the bodice on both the Master Piece 
and the Clone Piece. 

 

 
In the above illustration, we have modified the neck area and the modification 
is applied to the Clone Piece. We have modified the hem grading on one side 
of the Master Piece bodice. The modifications are applied to the right side of 
the Master Piece bodice as well as the Clone Piece. 
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To create more Clone generations in Plan View/ Piece View 
You may create the first Clone piece from a Master. A small symbol will 
appear on the side of Master Piece . 

 
 
Then you may create the first Clone pieces from the Master piece to 
identify as Self fabric. A small symbol will appear on the side of Clone 
pieces . 
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And then you need to create another Clone pieces from the first Clone 
piece to identify as Lining. A small symbol will appear on the side of Clone 
pieces . 

 
 
 
 
To modify Clone piece individually and (or) modify Clone piece by Master 
piece  
 
If the option Unlocked is checked in the Set Piece’s dialog box, you can 
modify the clone pieces if necessary. For example; you make changing to 
the second Clone pieces as the following picture shown, 

 
 
 

If you need to change the length and the width on the Master piece; it will 
be affected to the Clone piece again as the following picture.       
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Besides you can do the same modification in Pieces View, it supports the 
Clone pieces with Seam Allowance and Intelligent Mirror. 
 
For working on Grading View, all of Clone grading must be affected by the 
Master pieces. Ex: If Clone pieces are graded, then you makes grading to 
the Master Piece, all of the Grading modification will be affected to all 
Clone pieces again. 
 
Note: If the pieces are generated from Clone piece. When adding Seam 
Allowance, it should apply to the Master Clone piece. Then seam value will 
apply the same to the corresponding Clone pieces. 
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Copying a Master or a Clone 

You can copy a Master or a Clone. However, if you do, the copy does 
no save the attributes of its predecessor and the two are not 
interdependent. Furthermore, the Master copy is a plan and the 
Clone copy is a piece. If you copy them together, the copies retain 
the attributes of their predecessors. 
 
 
 

Grading 

Clone Grading always follows that of the Master, even though you 
can modify the Clone Grading without passing through its Master first. 
However, if you modify the grading of the Master, the Clone assumes 
the same grading as the Master, without taking its own grading into 
account. 
 
 
 

Frame 

Modification to Plan Master Pieces resulting from Frame modifications 
are reflected to their cloned piece. 
 
 
 

Seam Allowances 
The seam allowances are always recalculated to adjust to any piece 
modifications they may have undergone following the transformation 
of their master plan pieces. 
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Appendix A 
PAD System Software License Agreement 
. . . . . . . . 
 

PAD System International Limited 
Software License 
 
PLEASE READ THIS SOFTWARE LICENSE AGREEMENT ("LICENSE") CAREFULLY. BY CLICKING 
"Yes", YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS LICENCE. IF YOU DO NOT 
AGREE TO THE TERMS OF THIS LICENCE, OR IF YOU PURCHASED OR OBTAINED THE PAD 
SYSTEM SOFTWARE FROM AN UNAUTHORISED REPRESENTATIVE OF PAD SYSTEM 
INTERNATIONAL LIMITED, CLICK "No" AND (IF APPLICABLE) RETURN THE PAD SYSTEM 
SOFTWARE TO THE PLACE WHERE YOU OBTAINED IT FOR A REFUND. 
 
1. License.  The software, documentation and materials accompanying this License whether 
on disk, in read only memory, on any other media or in any other form (the "PAD System 
Software") are licensed to you by PAD System International Limited. You own the media on 
which the PAD System Software is recorded but PAD International Limited is the owner of the 
PAD System Software. The PAD System Software in this package and any copies which this 
License authorizes you to make are subject to this License. 
 
2. Permitted Uses and Restrictions.  This License allows you to install and use the PAD 
System Software on a single computer(s) with the appropriate hardware protection device 
provided at the time of initial purchase of PAD System software upon the terms and subject 
to the conditions contained herein. This License does not allow the PAD System Software to 
be loaded, installed or used on any other computer. You may make one copy of the PAD 
System Software in machine readable form for backup purposes only. The backup copy must 
include all copyright information contained on the original. Except as expressly permitted in 
this License, you may not decompile, reverse engineer, disassemble, modify, rent, lease, loan, 
sublicense, distribute or create derivative works based upon the PAD System Software in 
whole or part. This license allows you to install or operate the PAD System Software only on a 
computer system with the appropriate hardware protection device. THE PAD SYSTEM 
SOFTWARE IS NOT INTENDED FOR USE IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT 
NAVIGATION, COMMUNICATION SYSTEMS, OR AIR TRAFFIC CONTROL MACHINES IN WHICH 
CASE THE FAILURE OF THE PAD SYSTEM SOFTWARE COULD LEAD TO DEATH, PERSONAL 
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INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE AND PAD SYSTEM 
INTERNAITONAL Limited WILL NOT BE LIABLE FOR ANY DAMAGES OR LOSSES SO CAUSED. 
This Licence will terminate automatically without notice from PAD System International if you 
fail to comply with any term(s) of this License. 
 
3. Proprietary Rights.  You acknowledge that the PAD System software and related materials 
provided by PAD System International Limited are the exclusive property of PAD System 
International Limited and said materials are furnished solely to assist you in the installation, 
operation and use of the PAD System software. The only right which obtains from purchasing 
the PAD System software and related materials is the right of use in accordance with the 
terms and conditions of this License. Title to or ownership of all applicable rights in patent, 
copyright, trademark and trade secrets in PAD System software and related materials shall 
remain exclusively with PAD System International Limited. 
 
4. Limited Warranty on Media (if applicable).  PAD System International Limited warrants the 
media on which the PAD System Software is recorded to be free from defects in materials and 
workmanship under normal use for a period of ninety (90) days from the date of original 
retail purchase. Your sole remedy under this provision shall be, at PAD System International 
Limited's discretion, a refund of the purchase price of the product containing the PAD System 
Software or replacement of the PAD System Software when returned to PAD System 
International Limited or a PAD System International Limited's authorized representative with 
a copy of a valid purchase receipt. A valid purchase receipt means a receipt issued by an 
authorized representative of PAD System International Limited. THIS LIMITED WARRANTY 
AND ANY IMPLIED WARRANTIES ON THE MEDIA INCLUDING THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE LIMITED TO A PERIOD OF 
NINETY (90) DAYS FROM THE DATE OF ORIGINAL RETAIL PURCHASE. SOME JURISDICTIONS  
DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THIS 
LIMITATION MAY NOT APPLY TO YOU.TO THE EXTENT PERMITTED BY APPLICABLE LAW, PAD 
SYSTEM INTERNATIONAL LIMITED SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES ON THE 
MEDIA , WHETHER VERBAL OR WRITTEN, EXPRESS OR IMPLIED. 
 
5. Disclaimer of Warranty on PAD System Software.  You expressly acknowledge and agree 
that use of the PAD System Software is at your sole risk. The PAD System Software is provided 
"AS IS" and without warranty of any kind and PAD System International LIMITED EXPRESSLY 
DISCLAIMs ALL WARRANTIES AND/OR CONDITIONS, EXPRESSED OR IMPLIED, INCLUDING,  
BUT NOT LIMITED TO,  THE IMPLIED WARRANTIES AND/OR CONDITIONS OF  
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MERCHANTABILITY OR SATISFACTORY QUALITY AND FITNESS FOR A PARTICULAR PURPOSE 
AND NONINFRINGEMENT OF THIRD PARTY'S RIGHTS. PAD SYSTEM INTERNATIONAL LIMITED 
DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE PAD SYSTEM SOFTWARE  
WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE PAD SYSTEM SOFTWARE 
WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE PAD SYSTEM SOFTWARE 
WILL BE CORRECTED. FURTHERMORE, PAD SYSTEM INTERNATIONAL LIMITED. DOES NOT 
WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE 
USE OF THE PAD SYSTEM SOFTWARE OR RELATED DOCUMENTATION IN TERMS OF THEIR 
CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN 
INFORMATION OR ADVICE GIVEN BY PAD SYSTEM INTERNATIONAL LIMITED OR A PAD 
SYSTEM INTERNATIONAL LIMITED'S AUTHORIZED REPRESENTATIVE SHALL CREATE A 
WARRANTY OR IN ANY WAY WIDEN THE SCOPE OF THIS WARRANTY. SHOULD THE PAD 
SYSTEM SOFTWARE PROVE DEFECTIVE, YOU (AND NOT PAD SYSTEM INTERNATIONAL 
LIMITED OR ITS AUTHORIZED REPRESENTATIVE) ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. 
PAD SYSTEM INTERNATIONAL LIMITED SHALL BE UNDER NO LIABILITY TO YOU WHATSOEVER 
IN RESPECT OR THE PAD SYSTEM SOFTWARE IF YOU PURCHASED OR OBTAINED IT FROM AN 
UNAUTHORISED REPRESENTATIVE OF PAD SYSTEM INTERNATIONAL LIMITED. THE TERMS OF 
THIS DISCLAIMER DO NOT AFFECT OR PREJUDICE THE STATUTORY RIGHTS OF A CONSUMER 
ACQUIRING PAD SYSTEM INTERNATILNA LIMITED'S PRODUCTS OTHERWISE THAN IN THE 
COURSE OF A BUSINESS, NEITHER DO THEY LIMIT OR EXCLUDE ANY LIABILITY FOR DEATH OR 
PERSONAL INJURY CAUSED BY PAD SYSTEM INTERNATIONAL LIMITED'S NEGLIGENCE. 
 
6. Limitation of Liability.  UNDER NO CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL 
PAD SYSTEM INTERNATIONAL LIMITED. BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT 
OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR RELATING TO THIS LICENSE. SOME 
JURISDICTIONS DO NOT ALLOW THE LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES SO THIS LIMITATION MAY NOT APPLY TO YOU. In the event that any exclusion 
contained in this provision shall be held to be invalid for any reason and PAD System 
International Limited becomes liable for loss or damage that may lawfully be limited, such 
total liability to you for all damages shall not exceed the amount of [ one thousand Hong 
Kong dollars (HK$1.000.00)]. 
 
7. Term and Termination.  PAD System International Limited shall have the right to 
terminate this Licence if you fail to comply with the terms and conditions herein contained.  
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PAD System International Limited shall give written notice to you of such defaults and if such 
defaults have not been cured within thirty (30) days after such notice, then PAD System 
International Limited shall be entitled, in addition to any other rights it may have under this 
Licence or in law, to terminate this Licence. You agree, upon expiration of the term of the 
present Licence or upon termination by reason of your default, to immediately return or 
destroy the PAD System software and copies thereof and related materials as directed by 
PAD System International Limited and, if requested by PAD System International Limited, to 
certify in writing as to the destruction or return of the PAD System Software and all copies 
thereof. 
 
8. Compliance.  You agree that PAD System International Limited may perform such tests as 
PAD System International Limited shall deem necessary to monitor compliance with this 
Licence at any time, with or without notice, during normal business hours. 
 
9. Controlling Law and Severability.  This License shall be governed by the laws of Hong 
Kong SAR. If for any reason a court of competent jurisdiction finds any provision, or portion 
thereof, to be unenforceable, the remainder of this License shall continue in full force and 
effect. 
 
10. Complete Agreement.  This License constitutes the entire agreement between the 
parties with respect to the use of the PAD System Software and supersedes all prior or 
contemporaneous understandings regarding such subject matter. No amendment to or 
modification of this License will be binding unless in writing and signed by PAD System 
International Limited. 
 
PAD SYSTEM INTERNATIONAL LIMITED 
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Appendix B 
About PAD System International Limited 
. . . . . . . . 
 
 
PAD System was founded in 1988, in Montreal Canada by creative people from the apparel 
industry. 
 
A leader in CAD/CAM integrated solutions and dedicated to the apparel, textile and leather 
industry, PAD System is present on all five continents through its international distribution 
network. 
 
Today PAD System is active in more than 50 countries and available in 8 languages. 
 
From virtual design to integrated production, PAD System and its partners provide service, 
support and training to thousands of satisfied customers worldwide—from freelancers to 
large scale producers. 
 
With a complete design suite—pattern, placement, production—the software offered by 
PAD System represents a set of cutting-edge modules that are complete, coherent, and 
compatible with the competition.  PAD System software may also be used with the majority 
of standard peripherals on the market, such as digitizing tables, plotters, automated knives 
and even scanners. 
 
PAD System's mission is to produce complete, high-tech CAD/CAM solutions that are simple, 
efficient and flexible for companies and individuals working in the clothing, textile, and 
leather industries, as well as the 3D graphic design industry. 
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PAD System™ International Limited (Head Office) 
Flat A, 2/F, Cheung Wing Industrial Building, 
109-115 Wo Yi Hop Road, Kwai Chung,  
New Territories, Hong Kong 
 

Tel: (852) 2370-9063 
Fax: (852) 2370-9085 
 
padinfo@padsystem.com 
http://www.padsystem.com/ 
 
 

Other countries: 
 
Please locate the distributor near to you by consulting our website: 
www.padsystem.com, distributors section. 

 
 

http://www.padsystem.com/�
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